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The information in this document is subject to change without notice and describes only the
product defined in the introduction of this documentation. This document is intended for the
use of Nokia Networks' customers only for the purposes of the agreement under which the
document is submitted, and no part of it may be reproduced or transmitted in any form or
means without the prior written permission of Nokia Networks. The document has been
prepared to be used by professional and properly trained personnel, and the customer
assumes full responsibility when using it. Nokia Networks welcomes customer comments as
part of the process of continuous development and improvement of the documentation.

The information or statements given in this document concerning the suitability, capacity, or
performance of the mentioned hardware or software products cannot be considered binding
but shall be defined in the agreement made between Nokia Networks and the customer.
However, Nokia Networks has made all reasonable efforts to ensure that the instructions
contained in the document are adequate and free of material errors and omissions. Nokia
Networks will, if necessary, explain issues which may not be covered by the document.

Nokia Networks' liability for any errors in the document is limited to the documentary correction
of errors. Nokia Networks WILL NOT BE RESPONSIBLE IN ANY EVENT FOR ERRORS IN
THIS DOCUMENT OR FOR ANY DAMAGES, INCIDENTAL OR CONSEQUENTIAL
(INCLUDING MONETARY LOSSES), that might arise from the use of this document or the
information in it.

This document and the product it describes are considered protected by copyright according to
the applicable laws.

NOKIA logo is a registered trademark of Nokia Corporation.

Other product names mentioned in this document may be trademarks of their respective
companies, and they are mentioned for identification purposes only.

Copyright © Nokia Networks Oy 2000. All rights reserved.
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About this manual
Note

1 About this manual
This manual is intended for the users of MF Manager C2.5. It covers all the
information you need to start using MF Manager to configure NMS/10 MF or
PDH Polling HW and SW to poll the managed PDH/Primary Rate network.

In this manual both NMS/10 MF and PDH Polling are sometimes referred to as
NMS/10 MF. Note, however, that PDH Polling has some limitations compared to
NMS/10 MF.

This User's Manual covers the following topics:

• Introduction (Chapter 2)

• Installation instructions (Chapter 3)

• Authorising the licence (Chapter 4)

• Getting started (Chapter 5)

• Reference (Chapter 6)

• Connecting Nokia Managers to NMS/10 MF or PDH Polling workstation
(Appendix A)

• Directory hierarchy (Appendix B)

• Configuration report format (Appendix C)

• Network Test Client (Appendix D).

We recommend that you read Chapter 5, ’Getting Started’ to get acquainted with
the operation of MF Manager.

Please familiarize yourself with Microsoft Windows NT before operating this
program.
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For further information see also:

• NMS/10 MF Agent C2.0 Agent Configuration Tool User Manual

• NMS/10 MF C2.0 Operating Manual

• NMS/10 MF C1.0 Operating Manual

• PDH Polling HW C1.0 & SW C2.0 Installation Instructions

• PDH Polling C1.0 Installation Instructions

• Microsoft Windows NT user documentation.

1.1 Typographic conventions

The table below presents the  conventions that are used in this MF Manager
User’s Manual:

Table 1. Typographic conventions

Italic font Indicates a word or phrase that is emphasized, or a
reference to the title of a manual, example:

Refer to the NMS/10 MF Operating Manual.

Bold font Indicates the title of a window, or an option, command,
field or group, or anything that you must type exactly as it
appears, examples:

Help → Index means: choose Index from the

Help menu.

A:\install means: type A:\install

ALL CAPITALS Indicate a directory or file name, example:

INSTALL.EXE

SMALL CAPITALS Indicate the keys of the terminal keyboard, example:

CTRL

Highlights the start of a procedure.1
2
3
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2 Introduction to MF Manager C2.5
This chapter introduces MF Manager C2.5. It covers the following topics:

• System architecture (Section 2.1)

• General features (Section 2.2)

• User interface (Section 2.3)

• System requirements (Section 2.4)

• Compatibility (Section 2.5)

• Product codes (Section 2.6)

• Copyright notice (Section 2.7).

2.1 System architecture

MF Manager is a Windows NT based application for configuring NMS/10 MF
and PDH Polling.

MF Manager C2.5 runs under Microsoft Windows NT Workstation version 4.0
and is compatible with NMS/10 MF C2.0, NMS/10 MF C1.0, PDH Polling C2.0,
and PDH Polling C1.0.

NMS/10 MF and PDH Polling are used for collecting Q1 alarms and other
messages from Nokia's PDH/Primary Rate equipment, and mediating between
these equipment and a supervising NMS.

NMS/10 MF provides 16 management buses (3000 functional entities), which
can be protected, and mediates with NMS/10 and NMS/100(0).

PDH Polling provides 8 management buses (1500 functional entities), which can
be protected, and mediates with NMS/10.

NMS/10 System Frame is a platform for products monitoring network alarm
information and configuring Nokia's Eksos N20 and PDH/Primary Rate
transmission network elements, SDH radios, and Synfonet nodes.
DN00276927 © Nokia Networks Oy 11 (274)
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Figure 1. An example of a management network with NMS/10 System
Frame as the supervising network management system

2.2 General features

MF Manager is an application for configuring NMS/10 MF and PDH Polling,
including the Polling card and Q1 Interface cards, and fault monitoring software,
which poll the managed network.

The main functions of MF Manager are:

• Creating a new configuration with default values

• Modifying an existing configuration, either on-line or off-line

• Modifying bus, PDH Manager interface, OS interface and printer spooler
settings

• Configuring filter and alarm classifications of the SNMP interface

• Configuring network test interface

- Windows NT Workstation

NMS/10 MF C2.0

LAN/WAN
connection

Q1 network elements

- NMS/10 System Frame
- Node Managers

NMS/10 System Frame PC:

(TCP/IP)

V.11 connection
12 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Introduction to MF Manager C2.5
• Editing address, station and device type values

• Starting a network scan and utilizing its results

• Defining performance monitoring jobs

• Defining auto-discovery and utilizing its results

• Starting a fault status consistency check

• Creating filter and alarm classification definitions

• Printing the current configuration.

2.3 User interface

MF Manager consists of an application window inside which is the
Configuration window (Figure 2). The user interface complies with the standard
Windows NT controls.

The Configuration window is used for creating a new configuration or changing
an existing configuration. It contains a common part and three tabs for viewing
and editing configurations. The common part contains information about the
current configuration. Below is a brief introduction to the three tabs:

• Buses tab contains bus number, polling unit number, primary polling
direction port and speed, secondary polling direction port and speed (if the
bus is protected) for a bus, and the number of FEs and NEs configured on
the bus. Moreover, information about the suspension of the bus is shown.

• PDH Manager Interfaces tab contains all the PDH manager interfaces in
the current configuration. The list box contains PDH manager interface
number, TCP/IP port and filter and alarm classification names.

• OS Interfaces and Printer Spoolers tab contains all the OS interfaces and
printer spoolers in the current configuration. The OS Interfaces list box
contains OS interface number, command port, alarm port, filter and alarm
classification names. The Printer Spoolers list box contains the printer
spooler number and printer spooler name defined in Windows NT, and
filter and alarm classification names.
DN00276927 © Nokia Networks Oy 13 (274)
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Figure 2. The user interface of MF Manager

2.4 System requirements

This section describes the hardware and software requirements of the computer
for running MF Manager C2.5.

MF Manager

• Microsoft Windows NT Workstation or Server version 4.0 with Service
Pack 5 (or later), or

Microsoft Windows NT Server 4.0, Terminal Server Edition with Service
Pack 5 (or later).

• Personal computer with Pentium-compatible processor or faster

• Minimum of 32 megabytes (MB) of RAM (64 MB recommended)
14 (274) © Nokia Networks Oy DN00276927
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• 5 MB of hard disk space and 1 MB per each saved configuration

• CD-ROM drive for software installation

• SVGA-compatible (800x600) or better graphical colour display. A 17" or
larger monitor is recommended.

• Mouse, trackball or equivalent pointing device

- mouse port and driver software

• Network interface card utilising TCP/IP protocol for communicating with
NMS/10 MF.

• NMS/10 MF or PDH Polling to be configured is successfully installed and
commissioned.

2.5 Compatibility

MF Manager C2.5 is compatible with:

• Windows NT Workstation 4.0 with Service Pack 5 or later

• Windows NT Server 4.0 with Service Pack 5 or later

• Microsoft Windows NT Server 4.0, Terminal Server Edition with Service
Pack 5 (or later)

• NMS/10 MF C2.0

• NMS/10 MF C1.0

• PDH Polling HW C1.0

• PDH Polling SW C1.0 and C2.0.

2.6 Product codes

MF Manager

P31757.01 MF Manager C2.5 (media + licence for 1 system)
P31757.02 MF Manager C2.5 (media + licence for 5 systems)
P31757.03 MF Manager C2.5 (media + licence for 10 systems)

P31757.51 MF Manager C2.5 (software upgrade for 1 system)
P31757.52 MF Manager C2.5 (software upgrade for 5 systems)
DN00276927 © Nokia Networks Oy 15 (274)
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P31757.53 MF Manager C2.5 (software upgrade for 10 systems).

Manuals

C33846.22 MF Manager C2.5 User's Manual.

2.7 Copyright notice

The copyright to the MF Manager software is owned by Nokia Networks Oy. All
rights reserved. Unauthorized use, copying and modification of this software is
prohibited.

©COPYRIGHT Nokia Networks Oy 2000. All rights reserved.
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Installation
3 Installation
This chapter describes the hardware and software installation procedures for MF
Manager C2.5. It covers the following topics:

• Introduction (Section 3.1)

• Installation (Section 3.2).

This chapter assumes that:

• You have the NMS/10 SR CD-ROM.

• The computer in which you are installing MF Manager fulfils the hardware
and software requirements, as detailed in Section 2.4, ’System
Requirements’.

• Microsoft Windows NT has been previously installed and it is running
properly.

• Any previous version of MF Manager has been uninstalled.

• You know how to use Microsoft Windows NT.

3.1 General

The MF Manager software is supplied with a Setup program, which creates the
necessary directories for MF Manager and then copies the program files to the
directories.

When installing MF Manager, a 30-day trial licence is issued for your use. Refer
to Chapter 4, ’Authorising the licence’ for details on acquiring a permanent
licence.
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Note

3.2 Installing software

To be able to install MF Manager, you need to log on Windows NT with
administrator rights. If you wish to use domain groups, you must log on with
adequate privileges for the domain controller.

To install MF Manager:

1. Log on Windows NT as an administrator. Close all other applications
before installing MF Manager.

2. To run the Setup program (only follow option a or b):

a. If you are installing on Windows NT Workstation or Server, insert
the NMS/10 SR CD-ROM in the drive (e.g. D:). After a few seconds,
autoplay starts the Setup.

If your computer does not support autoplay, follow the bulleted
instructions below:
- Select Run... from the Start menu.
- Enter D:\autorun.exe (if D: is the CD-ROM drive letter) in

the Open: field and click on OK.

b. If you are installing on Windows NT Server 4.0 Terminal Server
Edition, start the installation with the Add/Remove Programs in the
Control Panel, and click Install.... Follow the instructions given in
the dialog box, selecting D:\auto run.exe (if D: is the CD-ROM
drive letter) as the install file. After installation TSE will be back in
the Execute mode.

3. You must accept the terms and conditions of the Software Licence to
continue. Click I accept to display the installation main window.

4. The NMS/10 System Release installation main menu is displayed. Click
MF Manager C2.5.

5. Click Install Product to start the installation of MF Manager.

6. The File Download dialog box is displayed. Select Run this program
from its current location and click OK.

7. The Security Warning dialog box is displayed. Click Yes to continue.
18 (274) © Nokia Networks Oy DN00276927
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Installation
8. After initialization, the Welcome dialog box (Figure 3) appears to indicate
the start-up of the installation program.

Figure 3. MF Manager installation, Welcome dialog box

There are usually three buttons in the installation dialog boxes:

- Next> continues to the next step of installation procedure

- <Back returns to the previous step of installation procedure

- Cancel aborts the installation.

Click the Next> button to proceed with the installation.

9. The Software License Agreement dialog box appears. Read the
agreement.

Click Yes if you accept the agreement and wish to continue with the
installation.

If you do not accept the agreement, click No to quit the installation.

10. Depending on the following conditions, MF Manager can be installed in
different folders:
DN00276927 © Nokia Networks Oy 19 (274)
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MF Manager C2.5
If NMS/10 MF C2.0 is installed on the same computer, Setup asks if you
wish to install MF Manager in the NMS/10 MF directory hierarchy.

If the environment variable NOKIAMGR is already defined on the system,
MF Manager will be installed in that folder.

If the environment variable NOKIAMGR is not defined on the system, and
there is a MF Manager licence file in the folder C:\NOKIAMGR\MFM,
MF Manager will be installed in this folder.

Otherwise, the Choose Destination Location dialog box is displayed
(Figure 4). Select one of the provided options, or if you want to install the
files elsewhere, select Other folder.

Click the Next> button to proceed with the installation.

If you selected Other folder, click the Browse... button in the Choose
Destination Location (continued) dialog box and select another folder, or
replace the default folder by typing in a new one.

Figure 4. Choose Destination Location dialog box

11. The Select Program Folder dialog box appears. In this dialog box you can
name the program group to which the MF Manager software icons will be
located.
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Installation
Click the Next> button to proceed with the installation.

12. The Start Copying Files appears and shows you the current settings for the
installation.

If you accept the settings, click the Next> button to proceed with the
installation. Otherwise click Cancel to abort the installation or <Back to
return to change the settings.

In addition to MF Manager, the following programs are installed:

- TMC-MF Converter

- Network Test Client

- NMS/10 Licence Manager.

13. After copying the files to hard disk, the licence system is activated, NMS/
10 security groups are created, and the file and directory permissions are
set.

14. The Setup Complete dialog box appears (Figure 5). If you wish to read the
README file, check the corresponding check box.

Click the Finish button to complete the installation and setup.
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Note

Figure 5. Setup Complete dialog box

A 30-day trial licence is issued for your use during the installation. Refer to
Chapter 4, ’Authorising the licence’ for details on the Licence Manager.

Refer to Chapter 5, ’Getting Started’ for starting and configuring
MF Manager.

For more information about using NMS/10, please refer to the NMS/10
System Release User Manual.
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Authorising the licence
Caution

4 Authorising the licence
This chapter describes how to authorise the MF Manager licences, and assumes
that:

• MF Manager is installed on your computer.

• You are entitled to a licence for this installation. The number of licences
available depends upon the product code for the package you have
purchased.

Moving the PC clock backwards disables any existing licences.

4.1 Software licence validation

The licence verification system used by Nokia is a software licence based on a
Site Code generated for the computer and a Site Key provided by Nokia Customer
Services.

NMS/10-related products are protected by software controlled licensing system.
Before you can use NMS/10 System Frame or other licence-protected
applications like MF Manager, you must have a licence for your installation.

You are granted an automatic 30-day trial licence when starting up MF Manager
for the first time. Note that for each release, this trial licence can be granted only
once on a single PC. Thus, if you reinstall the software after the trial licence
expires, a new trial licence will not be granted. In order to set the system up for
permanent operation you need to purchase a corresponding software licence from
Nokia to get a Site Key installed on your system.

The NMS/10 Licence Manager program is a tool to help the customers of Nokia
to manage licensing of NMS/10 related applications.

When you run Licence Manager on the computer on which you have installed the
software, a Site Code will be generated automatically. Nokia Customer Services
will supply you with a Site Key that matches this Site Code.
DN00276927 © Nokia Networks Oy 23 (274)
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Caution

The software licence is based on the machine and disk configuration and will be
lost if a disk is replaced or reformatted. If you have a disk failure, you will need
to contact Nokia Customer Services to get a new Site Key for your restored
software.

Figure 6. Software licence sequence

Generate
Site Code

Enter Site Key for
Licence Manager

Install Software

Use Software

Nokia
Customer
Services

2.

1.

4.

5.

Supply Site Code
and purchase details
to Nokia Customer
Services

3.
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4.2 Authorising a new licence

To authorise a new licence follow the steps below:

1. Start the Licence Manager from the Windows NT Start menu ( Programs
→ MF Manager → NMS10 Licence Manager). The NMS/10 Licence
Manager dialog box is displayed with the current licence status of NMS/
10 SR products.

Figure 7. NMS/10 Licence Manager dialog box (time-limit licence)

2. Select MF Manager.

3. Click on Generate fax. A dialog box for preparing the fax is displayed. Fill
in your contact information, the licenced product serial number and the
number of copies you request (1, 5, or 10).

4. Click OK. This prints the Authorisation Request fax sheet, including the
newly generated Site Code (a unique number for the PC installation).

5. Send the fax and a copy of your original Licence Agreement to Nokia
Customer Services.

6. Nokia Customer Services supplies a site key code.
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7. In the Licence Manager, select MF Manager and click Set Licence.... The
Set Licence dialog box is displayed.

Figure 8. Set Licence dialog box

8. Enter the code supplied to you in the Site key: edit field.

9. Click Set.

10. If the validation is successful, the confirmation message shown in Figure 9
is displayed.

Figure 9. Licence confirmation message
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4.3 Upgrading a trial licence

If you have a trial licence, you can upgrade it to a permanent software
licence by following the steps below:

1. The software and trial licence must already be installed in the target
machine.

2. Order a full software licence from your Nokia Account Manager.

3. Follow the same steps as in section 4.2.

4.4 Transferring a licence

It is not necessary to contact Nokia Customer Services if you wish to move your
licensed software from one PC to another. The Licence Manager software can
transfer the software licence between the two PC's.

The sequence below assumes that you will be using a floppy disk to hold the
registration and licence information. If both PC's are connected to a LAN and
have access to a shared directory, you could also use the path to the directory as
the location of the registration and licence imprint files.
DN00276927 © Nokia Networks Oy 27 (274)
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Figure 10. Software licence sequence

To transfer the licence, follow the steps below:

1. Install the software in the target computer.

2. Insert a blank floppy disk in the target computer and run Licence Manager.

Write Licence
Imprint File to
Disk

Read Licence
Imprint File
from Disk

Install Software

Use Software

(PC with Licence)

1.

3.

4.

5.

Source Computer

Target Computer

(to new PC)

Create Registration
Imprint File on Disk

2.
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Authorising the licence
Figure 11. NMS/10 Licence Manager dialog box (no licence)

3. Select MF Manager.

4. Select Licence In.... The Licence Transfer dialog box is displayed.

Figure 12. Licence Transfer dialog box (Step 1)
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5. Enter a path. Usually you will need to enter only A:\ in order to transfer the
licence to a floppy disk.

6. Click on OK.

Unless your copy of NMS/10 was unlicensed, the message shown in Figure
13 is displayed to warn you that the previous trial licence will be cancelled.

Figure 13. Kill licence warning message

7. Select Yes.

Figure 14. Licence transfer succeeded message

8. Move the disk to the source computer which has the existing licence and
run Licence Manager. The NMS/10 Licence Manager dialog box is re-
displayed as shown in Figure 15.
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Figure 15. NMS/10 Licence Manager dialog box (licenced)

9. Select MF Manager.

10. Select Licence Out....

Figure 16. Licence Transfer dialog box (Step 2)

11. Enter the correct path if drive A: is not the location of the directory.
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Caution

12. Select OK.

Figure 17. Transfer Out operation succeeded message

13. Move the disk (which now contains the licence) back to the target computer
which was used to create the registration imprint file. (The disk containing
the licence will not transfer the licence to any other computer.)

After you have read the registration file and written the licence imprint file (Step
3 in Figure 10), the source machine no longer has a licence. The only way to
continue using the software is to transfer the licence to the target computer. If you
decide to keep the licence on the source computer after you have written the
licence imprint file, you will have to complete the transfer to the target computer
and then repeat the transfer process to return the licence to the original machine.
Do not lose or damage the disk containing the licence imprint file before the
licence transfer is completed since the original licence now resides on the disk.

14. Run Licence Manager again on the target computer.
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Figure 18. NMS/10 Licence Manager dialog box (no licence)

15. Select MF Manager.

16. Select Licence In....

17. If drive A: is not the location of the file, enter the path and directory
containing the file.

18. Click on OK.
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Figure 19. Licence Transfer dialog box (Step 3)

19. The licence is transferred from the disk to the target PC.

20. Run the software on the target computer. The source computer will still
have the software installed, but its licence is invalid.

Figure 20. Licence Transfer succeeded message
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5 Getting started
This chapter explains the basic principles of operation of MF Manager. It covers
the following topics:

• Security (Section 5.1)

• Starting MF Manager (Section 5.2)

• Working with NMS/10 MF configurations (Section 5.3)

• Configuring NMS/10 MF and PDH Polling (Section 5.4)

• Using online help (Section 5.5)

• Printing (Section 5.6)

• Making backups (Section 5.7)

• Restoring backups (Section 5.8)

• Exiting MF Manager (Section 5.9).

This chapter assumes that:

• The MF Manager program has been installed in your computer as
described in Chapter 3.

• A licence has been authorised as described in Chapter 4.

• There is a network connection available between the computer with MF
Manager and NMS/10 MF.

For information about operating NMS/10, refer to the NMS/10 System Release
User Manual.

5.1 Security

For additional information on user groups and shares created by MF Manager and
NMS/10 MF installation programs, refer to Appendix A.2.
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The NMS/10 security model defines five user groups that are used as security
levels. The user groups, sorted in ascending order by the security level, are:

• NMS/10 Operator

• NMS/10 Basic

• NMS/10 Experienced

• NMS/10 Network Administrator

• NT Administrator.

The NT Administrator group is a combination of two predefined Windows NT
user groups: Domain Administrator and Local Administrator.

If you do not belong to any of the user groups, MF Manager displays an error
message and does not start. If you belong to multiple user groups, the most
powerful user group defines the security level.

MF Manager installation program creates the first four user groups. You (or the
administrator) must add your username to one of the security groups. You must
belong in the security group both on the local computer and on the NMS/10 MF
computer.

Initially all restrictions are enforced according to user security level on the local
computer. When MF Manager connects to an NMS/10 MF C2.0, it re-checks to
which security group you belong on that computer. If it is lower, that will be used.
In some cases, e.g. you do not belong in any of these groups on the system, you
are not allowed to do anything on that computer.

The section below describes the operations allowed on each security level (the
next level always includes all the allowed operations on the previous levels):

NMS/10 Operator

Can create a new configuration or open an existing local configuration, but cannot
save changes. Save or Save As... commands only validate the configuration.

NMS/10 Basic

Can connect to the NMS/10 MF, but cannot send changes

Configuration files are overwritten on the local PC.
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Can work with network scan and auto-discovery log files that are on the local PC,
but cannot remove the log files or anything from them. Can save the
configuration. Can view the date, time, timezone, and daylight saving settings on
the NMS/10 MF workstation, but cannot change them. Can view the status of the
NMS/10 MF processes and make queries about current users on the selected
system.

NMS/10 Experienced

Can fully work with network scan and auto-discovery log files, both local and
remote. Can send the configuration.

NMS/10 Network Administrator

Can fully use MF Manager: define fault status consistency checks and network
scans; set the date, time, timezone, and daylight saving settings on the NMS/10
MF workstation; stop, start, and restart NMS/10 MF processes and restart the
NMS/10 MF workstation.

NT Administrator

Can manage Windows NT access rights, for example, define users' security levels
using the NMS/10 user groups. This is done using Windows NT's own security
features and tools.

5.2 Starting MF Manager

To start MF Manager:

1. Log on Microsoft Windows NT.

2. Select the MF Manager item found from the Windows NT 4.0 Start →
Programs →  MF Manager menu.

An empty main window titled MF Manager C2.5 is displayed (Figure 21).
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Figure 21. MF Manager starting window

5.3 Working with configurations

MF Manager has two kinds of configurations: an off-line configuration and an on-
line configuration.

An off-line configuration is opened with Manage → Open..., or created with
Manage →  New.... With an off-line configuration, you are working with a
configuration on the local PC. A connection to the NMS/10 MF is not needed, and
hence off-line configurations can be created in advance to be utilised later. The
configuration is not necessarily up-to-date. A new configuration is always off-
line at the beginning.

An on-line configuration is opened with Manage → Connect.... With an on-line
configuration, you are working with the configuration on the NMS/10 MF. There
is a connection to the NMS/10 MF and the up-to-date configuration is copied
from there.
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A current configuration is the configuration (off-line or on-line) you are working
with.

Naming configurations

An off-line configuration can have any name, as long as the name is a valid
computer name (existing or non-existing). The length of the name can be 15
characters.

An on-line configuration name is always the same as the computer name of the
NMS/10 MF or PDH Polling workstation.

Sending configurations

You can send the current configuration to NMS/10 MF or PDH Polling with the
command Manage → Send. If you are working with an on-line configuration, the
configuration is activated immediately. If the configuration is off-line, the
configuration is activated in the next restart of NMS/10 MF or PDH Polling.

The off-line configuration name must be the same as the computer name of NMS/
10 MF. Use Manage → Save As... if necessary.

MF Manager restarts the NMS/10 MF automatically when an off-line
configuration is sent.

You cannot use Manage → Send if:

• there is no Configuration window or it is iconized

• the user level is lower than NMS/10 Experienced

• configuration is a new configuration, i.e. it has no name

• connection to NMS/10 MF is open, but there are no changes in the
configuration.

Connection to NMS/10 MF

When connecting to NMS/10 MF or PDH Polling with MF Manager, you must
have adequate user rights on the target workstation.

For more information, refer to Appendix A, ’Connecting Nokia Managers to
NMS/10 MF or PDH Polling workstation’.
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Configuration types

NMS/10 MF C2.0

This configuration contains buses, PDH Manager Interfaces, OS Interfaces,
Printer Spoolers, SNMP Interface, and Network Test Interface. You can also
define the performance monitoring.

There are one polling unit and two Q1 Interface units installed in an industrial PC.
Configuration can contain up to 16 buses.

PDH Manager Interface does not contain FM information.

NMS/10 MF C1.0

This configuration contains buses, PDH Manager Interfaces, OS Interfaces, and
Printer Spoolers. You can also define the performance monitoring.

There are one polling unit and two Q1 Interface units installed in an industrial PC.
Configuration can contain up to 16 buses.

This configuration type was PDH Polling and OS Interface in MF Manager C2.0.

PDH Polling C2.0

This configuration contains buses and PDH Manager Interfaces. User can also
define the performance monitoring.

There are one polling unit and one Q1 Interface unit installed in a desktop PC.
Configuration can contain up to 8 buses.

This configuration type was PDH Polling and PM Poller in MF Manager C2.0.

PDH Polling C1.0

This configuration contains buses and PDH Manager Interfaces.
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There is one polling unit and one Q1 Interface unit installed in a desktop PC.
Configuration can contain up to 8 buses.

This configuration type was PDH Polling in MF Manager C2.0.

Interfaces

PDH Manager interface

These interfaces are used by PDH Alarm Manager and node managers.

OS interface

This interface is used by NMS/100(0).

Printer spooler

This interface is used for printing out alarms.

SNMP interface

This interface is used for sending alarm information via SNMP.

Network Test interface

The Network Test client runs tests through this interface.

5.3.1 Creating a new configuration (off-line)

The following steps are required to enable MF Manager to work properly with
NMS/10 MF or PDH Polling. For details on configuration types, refer to section
6.22, ’Configuration window’.

You must at least give an equipment ID for a new configuration before you can
save or send it. For the configuration type NMS/10 MF C2.0 also the logon
domain of Network Test Interface is required.
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To create a new configuration:

1. Choose the menu command Manage → New. Select the configuration type
in the Configuration Type dialog box and click OK.

Select the configuration type according to Table 2, depending on which
configuration you wish to start.

2. A new configuration with default values will be opened in the
Configuration window.

3. Give an equipment ID for the configuration by choosing Configure →
PDH Polling General... and filling in the Equipment ID in the
Equipment ID tab of the PDH Polling General dialog box.

If you selected NMS/10 MF C2.0 as the configuration type, define the
logon domain in the Network Test Interface dialog box by choosing
Configure → Network Test Interface....

4. Add a bus to the configuration:

Click on the Buses tab to make it active.

Choose Configure → Bus → Add.... The Add Bus dialog box is
displayed.

Select a bus number (0...240) from the list and click OK. The Bus x dialog
box is displayed.

You can either configure the bus or accept the default values. In either case
you must select the port in the Port tab. Refer to Section 6.12, ’Bus x dialog
box’ for details on configuring buses. Click OK when you have completed
configuring the bus.

5. Define network addresses for the bus:

Table 2. Configuration types of MF Manager

Configuration type Equipment

NMS/10 MF C2.0 NMS/10 MF C2.0

NMS/10 MF C1.0 NMS/10 MF C1.0

PDH Polling C2.0 PDH Polling Functionality C2.0

PDH Polling C1.0 PDH Polling Functionality C1.0
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Click the Buses tab to make it active.

Choose Configure → Bus → Addresses... or click Edit... in the Bus x
dialog box. The Addresses dialog box is displayed.

See Section 6.8, ’Addresses dialog box’ for details on defining addresses
for buses. Click OK when you have completed defining addresses.

6. Define PDH manager interface:

Click the PDH Manager Interfaces tab to make it active.

Choose Configure PDH Manager Interface Add.... The PDH Manager
Interface dialog box is displayed.

Define the logon domain in the Port tab.

See Section 6.41, ’PDH Manager Interface x dialog box’ for details on
changing the configuration of PDH Manager interface. Click OK when
you have completed the configuration.

7. Define OS interface:

Click the OS Interfaces and Printer Spoolers tab to make it active.

Choose the menu command Configure → OS Interface → Add.... The
OS Interface dialog box is displayed.

Define the logon domain in the Ports tab.

See Section 6.39,’OS Interface x dialog box’ for details on changing the
configuration of OS interface. Click OK when you have completed the
configuration.

8. Save the new configuration with the command Manage → Save As... and
if you wish to send it to NMS/10 MF or PDH Polling, use the command
Manage → Send.

The name must be the same as the MF computer name.

5.3.2 Changing an existing off-line configuration

To open an existing off-line configuration:

1. Choose the menu command Manage →  Open.... The Open dialog box
will be displayed.
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2. Select an off-line configuration name in the Name: list box and click OK.
The off-line configuration will be opened in the Configuration window.

 To change an opened off-line configuration:

1. Add, modify or delete a bus from the configuration:

Choose one of the menu commands Configure →  Bus → Add.../
Modify.../Delete.

See Section 6.10.5, ’Configure menu’ for modifying buses.

2. Define network addresses for the buses:

Choose the menu command Configure →  Bus → Addresses.... The
Addresses dialog box will be displayed.

See Section 6.8, ’Addresses dialog box’ for details on defining addresses
for buses. Click OK after completing defining addresses.

3. Save the modified configuration with the command Manage → Save and
if you wish to send it to NMS/10 MF or PDH Polling, use the command
Manage → Send.

5.3.3 Changing an on-line configuration

To select an on-line configuration:

1. Give the menu command Manage → Connect.... The Connect dialog box
will be displayed.

2. Select or type an on-line configuration name in the Name list box and click
OK. The on-line configuration will be opened in the Configuration
window.

Connection to the NMS/10 MF or PDH Polling remains open until you
disconnect it with the Disconnect command.

To change an on-line configuration:

• Follow the steps in the previous section that describes how to change an
opened off-line configuration.
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5.4 Configuring NMS/10 MF and PDH Polling

This section describes the work order and main tasks of configuring NMS/10 MF
and PDH Polling with MF Manager. It covers the following topics:

• Converting TMC configurations (Section 5.4.1)

• General settings (Section 5.4.2)

• Adding buses (Section 5.4.3)

• Adding network elements (Section 5.4.4)

• Configuring the PDH Manager interface (Section 5.4.5)

• Configuring the OS interface (Section 5.4.6)

• Adding alarm printers (Section 5.4.7).

For details on installation and commissioning NMS/10 MF, refer to the NMS/10
MF Operating Manual.

The Readme file of MF Manager contains the latest information on MF Manager.

The README.TXT file of NMS/10 MF contains the latest information on NMS/
10 MF and things to take into consideration when it is used with other NMS
systems.

Configuring PDH Polling

Configuring PDH Polling is similar to configuring NMS/10 MF with the
exception that OS Interfaces, Printer Spoolers, SNMP Interface and Network Test
Interface are not available.

For details on installation and commissioning PDH Polling, refer to the PDH
Polling Installation Instructions.

The README.TXT file of PDH Polling contains the latest information on PDH
Polling and things to take into consideration when it is used with other NMS
systems.

5.4.1 Converting TMC configurations

If you wish to use existing TMS4 configurations, use TMC-MF Converter
before making any other configurations with MF Manager.

You can add network elements from TMC (TMS4) configurations with the TMC-
MF Converter program which is included in the MF Manager installation disks.
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To convert TMC configuration into NMS/10 MF or PDH Polling
configuration:

1. In TMS4, write the TMC configuration to a floppy disk. For details, refer
to the TMS4 Operating Manual.

2. Insert the disk in the computer where you have MF Manager and TMC-MF
Converter installed.

3. TMC-MF Converter will not overwrite an existing NMS/10 MF
configuration. If you wish to use an existing name, rename or remove the
old configuration. See Appendix B for details on handling configurations.

4. Start TMC-MF Converter from the Windows NT Start menu (Programs
→  MF Manager → TMCMF Converter).

5. Enter the destination configuration name (the target NMS/10 MF computer
name), and click Convert.

6. Start MF Manager and open the created configuration (Manage →
Open...).

To modify the configuration:

1. Fill in all information marked with question marks (?). You may need to
change the configuration type from the default NMS/10 MF C1.0 (Manage
→  Special Change → Configuration Type).

2. Set the Q1 Packet time-out value.

Polling parameters are not converted. NMS/10 MF or PDH Polling default values
are used instead.

3. Save the configuration (Manage → Save or Manage → Save As...).

If saving fails, there are inconsistencies in the configuration.
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To transfer the configuration to NMS/10 MF or PDH Polling:

1. After you have successfully saved the configuration, send it to the target
NMS/10 MF or PDH Polling (Manage → Send).

2. The target NMS/10 MF or PDH Polling restarts with the new
configuration.

5.4.2 General settings

You can change the general settings of NMS/10 MF and PDH Polling with the
MF Manager command Configure → PDH Polling General.... Make the
following settings:

• set identification number for the system (Equipment ID)

• select the FE name format

• define stations

• define equipment types (device types)

• define global filter and alarm classification.

For details, refer to Chapter 6, ’Reference’.

5.4.3 Adding buses

 To add buses:

1. Choose Configure →  Bus → Add....

2. Define the bus number and physical port.

3. Set the value of Q1 packet time-out according to local network
environment.

At the beginning, we recommend a longer time-out to find out that the
connection to network elements is in order (for example, with bus speed
9600 bit/s, set the Q1 packet time-out to 5 [500 ms], and with bus speed
2400 bit/s, set it to 8 [800 ms]). Later you can optimise the system
performance by decreasing the time-out value.
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4. Send the configuration to NMS/10 MF or PDH Polling (Manage → Send).

5.4.4 Adding network elements

To do the network scan:

1. Choose Manage →  Special → Network Scan....

2. Define buses for the network scan and address ranges for each bus.

3. Click Start. If the address range is large, it will take some time to complete
the scan. A moving magnifying glass is displayed on the status bar during
the scan (if there is a connection).

The network scan is the quickest and most convenient way of creating a network
configuration. Before scanning the network, you must add all the necessary buses
and send the configuration to the NMS/10 MF or PDH Polling.

 To check if the network scan is complete:

• A moving magnifying glass is displayed on the status bar during the scan
(if there is a connection).

• Choose View → Network Scan Log....

- If the network scan is in progress, MF Manager displays a message
about it.

- If the network scan is completed, MF Manager displays the network
scan log.

To add network scan results to the configuration:

1. Add the addresses to the configuration.

The FE name may be as is, but you need to define a station and device type.

2. Send the configuration to NMS/10 MF or PDH Polling (Manage → Send).
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5.4.5 Configuring the PDH Manager interface

Nokia Node Managers and Alarm Managers use the PDH Manager interface for
connecting to NMS/10 MF and PDH Polling. The user information sent to the
NMS/10 MF or PDH Polling must be valid within the logon user groups when
attempting to log on. On the NMS/10 MF C2.0 you must define the logon group.
Others use the fixed Nokia NMS/10 MF Command Interface user group.

After the installation of NMS/10 MF or PDH Polling, there is one PDH Manager
interface readily configured. Also, the user PAM (with an initial password PAM)
has been created into the Nokia NMS/10 MF Command Interface user group.
Nokia Node Managers may use the PAM user account for logging in via this PDH
Manager interface. We recommend you to change the password of the user PAM,
or add new users to the Nokia NMS/10 MF Command Interface user group.

If the configuration type is NMS/10 MF C2.0, you can connect to one PDH
Manager Interface from multiple computers. Other configuration types require a
separate PDH Manager Interface for each computer.

To configure the PDH Manager interface:

1. Check the current parameters of the PDH Manager interface and make the
necessary changes (Configure → PDH Manager Interface → Modify...).

2. The PDH Manager Interface dialog box is displayed. Modify the fields
in the General tab if necessary and then click on the Port tab.

3. Fill in the fields in the Port tab:

Nokia Node Managers and Alarm Managers must use the TCP/IP port
defined here. Make sure that no other PDH Manager interface uses this
TCP/IP port.

4. Save the configuration and activate it (Manage → Send) in the NMS/10
MF or PDH Polling. If you created a new configuration, save it with the
name of the NMS/10 MF or PDH Polling you wish to send the
configuration to.

5.4.6 Configuring the OS interface

If you are planning to use NMS/100 or NMS/1000, add or modify an OS Interface
(Configure → OS Interface...).
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After the installation of NMS/10 MF, one OS Interface is readily configured.

PDH Polling C2.0 and C1.0 do not support OS Interfaces.

5.4.7 Adding alarm printers

To add alarm printers:

1. Add printer(s) used for alarm printing (Configure → Printer Spooler →
Add...).

2. The Printer Spooler dialog box is displayed. In the Printer tab, define the
printer name and print job parameters.

If NMS/10 MF has a local printer (directly connected), named as
MFPrinter, the configured printer name can be in format:

MFPrinter

If the printer is referred to with its share name, the format is:

\\ComputerName\PrinterShareName.

PDH Polling C2.0 and C1.0 do not support Printer Spoolers.

5.5 Using online help

You can request help by  using one of the following methods:
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• Choose the Help → Help Topics menu command in the MF Manager
application window or click the Help icon in the toolbar to display the
Help Topics dialog box.

Then you may choose a topic in the Index tab, or search a topic in the Find
tab.

• Press F1 or choose the menu command Help → Active Window to get
help about the Configuration window. Pressing F1 when there is no
Configuration window opens the Help Topics dialog box.

• Click a Help button in a dialog box to get help about that particular dialog
box.

For further information on how to use online help, refer to Microsoft Windows
user documentation.

5.6 Printing

You must set the printer up  correctly before printing. If you have not set your
printer up, follow the instructions given in your printer manual and Microsoft
Windows user documentation. Choosing Manage → Print Setup... allows you
to change the printer and its settings, and with Manage → Page Setup... you can
change page settings such as margins and fonts.

To print a configuration report:

1. Choose Manage → Print... to print a configuration report.

2. You can select in the Print Selection dialog box what information will be
included in the configuration report. Click OK to print the report.

3. The standard Abort Printing dialog box appears. You can cancel printing
by clicking the Cancel button. The dialog box closes automatically when
printing is completed.
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Caution

5.7 Making backups

Always back up the configuration files after changing them and keep the files in
a safe place. If you have a problem with the system, such as a hard disk crash, you
can copy the backup files to their original locations and resume operation.

SNMP configuration file, which MF Manager uses does not have all the
parameters that the SNMP Interface uses, for example, trap destinations. If you
want to make a full backup of the NMS/10 MF C2.0 configuration, you must also
backup the SNMPD.CNF file on the NMS/10 MF C2.0 computer. This file is
located in the folder C:\PROGRAM FILES\NOKIA\NMS10\COMMON
AGENT.

MF Manager stores configurations into folders located under the
C:\NOKIAMGR\MFM folder (if C:\NOKIAMGR is the installation folder). The
structure of MF Manager folders is explained in Appendix B, ’Directory
hierarchy’.

When MF Manager connects to the target system, it reads the whole
configuration. For example, if MF Manager connects to a target system named
TARGET, the folder C:\NOKIAMGR\MFM\TARGET contains the target
system configuration.

We recommend you to back up all folders located under the
C:\NOKIAMGR\MFM folder. MF Manager keeps common configuration files in
this folder. If those files have been modified or new files have been added, back
them up as well.

Licence Manager creates four hidden files (MFM.41S, MFM.ENT, MFM.KEY,
MFM.RST) to the MF Manager's root directory (usually C:\NokiaMgr\mfm). Do
not remove, rename, or move them.

The software license is based on the computer and disk configuration and will be
lost if a disk is replaced or reformatted. If you have a disk failure, you will need
to contact Nokia Customer Services to get a new Site Key for your restored
software.
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5.8 Restoring backups

To restore backups:

1. Restore all needed configuration folders from your backup media to the
C:\NOKIAMGR\MFM folder.

If you have backed up the SNMPF.CNF file, restore it as well.

2. Start MF Manager and open a configuration (Manage → Open).

3. Send the configuration to the target system (Manage → Send).

5.9 Exiting MF Manager

To exit MF Manager:

1. Choose Manage→ Exit or double-click the Control menu box in the top-
left corner of the MF Manager application window.

2. If there is an open connection and/or the current configuration has changed,
MF Manager warns you about it and asks if you wish to save, send or
cancel the shutting down of the program.

3. MF Manager closes down.
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6 Reference
This chapter describes in detail the available menu commands. It also explains the
functions of various windows and dialog boxes.

Using the Reference

The windows and dialog boxes are presented in alphabetical order.

The windows and dialog boxes shown are examples; the exact contents will
depend on the monitored network and its status.

To find information on a certain window or dialog box:

1. See the name of the window displayed in the title bar:

Figure 22. The title bar of a window or dialog box

2. See the corresponding section of this chapter.

6.1 About MF Manager dialog box

This dialog box shows the release and version information about MF Manager.
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6.2 Add Alarm Classification dialog box

This dialog box allows you to define alarm severity for the interface. The
configuration type NMS/10 MF C2.0 also allows you to set global alarm
classifications.

Alarm severity definitions made in MF Manager do not have any effect on PDH
Alarm Manager alarm severity, because it defines alarm severities of its own.

This dialog box is used for:

• adding a new alarm classification (Add Alarm Classification)

• modifying a selected alarm classification (Modify Alarm Classification).

There are four or five levels of severity:

• CRITICAL (***), sometimes also denoted as FATAL

• MAJOR (**)

• MINOR (*)

• WARNING (in the configuration type NMS/10 MF C2.0)

• UNCLASSIFIED.

With the PDH Manager Interfaces, OS Interfaces, and Printer Spoolers, the alarm
severity is displayed as asterisks (*). In this case, WARNING is the same as
UNCLASSIFIED (no asterisks).

You can define an alarm classification for the following instances:

• Management network (i.e. the global alarm classification)

• PDH Manager interface (excluding NMS/10 MF C2.0)

• OS interface

• SNMP interface

• Printer spooler.
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The global alarm classification can be used for overriding the default severity
assignment of all events (except for internal faults on bus 254). The initial
severities of events generated by ND generation fault polling is set based on fault
codes according to the NMS/10 MF Fault Codes (an appendix to the NMS/10 MF
C2.0 Operating Manual). E generation fault polling obtains the initial severity
from the network element.

Only the configuration type NMS/10 MF C2.0 can have a global alarm
classification.

Bus 254 has its own built-in severities. If you want to override them, do it using
the interface-specific alarm classification.

One interface can have only one alarm classification. Same alarm classification
can be set to multiple interfaces.

Figure 23. Add Alarm Classification dialog box
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Name

Name of the alarm classification. There is no default value.

The normal Windows NT file name limitations apply. MF Manager adds the
extension. CLF to the name, so it must not appear in the name in advance.

Severity definitions

This group box contains a list of definitions of the alarm classification.

The general format of an alarm classification is the same as the filter definition.
For details refer to Section 6.5, ’Add Filter dialog box’.

In the global alarm classification, the SEVERITY cannot be used.

When an alarm fulfils the logical statement, its severity is defined. Mapping of
the alarm goes from ’CRITICAL’ to ’MINOR’, or from ’CRITICAL’ to
’WARNING’, depending on the configuration type, and stops as a match is
found. If the alarm does not match with any of the classifications, its severity is
tagged as ’UNCLASSIFIED’.

If any of the alarm classification types is missing, severities of that type are not
created. However, at least one severity definition must be present.

An example:

CRITICAL BUS=1,3,5-7 AND FC=200

MAJOR    BUS=1,3,5-7 AND FC=201

MINOR    BUS=1,3,5-7 AND ADDRESS=100 AND FC=20

Alarm severity is critical if bus number is 1, 3, 5, 6 or 7 and fault code is 200.

Alarm severity is major if bus number is 1, 3, 5, 6 or 7 and fault code is 201.

Alarm severity is minor if bus number is 1, 3, 5, 6 or 7 and physical address is 100
and fault code is 20.

Otherwise alarm severity is unclassified.

Definitions / Critical

A definition of the critical alarm classification. This severity is sometimes also
denoted as fatal.

Definitions / Major
58 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Reference
Note

A definition of the major alarm classification.

Definitions / Minor

A definition of the minor alarm classification.

Definitions / Warning

A definition of the warning alarm classification. Only the configuration type
NMS/10 MF C2.0 supports warnings.

Comment

A free format text comment about the alarm classification. Quotation marks are
not allowed in the comment field.

OK

Closes the Add / Modify Alarm Classification dialog box.

The syntax of the definition is checked. If there are errors, MF Manager informs
you about them and cancels the operation.

MF manager also checks if the alarm classification definition is too deep. If the
depth is over 200 levels (see section 6.5, ’Add Filter dialog box’), MF Manager
informs you about it and cancels the operation.

If you add a new alarm classification or change its name and the name is the same
as an existing name, an error message is displayed and the operation is cancelled.

The alarm classification is saved into the file when the configuration is saved.

This button is disabled if the Name field or all the Definitions group box fields
are empty.

Cancel

Closes the Add / Modify Alarm Classification dialog box and discards changes.

Help

Displays help about the Add / Modify Alarm Classification dialog box.
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6.3 Add Bus dialog box

This dialog box allows you to select the bus number.

Figure 24. Add Bus dialog box

Bus

The bus number can be 0...240. The default is the first free bus number.

Only available bus numbers are displayed.

OK

Closes the Add Bus dialog box and continues the operation that called this dialog
box.

This button is disabled if no bus is selected.

Cancel

Closes the Add Bus dialog box and discards the selection. No new bus is added.

Help

Displays help about the Add Bus dialog box.

6.4 Add Device Type dialog box

This dialog box allows you to define a product family for a supervising
management system (for example, NMS/10 and NMS/100).

This dialog box is used for:
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• adding a new device type (Add Device Type)

• modifying a selected device type (Modify Device Type).

Figure 25. Add Device Type dialog box

Device type

The device type number can be 0...254. The box contains only available device
type numbers.

This field is disabled in the Modify Device Type dialog box.

Name

The length of the device type name can be 1...16 characters. There is no default
value.

OK

Closes the Add / Modify Device Type dialog box.

This button is disabled if the Device type or Name field is empty.

Cancel

Closes the Add / Modify Device Type dialog box and discards changes.

Help

Displays help about the Add / Modify Device Type dialog box.

6.5 Add Filter dialog box

This dialog box allows you to add filters and change the filter information.

This dialog box is used for:
DN00276927 © Nokia Networks Oy 61 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
Note

• adding a new filter (Add Filter)

• modifying a selected filter (Modify Filter).

You can define a filter for the following interfaces:

• Management network (i.e. the global filter)

• PDH Manager interface (excluding NMS/10 MF C2.0)

• OS interface

• SNMP interface

• Printer spooler.

The global filter comes before all other filters. The global filter cannot filter bus
254 alarms. That must be done using the interface-specific filter.

One interface can only have one filter. Same filter can be set for multiple
interfaces. If there is no filter for an interface, all alarms go through that interface.

Figure 26. Add Filter dialog box

Name
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The name of the filter. There is no default value.

The normal Windows NT file name limitations apply. MF Manager adds the
extension. FLT to the name, so it must not appear in the name in advance.

Filter type

You can select the type of filter in this group box.

Filter type / Inclusive

The type of the filter defined in the Definition edit box is inclusive, that is, alarms
matching to the definition are passed through.

This is the default selection.

Filter type / Exclusive

The type of the filter defined in the Definition edit box is exclusive, that is, alarms
matching to the definition are not passed through.

Definition

The filter definition. There is no default value.

With all configuration types, you can use the following parameters in the
definition:

With the configuration type NMS/10 MF C2.0, you can also use the following
parameters in the definition:

Parameter Range of values Key

Bus number 0...240, 254 BUS

Address 0...4093, 65535 ADDRESS

FE number 0...254 FE

SB number 0...254 SB

Fault code 0...254 FC

Alarm type ALARM, CANCEL, DISTURBANCE TYPE

FE status A, B, D, S, E FE_STATUS
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You can use the following logical operators in the definition:

The general format of a filter is as follows:

logical_statement(s)

where logical_statement = key=value

• key = BUS, ADDRESS, FE, SB, FC, TYPE, FE_STATUS,FC, TYPE,
GENERATION, SEVERITY, or S_STATUS;

• value = a value that must be fulfilled; multiple numerical FE_STATUS and
S_STATUS values can be entered by separating them with a comma, and a
range of numeric values can be given with a hyphen as a separator.

You can combine multiple logical statements with the logical operators NOT,
AND and OR, and use parentheses for grouping the statements, as illustrated in
the example below.

FE_STATUSes are by default matched exactly. If a filter has the entry:

FE_STATUS=A

then the status of the FE must be exactly A.

Parameter Range of values Key

Fault code 256...65535 FC

Alarm type NOTIFICATION, WARNING TYPE

NE generation ND, E, NONE GENERATION

Fault severity CRITICAL, MAJOR, MINOR, WARNING,
UNCLASSIFIED

SEVERITY

Severity status ACTIVE, CRITICAL, MAJOR, MINOR, WARNING,
DISTURBANCE

S_STATUS

Operator Description

NOT Logical statement after ’NOT' must be false

AND Logical statements on both sides of 'AND' must be true

OR Logical statement on either side of 'OR' must be true

The precedence is (from highest to lowest): NOT, AND, OR
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However, you can use keywords ANY and ALL in the FE_STATUS list to make
it match in case any of the status bits are set respectively. For example:

FE_STATUS=A,B

matches to a status byte that has exactly the status bits A and B on.

FE_STATUS=ANY A,B

matches to any status byte that has a status bit A or B on.

FE_STATUS=ALL A,B

matches to a status byte that has both the status bits A and B on.

Severity statuses are handled in the same way as FE statuses.

An example of a filter of the type INCLUDE:

(BUS=1,3,5−7 AND ADDRESS=100 OR BUS=4) AND FC=200

An alarm passes the filter if bus number is 1, 3, 5, 6 or 7, physical address 100 and
fault code 200, or bus number is 4 and fault code 200.

The filter definition cannot be arbitrarily complex. There is a limit of 200 levels
of nesting for the definition. The depth of a filter is the maximum nesting level of
the match expressions used in the definition. For example, the depth of the
following definition is two:

TYPE=ALARM OR FC=15

whereas the following definition has a depth of 5:

NOT (TYPE=ALARM OR (TYPE=CANCEL AND FC=5−6 AND BUS=5 ) )

The depth can also be defined as the longest path from the root to the leaf in the
syntax tree. The syntax tree for the above definition is visualized in the example
below:
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Note

Comment

A free format text comment about the filter. Quotation marks are not allowed in
the comment. There is no default value.

OK

Closes the Add / Modify Filter dialog box.

Syntax of the definition is checked. If there are errors, MF Manager informs you
about them and cancels the operation.

MF manager also checks if the filter definition is too deep. If the depth is over 200
levels, MF Manager informs you about it and cancels the operation.

If you add a new filter or change the name of an existing filter and its name is
same as an existing filter, an error message is displayed and the operation is
cancelled.

The filter is saved into the file when the configuration is saved.

This button is disabled if the Name or Definition field is empty.

Cancel

Closes the Add / Modify Filter dialog box and discards changes.

Help

Displays help about the Add / Modify Filter dialog box.

NOT

OR

TYPE=ALARM AND

TYPE=CANCEL AND

FC=5-6 BUS=5
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6.6 Add PM Jobs dialog box

This dialog box is described in Section 6.14, ’Bus x  Add PM Jobs dialog box’.

Figure 27. Add PM Jobs dialog box

6.7 Add Station dialog box

This dialog box allows you to add stations and change station information.

This dialog box is used for:

• adding a new station (title bar Add Station)

• modifying a selected one (title bar Modify Station).
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Figure 28. Add Station dialog box

Station

The station number can be 1...254. The box contains only available station
numbers.

This field is disabled in the Modify Station dialog box.

Name

The length of the station name can be 1...12 characters. There is no default value.

OK

Closes the Add / Modify Station dialog box.

This button is disabled if the Station or Name field is empty.

Cancel

Closes the Add / Modify Station dialog box and discards changes.

Help

Displays help about the Add / Modify Station dialog box.

6.8 Addresses dialog box

This dialog box allows you to change addresses of the selected bus.

This dialog box is used for:
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• showing all FEs from the selected bus or all the buses (title bar Addresses)

• showing a subset of FEs from the selected bus or all the buses (title bar
Addresses (SUBSET)).

Figure 29. Addresses dialog box

Bus

A list of buses defined to NMS/10 MF. Addresses on the selected bus are
displayed in the list box below this combo box. If you open this dialog box from
the Bus dialog box, the selection is fixed to that bus. The default is empty
selection.

The selection All is present only if more than one bus is present.

The bus 254 is reserved for the system. It is reserved for reporting about internal
faults of NMS/10 MF.
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Note

When the you select another bus and there are changes, MF Manager asks if you
wish to save the changes and informs that the changes are saved permanently
(although not yet to the configuration files); they cannot be cancelled later with
the Cancel button. MF Manager validates the FE names, NE generations,
stations, device types, and the existence of FE0 on each address. MF Manager
displays a warning message if the configuration type is NMS/10 MF C2.0 and an
ND generation element has PM jobs that are not in the FE 0. In case of invalid
values, MF Manager displays an error message and the bus is not changed.

The user-definable limits for the number of addresses per bus and number of FEs
in the polling unit, i.e. system, are not enforced here (see ’Limits tab’ in section
6.42, ’PDH Polling General dialog box’). They are checked when you save the
configuration.

“note field”

Next to the Bus combo box is a (usually empty) note field that is used to display
additional information about the selected bus(es).

Possible notes are:

• the selected bus is not a real bus but the system-defined bus 254

• all activity is suspended on the bus

• all fault polling and auto-discovery is suspended on the bus

• all activity is suspended on at least one bus

• all fault polling and auto-discovery is suspended on at least one bus

• all activity is suspended on at least one bus and all fault polling and auto-
discovery is suspended on at least one bus.

The last three cases are possible if All is selected in the Bus combo box.

“address list”

A list of addresses and FEs on the selected bus or all the buses. By default, the
rows are sorted in ascending order by the bus/address/FE combination. You can
use the header to sort the lines in different ways. For example, clicking Station in
the header sorts the rows in ascending order by the station name. The secondary
sorting rule is always the bus/address/FE combination.
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Note

If a subset is defined, only those FEs are shown. Addresses (SUBSET) is
displayed on the title bar. A subset can be defined in the Subset Definition dialog
box that opens with the Define Subset... button.

Different FEs on one address can have different station and device type settings.
Fault polling is per address, not per FE. PM is per FE if the configuration type is
NMS/10 MF C2.0. Otherwise, PM is per address.

The Gen. field can be ND, E, or empty. It is empty if:

• the configuration type is NMS/10 MF C1.0, PDH Polling C2.0, or PDH
Polling C1.0

• the NE generation is unknown

• the address is the system-defined address 65535

• the bus is the system-defined bus 254.

The status at the end of the row can be one of the following:

• empty: the address is not in fault polling. The address or FE has no PM jobs

• F: the address is in fault polling

• F S: the address is in fault polling, but suspended

• F S P: the address or FE is in fault polling, but suspended. The address or
FE has PM jobs

• F P: the address is in fault polling. The address or FE has PM jobs

• P: the address or FE has PM jobs.

The Status field is empty if the selected bus is the system-defined bus.

If all activity is suspended on the bus, it is not indicated with S in the addresses.
If the configuration type is NMS/10 MF C2.0, only those FEs that have PM jobs
has the ’P’ in the Status field. Otherwise, all FEs of an address that has PM jobs
have the ’P’ in the Status field.

The address 65535 is reserved for the system for reporting bus-related faults and
it is always present (except for bus 254).

The “address list” is empty if:
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• no buses are selected

• no FEs fulfil the active subset definition.

OK

Closes the Addresses dialog box.

If there are changes, MF Manager validates FE names, NE generations, stations,
and device types. If they are invalid, MF Manager displays an error message. The
dialog box is not closed.

MF Manager displays a warning message if the configuration type is NMS/10 MF
C2.0 and an ND generation element has PM jobs that are not in the FE 0.

The user-definable limits for the number of addresses per bus and number of FEs
in the polling unit, i.e. system, are not enforced here (see ’Limits tab’ in section
6.42, ’PDH Polling General dialog box’). They are checked when you save the
configuration.

Cancel

Closes the Addresses dialog box and discards changes.

Add...

Opens the Bus x - Add Address(es)/FE(s) dialog box.

If the selected bus is the system-defined bus 254, NE generation, Station,
Device type, and In fault polling have fixed values.

If you changed the name of some station or device type, it is updated to the
address list.

This button is disabled if you have not selected a bus or you have selected All in
the Bus combo box.

Modify...

If the FEs are from one bus, opens the Bus x - Modify Address(es)/FE(s) dialog
box. Otherwise, opens the Modify Address(es)/FE(s) dialog box.

If multiple FEs are selected, only the NE generation, Station, Device type and
In fault polling can be changed. Otherwise, also FE name can be changed.

If the selected FE is address 65535 or on the system-defined bus 254, only FE
name can be changed. Other information has fixed values.
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If you changed the name of some station or device type, it is updated to the list
view.

This button is disabled if you have not selected an FE or you have selected
multiple FEs and all of them are system-defined address(es) 65535 and/or from
the system-defined bus 254.

Delete

Deletes the selected FEs. You are asked for confirmation before the selected FEs
are deleted.

You cannot delete the system-defined address 65535.

This button is disabled if you have not selected an FE or you have only selected
the system-defined address 65535.

To FM

Adds the selected address(es) to fault polling. If the address has multiple FEs, all
of them are added. The status information is updated accordingly.

You cannot set the system-defined address 65535 or any address from the system-
defined bus 254 to be fault polled.

This button is disabled if you have not selected an address, or the selected
address(es) are already in fault polling, or you have selected only the system-
defined address(es) 65535 and/or FEs from the system-defined bus 254.

From FM

Removes the selected address(es) from fault polling. If the address has multiple
FEs, all of them are removed. The status information is updated accordingly.

This button is disabled if you have not selected an address, or the selected
address(es) are not in fault polling, or you have selected only the system-defined
address(es) 65535 and/or FEs from the system-defined bus 254.

To PM...

If the configuration type is NMS/10 MF C2.0, only the selected FEs are included,
because PM is per FE. Otherwise, if an address has multiple FEs, they are all
included, because PM is per address. The status information is updated
accordingly.

If the configuration type is NMS/10 MF C2.0 and multiple FEs are selected from
only one address, MF Manager opens the Bus x Address y - Add PM Jobs dialog
box. Any existing PM jobs on the addresses are not displayed. Same PM jobs are
added to all the FEs.
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If multiple addresses are selected from only one bus, MF Manager opens the Bus
x - Add PM Jobs dialog box. Any existing PM jobs on the addresses or FEs are
not displayed. Same PM jobs are added to all the addresses or FEs.

If the addresses are from multiple buses, MF Manager opens the Add PM Jobs
dialog box. Any existing PM jobs on the addresses or FEs are not displayed. Same
PM jobs are added to all the addresses or FEs.

If the configuration type is NMS/10 MF C2.0 and only one FE is selected, MF
Manager opens the Bus x Address y FE z - Edit PM Jobs dialog box. Any
existing PM jobs on the FE are displayed.

If the configuration type is not NMS/10 MF C2.0 and only one address is selected,
MF Manager opens the Bus x Address y - Edit PM Jobs dialog box. Any
existing PM jobs on the address are displayed.

Addresses on the system-defined bus 254 cannot have PM jobs. However, the
system-defined address 65 535 can have PM jobs.

This button is disabled if the configuration type is PDH Polling C1.0, or you have
not selected an address or FE, or all selected address(es) or FE(s) are on the
system-defined bus 254.

From PM

If the configuration type is NMS/10 MF C2.0, only the selected FEs are included,
because PM is per FE. Otherwise, if an address has multiple FEs, they are all
included, because PM is per address. The status information is updated
accordingly.

This button is disabled if the configuration type is PDH Polling C1.0, or you have
not selected an address or FE, or the selected address(es) or FE(s) do not have PM
jobs, or all selected address(es) or FE(s) are on the system-defined bus 254.

Edit PM...

If the configuration type is NMS/10 MF C2.0, only the selected FEs are included,
because PM is per FE. Otherwise, if an address has multiple FEs, they are all
included, because PM is per address. The status information is updated
accordingly.

If the configuration type is NMS/10 MF C2.0, MF Manager opens the Bus x
Address y FE z - Edit PM Jobs dialog box. Existing PM jobs on the FE are
displayed.

Otherwise, MF Manager opens the Bus x Address y - Edit PM Jobs dialog box.
Existing PM jobs on the address are displayed.
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This button is disabled if the configuration type is PDH Polling C1.0, or you have
not selected an address or FE, or you have selected multiple addresses or FEs
(depending on the configuration type), or the selected address or FE has no PM
jobs, or the FE is on the system-defined bus 254.

Define Subset...

Opens the Subset Definition dialog box where you can define a subset of the FEs
that are displayed in the address list. The subset definition remains effective until
you remove all restrictions in the Subset Definition dialog box or by clicking
Reset Subset.

When there is a subset definition in effect, the title bar of the Addresses dialog
box is Addresses (SUBSET).

Reset Subset

Resets the subset definition and displays all the FEs in the list view. The title bar
of this dialog box is changed back to Addresses.

This button is disabled if no subset is defined.

Help

Displays help about the Addresses dialog box.

6.9 Addresses (SUBSET) dialog box

This dialog box is described in Section 6.8, ’Addresses dialog box’.
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Figure 30. Addresses (SUBSET) dialog box

6.10 Application window

The MF Manager application window layout is shown in Figure 31.
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Figure 31. MF Manager application window

6.10.1 Title bar

Title bar at the top of the application window shows the name of the application,
MF Manager C2.5. If a configuration is currently managed, there is also the
name of the configuration on the title bar. If the configuration is on-line, title bar
has the text (connected), otherwise there is the text (not connected). If the
configuration is new, its name is <Untitled>.

Example:

If a node named as eswd0780kara is currently managed and it is an on-line
configuration, the title bar has the text MF Manager C2.5 - eswd0780kara
(connected).
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6.10.2 Menu bar

Below the title bar is the menu bar, which contains the menu items for MF
Manager. The menus are described in sections 6.10.3...6.10.9.

The mnemonic letter for each menu choice is underlined and shortcut keys are
displayed after the menu items.

6.10.3 Manage menu

Figure 32. Manage menu

Connect...

Connects to a NMS/10 MF, reads the configuration and opens it in the
Configuration window. If the current configuration has unsaved changes,
MF Manager asks you if they should be saved.

MF Manager opens the Connect dialog box where you can select an NMS/10
MF. If another MF Manager is connected to the selected NMS/10 MF, MF
Manager displays its information (if the configuration type is NMS/10 MF C2.0)
or a warning message, but the connection is allowed.

Connection to the NMS/10 MF remains open until you disconnect it with the
Disconnect command.

MF Manager checks from the local PC and the connected MF if there are any
unhandled network scan and auto-discovery log files.
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Note

This menu choice is disabled if a connection to NMS/10 MF is open or the user
is lower than NMS/10 Operator.

Refresh

Refreshes the current configuration.

If the current configuration has no changes, MF Manager informs about it. If the
current configuration has unsaved changes, MF Manager shows a warning that
they will be lost.

If there is a connection open to NMS/10 MF, configuration is retrieved from there
(if the configuration type is NMS/10 MF C2.0, information about other connected
users is shown). Otherwise it is read from the local files.

If the current configuration is a new one, MF Manager just creates a new off-line
configuration into the memory using the default values.

This menu choice is disabled if there is no Configuration window or it is
iconised.

Send

Sends the current configuration to NMS/10 MF and activates it.

If the current configuration has unsaved changes, MF Manager saves the changes
after asking confirmation to continue the operation.

If the configuration type is NMS/10 MF C2.0 and there are connected users, their
information is shown. However, you can continue if you wish to do so.

If there is a connection open to an NMS/10 MF, i.e. this is an on-line
configuration, changes are sent and the NMS/10 MF is informed about the
changes. Connection to the system remains open until you disconnect it with
Manage → Disconnect.

If there is no open connection to an NMS/10 MF (off-line configuration), MF
Manager warns you about a possibly dangerous operation and that the NMS/10
MF (not computer) is restarted. MF Manager checks that the current
configuration is compatible with the NMS/10 MF. If it is incompatible, MF
Manager displays an error message and the operation is cancelled. In this case,
change the type of the current configuration with Manage → Special → Change
Configuration Type.

If you send an off-line configuration, its name must be the same as the target
NMS/10 MF computer name. Change the configuration name with the Manage
→ Save As... command when necessary.
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This menu choice is disabled if:

• there is no Configuration window or it is iconised

• configuration is a new configuration, i.e. it has no name

• connection to MF is open with no changes in configuration

• the user security level is lower than NMS/10 Experienced.

If you have made a major change to the configuration, it may take a long time
(several minutes) before control is returned to MF Manager after the Send
command.

Disconnect

Disconnects from NMS/10 MF and continues editing locally.

If there are unsent changes in the current configuration, MF Manager asks if they
should be sent.

If the current configuration has no changes, you are asked to confirm that you
really want to disconnect. Hence, the current configuration becomes an off-line
configuration.

This menu choice is disabled if there is no connection to NMS/10 MF.

New

Creates a new off-line configuration using the default values and opens it in the
Configuration window.

If the current configuration has unsaved changes, MF Manager asks you if they
should be saved.

MF Manager opens first the Configuration Type dialog box where you can
select the type of the new configuration.

This menu choice is disabled if a connection to NMS/10 MF is open.

Open...

Opens an existing off-line configuration in the Configuration window.

If the current configuration has unsaved changes, MF Manager asks you if they
should be saved.
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MF Manager displays the Open dialog box where you can select any existing
configuration.

MF Manager checks from the local PC if there are any unhandled network scan
or autodiscovery files.

This menu choice is disabled if a connection to NMS/10 MF is open.

Save

Saves the current configuration into local files.

The configuration changes are not sent to the NMS/10 MF automatically.

If the current configuration is a new one, MF Manager opens the Save As dialog
box where you can give a name to the configuration.

This menu choice is disabled if:

• there is no Configuration window

• there are no unsaved changes in the configuration.

Save As...

Saves the current configuration with a new name.

The configuration changes are not sent to the NMS/10 MF automatically.

MF Manager opens the Save As dialog box where you can give a name to the
configuration. You are asked for confirmation in case saving would overwrite
existing files.

This menu choice is disabled if:

• there is no Configuration window

• connection to NMS/10 MF is open.

Special → Network Scan...

Starts a network scan on an NMS/10 MF. If all activity is suspended on all the
buses, network scan is not allowed.
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If the Configuration window is not open, MF Manager opens the Connect
dialog box where you can select a configuration name. Otherwise the currently
selected configuration name is used (unless it is a new configuration).

If the configuration type is NMS/10 MF C2.0 and there are connected users, their
information is shown. However, you can continue if you wish to do so.

MF Manager checks from the NMS/10 MF that there is not a network scan in
process and that there is not an unhandled network scan log file. If a network scan
log file is found, MF Manager displays a warning message that its results will be
lost if you continue the operation. If everything is in order, MF Manager opens
the Network Scan dialog box where you can select the bus(es) and define the
address(es) to scan. If all activity is suspended on a bus, MF Manager informs you
about it and excludes that bus from the scan. MF Manager informs the NMS/
10 MF about the bus(es) and address(es) to scan.

There is an indicator (magnifying glass) in the status bar during the network scan
(if there is a connection).

This menu choice is disabled if the user security level is lower than NMS/10
Network Administrator.

Special → Fault Status Consistency Check...

Starts a fault status consistency check on an NMS/10 MF. If all activity is
suspended on all the buses, the fault status consistency check is not allowed.

If the Configuration window is not open, MF Manager opens the Connect
dialog box where you can select a configuration name. Otherwise the currently
selected configuration name is used (unless it is a new configuration).

If the configuration type is NMS/10 MF C2.0 and there are connected users, their
information is shown. However, you can continue if you wish to do so.

MF Manager opens the Fault Status Consistency Check dialog box where you
can select the bus(es) to check. MF Manager informs the NMS/10 MF about the
bus(es) to check. If all activity is suspended on a bus, MF Manager informs you
about it and excludes that bus from the consistency check.

This menu choice is disabled if the user security level is lower than NMS/10
Network Administrator.

Special → Network Test...

Starts the Network Test application.
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The Network Test application is a separate application for testing the Q1 network.
It is installed at the same time as MF Manager.

The Network Test application works only with NMS/10 MF C2.0. It does not
work with the older releases, e.g. NMS/10 MF C1.0.

For instructions in using the Network Test application, see Appendix D,
’Network Test Client’.

Special → System Command...

Sends a command to NMS/10 MF.

If the Configuration window is not open, MF Manager opens the Connect
dialog box where you can select a configuration name. Otherwise the currently
selected configuration name is used (unless it is a new configuration).

MF Manager opens the System Command dialog box where you can select the
command to send to NMS/10 MF.

If your security level is lower than NMS/10 Network Administrator, you can only
check the NMS/10 MF's status and the current users on the NMS/10 MF.

This menu choice is disabled if the user security level is lower than NMS/10
Operator.

Special → Set NT Time...

Sets the time of an NMS/10 MF NT.

If the Configuration window is not open, MF Manager opens the Connect
dialog box where you can select an NMS/10 MF. Otherwise the currently selected
MF is used (unless it is a new configuration).

If the configuration type is NMS/10 MF C2.0 and there are connected users, their
information is shown. However, you can continue if you wish to do so.

MF Manager opens the Set NT Time dialog box where you can check the current
times (local and remote), change them and send the correct time to the remote
NMS/10 MF NT.

If your security level is lower than NMS/10 Network Administrator, you can only
check the current settings.

This menu choice is disabled if the user security level is lower than NMS/10
Operator.
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Special → Change Configuration Type...

Lets you change the current configuration type in the Change Configuration
Type dialog box. There are four types of configuration: NMS/10 MF C2.0, NMS/
10 MF C1.0, PDH Polling C2.0 and PDH Polling C1.0.

If the target configuration type is NMS/10 MF C2.0, MF Manager checks if all
necessary addresses on bus 254 are present. If an address is missing,
corresponding faults cannot be reported.

MF Manager compares device types to the DEVTYPES.TXT file (found in the
MF Manager root directory) and checks if there are new device types that could
be added. MF Manager asks you if a new device type should be added.

MF Manager displays you the changes that are to be made and asks you a
confirmation before the changes are applied.

This menu choice is disabled if:

• there is no Configuration window

• connection to NMS/10 MF is open.

Page Setup...

Changes the configuration report page settings: margins, printer font, and paper
orientation.

MF Manager opens the Page Setup dialog box. Page setup settings can be used
with all configuration types, but the settings are saved to configuration only when
the configuration type is NMS/10 MF C2.0.

This menu choice is disabled if there is no Configuration window.

Print...

Prints a configuration report to a printer.

MF Manager opens the Print Selection dialog box where you can select what is
included into the configuration report. Configuration report format is described in
Appendix C, ’Configuration report format’.

When configuration report is printed, MF Manager shows the standard Abort
printing message box and you can abort the printing.

This menu choice is disabled if there is no Configuration window.

Print Setup...

Changes the printer and its settings in the Print Setup dialog box.
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MF Manager supports only the basic options: printer selection, paper selection
and paper orientation.

Exit

Closes the MF Manager application. The following confirmations are made:

• If there is a connection to NMS/10 MF open and current configuration has
unsent changes, MF Manager asks if they should be sent.

• If there is no connection to NMS/10 MF, but current configuration has
unsaved changes, MF Manager asks if they should be saved.

6.10.4 Edit menu

Figure 33. Edit menu

Undo

Undoes the last paste operation.

This menu choice is disabled if:

• there is no Configuration window or it is iconized

• the undo operation is not possible, i.e. you have not made any paste
operation or have made changes to the configuration since the last paste
operation.

Copy

Copies the selected bus, PDH Manager interface, OS interface, or printer spooler
into the Clipboard.

This menu choice is disabled if:

• there is no Configuration window or it is iconized

• nothing or multiple items is selected in the Configuration window.
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Paste

Pastes the configuration data from the Clipboard to the selected bus, PDH
Manager interface, OS interface, or printer spooler.

This menu choice is disabled if:

• there is no Configuration window or it is iconized

• multiple items or nothing is selected in the Configuration window

• information in the Clipboard does not match with the target, e.g. you try to
paste bus information to a PDH Manager interface.

See Section 6.10.14 for more information about the Clipboard.

6.10.5 Configure menu

Figure 34. Configure menu

The submenus under PDH Manager Interface, OS Interface and Printer
Spooler are the same as in the Bus submenu except that they do not have the
Addresses... menu choice.

These menu choices are disabled if there is no Configuration window.

Bus →

This menu is disabled if the Configuration window is iconized or either the PDH
Manager Interfaces or OS Interfaces and Printer Spoolers tab is selected.

Bus → Add...

Adds a new bus.
86 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Reference
MF Manager opens the Add Bus dialog box where you can select the new bus
number. Only the available bus numbers are displayed.

After selection of the bus number, MF Manager opens the Bus dialog box where
you can configure the new bus. If the maximum number of buses already exist,
MF Manager informs you about it. New buses cannot be added.

Bus → Modify...

Opens the Bus dialog box where you can configure the selected bus.

This menu choice is disabled if:

• bus is not selected in the Configuration window

• multiple buses are selected in the Configuration window.

Bus → Delete

Deletes the selected bus(es).

Confirmation is asked before the selected bus(es) are deleted.

This menu choice is disabled if no bus(es) are selected in the Configuration
window.

Bus → Addresses...

Shows the bus address information.

MF Manager opens the Addresses dialog box where you can configure its values.
If one bus is selected in the Configuration window, its addresses are displayed
by default. Otherwise no address information is displayed until you select a bus.

PDH Manager Interface →

This menu is disabled if the Configuration window is iconized or either the
Buses or OS Interfaces and Printer Spoolers tab is selected.

PDH Manager Interface → Add...

Adds a new PDH Manager interface.

MF Manager opens the PDH Manager Interface dialog box and you can
configure the new PDH Manager interface.

With the configuration type NMS/10 MF C2.0, only the Port tab of the PDH
Manager Interface dialog box is available.
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If the maximum number of interfaces already exist, MF Manager informs you
about it. New interfaces cannot be added. You can define the maximum number
of PDH Manager Interfaces in the Limits tab in the PDH Polling General dialog
box.

PDH Manager Interface → Modify...

Modifies the selected PDH Manager interface.

MF Manager opens the PDH Manager Interface dialog box where you can
configure the selected PDH Manager interface.

With the configuration type NMS/10 MF C2.0, only the Port tab of the PDH
Manager Interface dialog box is available.

This menu choice is disabled if:

• a PDH Manager interface is not selected in the Configuration window

• multiple PDH Manager interfaces are selected in the Configuration
window.

PDH Manager Interface → Delete

Deletes the selected PDH Manager interface(s).

Confirmation is asked before the selected PDH Manager interface(s) are deleted.

This menu choice is disabled if no PDH Manager interface(s) are selected in the
Configuration window.

OS Interface →

This menu is disabled if the Configuration window is iconized, or either the
Buses or PDH Manager Interfaces tab is selected, or the configuration type is
PDH Polling C2.0 or PDH Polling C1.0.

OS Interface → Add...

Adds a new OS interface.

MF Manager opens the OS Interface dialog box and you can configure the new
OS interface.

If the maximum number of interfaces already exist, MF Manager informs you
about it. New interfaces cannot be added.

OS Interface → Modify...

Modifies the selected OS interface.
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MF Manager opens the OS Interface dialog box where you can configure the
selected OS interface.

This menu choice is disabled if:

• an OS interface is not selected in the Configuration window

• multiple OS interfaces are selected in the Configuration window.

OS Interface → Delete

Deletes the selected OS interface(s).

Confirmation is asked before the selected OS interface(s) are deleted.

This menu choice is disabled if no OS interface(s) are selected in the
Configuration window.

Printer Spooler →

This menu is disabled if the Configuration window is iconised or either the
Buses or PDH Manager Interfaces tab is selected, or the configuration type is
PDH Polling C2.0 or PDH Polling C1.0.

Printer Spooler → Add...

Adds a new printer spooler.

MF Manager opens the Printer Spooler dialog box and you can configure the
new printer spooler. If the maximum number of printer spoolers already exist, MF
Manager informs you about it. New printer spoolers cannot be added.

Printer Spooler → Modify...

Modifies the selected printer spooler.

MF Manager opens the Printer Spooler dialog box where you can configure the
selected printer spooler.

This menu choice is disabled if:

• no printer spooler is selected in the Configuration window

• multiple printer spoolers are selected in the Configuration window.

Printer Spooler → Delete

Deletes the selected printer spooler(s).

MF Manager asks for confirmation before the selected printer spooler(s) are
deleted.
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This menu choice is disabled if no printer spooler(s) are selected in the
Configuration window.

SNMP Interface...

Opens the SNMP Interface dialog box for configuring filters and alarm
classifications. The agent configuration tool is to be used for configuring SNMP
settings.

This menu choice is disabled if the configuration type is PDH Polling C1.0, PDH
Polling C2.0, or NMS/10 MF C1.0.

Network Test Interface...

Opens the Network Test Interface dialog box.

This menu choice is disabled if the configuration type is PDH Polling C1.0, PDH
Polling C2.0, or NMS/10 MF C1.0.

PDH Polling General...

Configures PDH Polling general settings: FE name format, station, device type,
equipment ID, global filter, global alarm classification, limits and comment.
Opens the PDH Polling General dialog box.

Hardware...

Shows PDH Polling hardware settings: number of polling units, I/O addresses,
interrupts and type of interface units. Opens the Hardware dialog box which is
read-only.

Filter and Alarm Classification...

Configures filters and alarm classifications. Opens the Filters and Alarm
Classifications dialog box.

6.10.6 Performance menu

Figure 35. Performance menu

These menu choices are disabled if there is no Configuration window or the
configuration type is PDH Polling.
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Performance Settings...

Configures performance monitoring data storage settings: PM data storage limits
and full action.

Opens the Performance Settings dialog box.

Addresses...

Shows the bus address information.

MF Manager opens the Addresses dialog box where you can configure its values.
If one bus is selected in the Configuration window, its addresses are displayed
by default. Otherwise no address information is displayed until you select a bus.

6.10.7 View menu

Figure 36. View menu

Toolbar

Toggles the toolbar. If the toolbar is visible, there is a check mark next to this
menu item.

Status Bar

Toggles the status bar. If the status bar is visible, there is a check mark next to this
menu item.

Network Scan Log...

If the Configuration window is open, i.e. there is a current configuration, MF
Manager checks from the local PC if there is a network scan log file that could be
used. If there is one, MF Manager asks if you want to process it. MF Manager
informs that if the local log file is not processed now, it will be overwritten with
the log file retrieved from the system. If the local log file is not processed or there
is not one, MF Manager checks from the NMS/10 MF (using the name of the
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Note

current configuration) if there is a log file. If there is one, MF Manager retrieves
it (it is written over the log file in the local computer). The log file is opened in
the Network Scan Log dialog box where you can compare its content and the
current configuration. If there was not a log file to use, MF Manager informs
about it.

If the Configuration window is not open, i.e. there is no current configuration,
MF Manager first asks if you want to compare the possible log file with an off-
line or with an on-line configuration. MF Manager opens the Open or Connect
dialog box (depending on the previous selection) where you can select the name
of the configuration. From there on the operation is as if the Configuration
window were already open. It is opened only if a network scan log file was found
and it is processed.

This menu choice is disabled if the current configuration is a new one, i.e. it has
no name, or the user security level is lower than NMS/10 Operator.

As MF Manager checks the network scan log file, it is possible that the network
scan is not yet finished. MF Manager informs you about this. There is also an
indicator (magnifying glass) in the status bar during the network scan if there is a
connection.

If you retrieve a network scan log from a remote computer, it replaces the local
log file. All unhandled information will be lost from the local log file.

If the user security level is lower than NMS/10 Experienced, only the local log file
can be viewed.

Auto-discovery Log...

If the Configuration window is open, i.e. there is a current configuration, MF
Manager first checks from the local PC if there is an auto-discovery log file that
could be used. If there is one, MF Manager asks if you want to process it. MF
Manager informs that if the local log file is not processed now, it will be
overwritten with the log file retrieved from the system. If the local log file is not
processed or there is not one, MF Manager checks from the NMS/10 MF (using
the name of the current configuration) if there is a log file. If there is one, MF
Manager retrieves it (it is written over the log file in the local computer). Log file
is opened into the Auto-discovery Log dialog box where you can compare its
content and the current configuration. If there was not a log file to use, MF
Manager informs about it.
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If the Configuration window is not open, i.e. there is no current configuration,
MF Manager first asks if you want to compare the possible log file with an off-
line or with an on-line configuration. MF Manager opens the Open or Connect
dialog box (depending on the previous selection) where you can select the name
of the configuration. From there on the operation is as if the Configuration
window were already open. It is opened only if an auto-discovery log file was
found and it is processed.

This menu choice is disabled if the current configuration is a new one, i.e. it has
no name, or the user security level is lower than NMS/10 Operator.

If you retrieve an auto-discovery log from a remote computer, it replaces the local
log file. All unhandled information will be lost from the local log file.

You can retrieve a remote auto-discovery log file at any time. The remote
computer starts a new log when necessary. However, NEs reported to the
retrieved log are not included in the new log until the next NMS/10 MF restart.

If the user security level is lower than NMS/10 Experienced, only the local log file
can be viewed.

Event Log...

Executes the Event Viewer application. This application is a standard part of the
Windows NT operating system.

MF Manager opens the Connect dialog box where you can select the system
whose event log will be displayed. The selection “-- local --” is the local
Windows NT.

If the Configuration window is open, the name of the active configuration is
displayed as a default selection.

6.10.8 Window menu

Figure 37. Window menu
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These menu choices are disabled if there is no Configuration window.

Cascade

Cascades all windows that are not minimized.

The Configuration window is located to the upper left corner.

Tile

Tiles all windows that are not minimized.

The Configuration window is located to the upper left corner.

Arrange Icons

Arranges all minimized windows at the bottom of the MF Manager window.

Minimized Configuration window is located to the lower left corner.

<list of open and minimized windows>

Windows NT keeps a list of currently open windows on the bottom of Window
menu. Currently active window has a tick mark before its menu choice.

MF Manager has only one such window and the text of the menu choice is 1
Configuration regardless of the configuration type.

6.10.9 Help menu

Figure 38. Help menu

Help Topics

Opens the help file with Windows Help application and displays the Help Topics
dialog box.
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Overview

Opens the help file with Windows Help application and shows the MF Manager
C2.5 Overview help page.

Active Window

Opens the help file with Windows Help application and shows the page that
contains information about the Configuration window.

This menu choice is disabled if there is no Configuration window.

About MF Manager

Displays the About MF Manager dialog box that shows version, product code,
release, build, and copyright information about MF Manager.

6.10.10 Toolbar

The toolbar contains shortcut buttons for the most frequently needed commands.
It provides you a quicker way to operate with the mouse.

Figure 39. The toolbar

The functions of the toolbar buttons refer to the following menu items:

1. Manage → Connect...

2. Manage → Refresh

3. Manage → Send

4. Manage → Disconnect

5. Manage → New

6. Manage → Open...

7. Manage → Save

8. Manage → Print...

9. Edit → Undo
DN00276927 © Nokia Networks Oy 95 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
10. Edit → Copy

11. Edit → Paste

12. Help → Help Topics

6.10.11 Status bar

The status bar on the bottom of the application window displays information
about the functions of MF Manager:

• A short description about the chosen menu command or toolbar icon.

• An icon showing that the network scan operation is still going on (if there
is a connection). There are 5 icons that change periodically:

• An icon showing if the current configuration is an off-line or an on-line
configuration.

6.10.12 User input

All MF Manager functions can be activated with a mouse or keyboard.

Menu choices and dialog box fields all have a mnemonic letter that is underlined.
A mnemonic is used by pressing at the same time the ALT key and the mnemonic
letter. For example, you can open the Manage menu by pressing the key
combination ALT + M.

Some menu choices have also a shortcut key. For example, the Copy menu choice
in the Edit  menu has a short cut key CTRL + C.

In a list box or list view (a list box with a sorting header) you can use the following
keyboard selections and mouse actions as a replacement for a menu choice or
command button:

• A double-click of the mouse can be used to activate an item in the list view.
This is a general ’modify’ action.

• The INSERT key can be used to add a new item into the list view. This is a
general ’add’ action.

• The DELETE key can be used to delete the selected items from the list view.
This is a general ’delete’ action.
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6.10.13 Data validation

When the configuration is read in, its data is validated. If invalid data is found,
MF Manager displays an error message explaining which part of the data was
invalid, which are the valid values and what is the default value. You are given
two choices: use the default value or cancel the reading.

Most of the parameters have a default value. If the parameter does not have a
default value, like a port of a bus, it is set as ’undefined’. A configuration cannot
be saved before the ’undefined’ values are defined.

When you close a dialog box with the OK button, and there are changes, all the
data is validated. If there is invalid data, MF Manager displays an error message
explaining which part of the data was invalid and which are the valid values.
When you close the error message box, the input focus is moved onto the invalid
data if possible.

The error checking scope is one dialog box. It means that when you open a dialog
box from another dialog box, make changes there, return by clicking OK, and
leave the first dialog box by clicking Cancel, changes made in the second dialog
box remain effective and cannot be restored.

When the configuration is saved, MF Manager:

• checks that all parameter have valid values. In a new configuration
(depending on the configuration type) at least the equipment ID value is
undefined

• checks that all addresses contain FE0

• checks that all the port values and printer names are consistent:

- buses have unique port values
- PDH Manager Interfaces, OS Interfaces, and the Network Test

Interface have unique TCP/IP port values
- Printer Spoolers have unique printer names
- number of PDH Manager Interfaces does not exceed the allowed

number.
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• checks that PM is defined in FE0 if the configuration type is NMS/10 MF
C2.0 and the NE generation is ND

• validates the maximum number of addresses in one bus and FEs in the
polling unit.

In the first three cases, if there is invalid data, MF Manager displays an error
message explaining which part of the data was invalid. Saving is cancelled.

In the fourth case MF Manager displays a warning message. You can select if you
want to continue anyway.

In the last case, if any of the limits is exceeded, MF Manager displays a warning
message explaining which limits were exceeded and what are the valid values.
You have two choices: either use invalid values or cancel saving.

6.10.14 Clipboard

MF Manager supports data exchange via the Clipboard:

• between edit boxes (standard Windows NT support)

• copy and paste configuration data of one bus to another bus; all bus
information, except primary and secondary port and any address
information, is transferred

• copy and paste configuration data of one PDH Manager interface to
another PDH Manager interface; all PDH Manager interface information,
except TCP/IP port, is transferred

• copy and paste configuration data of one OS interface to another OS
interface; all OS interface information, except TCP/IP ports, is transferred

• copy and paste configuration data of one printer spooler to another printer
spooler; all printer spooler information, except printer name, is transferred

• copy and paste configuration data of an SNMP interface to another.

Moreover, copy and paste operations are possible between two instances of
MF Manager.
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When you paste PDH Manager Interface, OS Interface, SNMP Interface or
Printer Spooler to another configuration, filter and alarm classification names are
pasted, but the actual files are not moved. If you wish to use same filters and alarm
classifications in the target configuration, we recommend you to make a copy of
the original configuration with the command Manage → Save As....

Format of the clipboard data is not compatible with the previous versions of MF
Manager.

6.10.15 Printing

You can print a report of the current configuration. The format of configuration
reports is described in Appendix C, ’Configuration report format’.

You can change the printer, paper selection and paper orientation in the Print
Setup dialog box, and fonts and margins in the Page Setup dialog box.

6.10.16 Online help

You can request help by using one of the following methods:

• Choose the Help → Help Topics menu command in the MF Manager
application window or click the Help icon in the toolbar to display the Help
Topics dialog box.

Then you may choose a topic in the Index tab, or search a topic in the Find
tab.

• Press F1 or choose the menu command Help → Active Window to get
help about the Configuration window. Pressing F1 when there is no
Configuration window opens the Help Topics dialog box.

• Click a Help button in a dialog box to get help about that particular dialog
box. The F1 key has no effect in dialog boxes.

For further information on how to use online help, refer to Microsoft Windows NT
User's Guide.

6.10.17 Command line arguments

MF Manager supports the following command line format:

MFM.EXE - NAME name
DN00276927 © Nokia Networks Oy 99 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
This command starts MF Manager and connects to a NMS/10 MF by the name of
name. The name is the computer name for the computer in which NMS/10 MF is
installed.

6.11 Auto-discovery Log dialog box

This dialog box allows you to view auto-discovery and network scan logs and
include found NEs in the current configuration.

This dialog box is used for:

• viewing an auto-discovery log (Auto-discovery Log)

• viewing a network scan log (Network Scan Log).

Figure 40. Auto-discovery Log / Network Scan Log dialog box

A remote log file is retrieved to the local computer. However, a network scan log
cannot be transferred until the defined network scan is complete. The system does
not control who retrieves the log, so it is possible for someone who has not started
the scan to retrieve the log.
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An auto-discovery log can be transferred at any time. After the transfer, NMS/10
MF starts a new log which does not include the previously found and retrieved
network elements. In such case, you need to restart the NMS/10 MF in order to
find these NEs again.

When a remote log is retrieved, it replaces an existing local log file causing any
unhandled data to be lost.

Bus

A list of buses defined in the log file. Addresses and FEs on the selected bus are
displayed in the Addresses on log and Addresses on current configuration list
boxes.

When you select another bus and there are changes, MF Manager asks if you wish
to save the changes and informs that the changes are saved permanently (although
not yet to the configuration files); they cannot be cancelled later with the Cancel
button.

The default is an empty selection.

Only buses that are in both the current configuration and the log are displayed.

Addresses on log

A list of addresses found in the log on the selected bus. Addresses are sorted in
ascending order. The columns are sortable, and the default sort order is address/
FE. If there are multiple FEs on one NE, the FEs are displayed on their own lines
sorted in ascending order by FE number.

This list view is empty if no buses are selected or all FEs are moved to the current
configuration.

The Gen. ID field is empty if:
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• the configuration type is NMS/10 MF C1.0, PDH Polling C2.0, or PDH
Polling C1.0

• the NE does not have a generation ID, i.e. it is a ND generation equipment;
for E generation equipment the ID is ’Q1E’.

If there are N/A entries in the Equipment ID, Software ID or FE name columns,
you may need to increase the Q1 Packet timeout and Command retries values
in the Bus dialog box. See Section 6.12, ’Bus dialog box’.

ACM2 nodes do not respond correctly to the software identification command.
The answer is always ACM2.

Addresses on current configuration

A list of addresses in the current configuration on the selected bus. The columns
are sortable, and the default sort order is address/FE. Addresses are sorted in
ascending order. If there are multiple FEs on one NE, each of the FEs are
displayed on its own line sorted in ascending order by FE number.

Different FEs on one address can have different station and device type settings.
Fault polling is per address, not per FE. PM is per FE if the configuration type is
NMS/10 MF C2.0. Otherwise, PM is per address.

The Gen. field can be ND, E or empty. It is empty if:

• the configuration type is NMS/10 MF C1.0, PDH Polling C2.0, or PDH
Polling C1.0

• the NE generation is unknown.

The status at the end of the row can be one of the following:

• empty: the address is not in fault polling. The address or FE has no PM jobs

• F: the address is in fault polling

• F S: the address is in fault polling, but suspended
102 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Reference
Note

• F S P: the address or FE is in fault polling, but suspended. The address or
FE has PM jobs

• F P: the address is in fault polling. The address or FE has PM jobs

• P: the address or FE has PM jobs.

The letter L in front of the status shows the added addresses and FEs.

The system-defined address 65535 is not displayed.

This list view is empty if there are no addresses in the current configuration on
the selected bus, or no buses are selected.

If all activity is suspended on the bus, it is not indicated with S in the addresses.
If the configuration type is NMS/10 MF C2.0, only those FEs that have PM jobs
has the ’P’ in the Status field. Otherwise, all FEs of an address that has PM jobs
have the ’P’ in the Status field.

Add →

Moves selected address(es) and FE(s) from the log to the current configuration.
If an address contains multiple FEs, only the selected FEs are moved.

If an address or FE is already in the current configuration, you are asked for
confirmation on adding the address/FE. If Use device type from log when
adding FE to current configuration is selected, an equipment ID (device type)
that is unknown to the current configuration is added automatically to its device
type list. Otherwise, if an FE has an unknown equipment ID, MF Manager asks
you if you wish to add it to the device type list.
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MF Manager opens the Bus x - Move Address(es)/FE(s) dialog box in which you
can define NE generation information, and station, device type and fault polling
values. The same value is given to each selected address/FE. See section 6.17,
’Bus x - Move Address(es)/FE(s) dialog box’ for details on how the default values
are found.

If you have selected one address/FE, its FE name is displayed and you can change
it. If multiple address(es)/FE(s) are selected, their FE name cannot be changed.
Existing FE(s) get their FE name as defined by the Use FE name from log when
adding FE to current configuration check box. Either the FE name from log or
the existing FE name is retained. New FEs get the FE name displayed in the
Addresses on log list box. New FE names are formatted according to the FE
Name Format (see FE Name Format tab in section 6.42, ’PDH Polling General
dialog box’).

New address(es)/FE(s) are set to fault polling by default (if not otherwise defined
in the Bus x - Move Address(es)/FE(s) dialog box). Fault polling and NE
generation are set per address, not per FE.

If you changed the name of some station or device type, it is updated to all
corresponding FEs in the Addresses on current configuration list view.

This button is disabled if no address/FE is selected in the Addresses on log list
box.

Add All →

Moves all addresses and FEs from log to the current configuration. The action is
the same as in Add →.

Use the FE name from log option when adding an FE to the current
configuration

FE name to use when adding an FE from the log to the current configuration.

If this check box is cleared, the existing FE retains its current FE name. Otherwise
it gets the FE name from the log. The default state is cleared.

This check box has no effect if the added FE is a new one. It always gets its FE
name from the log.

Use device type from log when adding FE to current configuration
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Device type to use when adding an FE (new or existing) from the log to the
current configuration.

If this check box is selected, device type from the log is used (you can also select
a specific device type in the Bus x - Move Address(es)/FE(s) dialog box).
Otherwise, you must select the device type in the Bus x - Move Address(es)/
FE(s) dialog box.

The default selection is cleared.

← Remove

Moves selected addresses and FEs from the current configuration back to log.
Only address(es)/FE(s) that were originally in the log can be removed (they have
the letter L in front of the status field).

The original settings are restored to the addresses/FEs in the current
configuration. If the fault polling setting of an address has changed, it is restored
when all added FEs are removed back to the log when all added FEs on that
address are removed back to the log.

If you changed a name of a station or device type with Add → or Add All →, it
is not restored. If the moved FE had an unknown equipment ID, i.e. device type,
and it was added to the device type list, it is not removed from the list.

This button is disabled if no address/FE is selected in the Addresses on current
configuration list box or the selected FEs were not previously moved from the
log to the current configuration.

OK

Closes the Auto-discovery / Network Scan Log dialog box. If the user security
level is at least NMS/10 Experienced, MF Manager asks you what you wish to do
with the log. If you decide to remove the log, all unhandled information will be
lost.

Cancel

Closes the Auto-discovery / Network Scan Log dialog box and discards all
changes. If the user security level is at least NMS/10 Experienced, MF Manager
asks you what you wish to do with the log. If you decide to remove the log, all
unhandled information will be lost.

Help

Displays help on the Auto-discovery / Network Scan Log dialog box.
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6.12 Bus x dialog box

This dialog box allows you to change the configuration of the selected bus. The
bus number (in place of ’x’) is displayed on the title bar of the dialog box.

This dialog box contains the following tabs:

• Fault Polling and Auto-discovery

• Port

• Cycle

• Time-out and Delay

• Connection Monitoring

• PM

The PM tab is disabled if the configuration type is PDH Polling C1.0.

When you change from one tab to another, all values in the previous tab are
validated. If there are errors, MF Manager displays an error message. The tab is
not changed.

Buttons common to all tabs

OK

Closes the Bus x dialog box.

All values are validated and if there are errors, an error message is displayed and
the operation is cancelled.

Cancel

Closes the Bus x dialog box and discards all changes.

Help

Displays help about the Bus x dialog box.

Fault Polling and Auto-discovery tab

You can define the fault polling and auto-discovery addresses of the selected bus
in this tab. Some or all addresses can be suspended.

There may be addresses on several lines and they are separated with commas. An
address range is given by separating two addresses with a hyphen. Addresses are
sorted in ascending order. Each address is displayed only once even if there are
multiple FEs on the same NE address.
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Figure 41. Fault Polling and Auto-discovery tab

Fault polling addresses

Addresses defined for the fault polling grouped by the NE generation.

A higher-level NMS does not know, which NEs are in fault polling, or about any
changes in them (for example, if an NE is removed from fault polling); it is not
reported in any way.

Fault polling addresses / ND generation equipment

These addresses are defined for fault polling from ND generation equipment. The
addresses can be between 0 and 4093. The default is empty.
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The Fault polling addresses / ND generation equipment edit box is read-only.
If you want to modify its contents, open the Addresses dialog box by clicking
Edit.... If the configuration type is NMS/10 MF C1.0, PDH Polling C2.0, or PDH
Polling C1.0, all addresses regardless of the NE generation are shown in this edit
box.

Fault polling addresses / E generation equipment

These addresses are defined for fault polling from E generation equipment. The
addresses can be between 0 and 4093, but addresses above 3999 is not
recommended. The default is empty.

The Fault polling addresses / E generation equipment edit box is read-only. If
you want to modify its contents, open the Addresses dialog box by clicking
Edit....

The Fault polling addresses / E generation equipment edit box is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Edit...

Opens the Addresses dialog box where you can edit the addresses of the selected
bus. The Bus combo box on the Addresses dialog box is fixed to the current bus.

Auto-discovery addresses

These addresses are defined to be checked for new NEs. The addresses can be
between 0 and 4094. The default is empty.

Address 4094 is a possible address for an NE. However, the address 4094 is
reserved for other use, so it is not an acceptable address for an NE. By adding the
address 4094 to the auto-discovery address list you may check that no NE uses
this address.

Address information (FE/NE)

Displays the number of FEs and NEs currently defined on the bus and in the fault
polling per NE generation and totally.

The E generation information is disabled if:
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• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Suspension

This group box contains different options for suspending fault polling and auto-
discovery.

All suspension settings are temporary and they are lost in a system restart. A
higher-level NMS does not know if something is suspended; it is not reported in
any way.

Fault polling and auto-discovery suspended as defined

Some of the addresses defined for fault polling or for auto-discovery are
suspended. The suspended addresses are defined in the edit box when this option
is selected. The addresses can be between 0 and 4093.

This is default selection and the edit box is empty by default.

All fault polling and auto-discovery suspended

All of the addresses defined for fault polling or auto-discovery are suspended.
Other activities, for example PM, are allowed.

If this option is selected, the edit box is disabled.

All activity suspended

All activity on the selected bus is suspended.

If this option is selected, the edit box is disabled.

Port tab

You can define the primary and secondary polling direction port parameters in
this tab.
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Figure 42. Port tab

Protected bus

If the Protected bus check box is not checked, the Secondary direction group
box and all its controls are disabled. The default is not selected.

Polling unit

The polling unit value is 1.

Primary direction / Port

The port value can be 1A...16B. The port value format is defined in Section
6.22.2, ’Buses tab’. The default is an empty selection.

Each bus must have a unique primary polling direction port value.
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Primary direction / Line speed (bit/s)

The line speed can be 300, 600, 1200, 2400, 4800, 9600 or 19200 bit/s. The
default is 9600 bit/s.

When using configuration types PDH Polling C1.0, PDH Polling C2.0 and NMS/
10 MF C1.0, the line speed for primary direction must be the same as the line
speed of secondary direction.

Secondary direction / Port

The port value can be 1A...16B. The port value format is defined in Section
6.22.2, ’Buses tab’. The default is an empty selection.

Each bus must have a unique secondary polling direction port value.

This item is disabled if the Protected bus check box is not checked.

Secondary direction / Line speed (bit/s)

The line speed can be 300, 600, 1200, 2400, 4800, 9600 or 19200 bit/s. The
default is 9600 bit/s.

When using configuration types PDH Polling C1.0, PDH Polling C2.0 and NMS/
10 MF C1.0, the line speed for secondary direction must be the same as the line
speed of primary direction.

This item is disabled if the Protected bus check box is not checked.

Cycle tab

You can define the cycle parameters for primary and secondary polling directions
in this tab.
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Figure 43. Cycle tab

Cycle target time

The time that must pass between starting one fault polling cycle and starting the
next fault polling cycle. If there is time left after the compulsory actions (fault
polling cycle, consistency check, and finding lost and new network elements), it
is used as defined in the Perform on every cycle (if time left) group box.

The minimum time between two fault polling cycles can be 0...86 400 seconds (0
s...24 h). The default value is 0.

The value 0 is a so called ’do not care’ value, i.e. only compulsory actions are
carried out. If the cycle target time is 0, the Perform on every cycle (if time left)
group box, all the controls inside it, and the static text above it are disabled.

Perform on every cycle (compulsory)

The compulsory actions that are carried out in every cycle.

Perform on every cycle (compulsory) / Consistency check
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The full poll consistency check can be none, x NE or x FE, where x = 1...100. The
default is 1 NE per cycle.

If the selected value is none, the edit box next to this box is disabled.

Perform on every cycle (compulsory) / Check lost network elements

The number of NEs (previously reported as disconnected) that are polled for
existence after every fault polling cycle. The number can be 0...10 and the default
is 1.

Perform on every cycle (compulsory) / Find new network elements

The number of new (auto-discovery) addresses that are polled for existence after
each fault polling cycle. The number can be 0...10 and the default is 1.

Perform on every cycle (if time left)

You can choose the actions that are carried out if there is time left after the
compulsory actions. The sum of percentages in this group box must always be
100%.

This group box is disabled if:

• the cycle target time is 0

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Perform on every cycle (if time left) / Consistency check

The proportion of the time left used for consistency check can be 0...100 in
percents. The default value is 50 (%).

Perform on every cycle (if time left) / Check lost network elements

The proportion of the time left used for polling addresses (previously reported as
disconnected) for existence can be 0...100 in percent. The default value is 30 (%).

Perform on every cycle (if time left) / Find new network elements

The proportion of the time left used for polling addresses (auto-discovery) for
network element can be 0...100 in percent. The default value is 20 (%).

Perform on every cycle (if time left) / Do nothing

The proportion of the time left used for doing nothing can be 0...100 in percent.
The default value is 0 (%).
DN00276927 © Nokia Networks Oy 113 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
Time-out and Delay tab

You can define the time-out and delay parameters for primary and secondary
polling directions in this tab. The purpose of timeout and delay parameters is to
give you the opportunity to ensure smooth communication between network
elements and the Polling card.

Figure 44. Time-out and Delay tab

Q1 Packet time-out

The time-out applied to waiting for any Q1 packet level response. It is the
maximum amount of time that is allowed to elapse between transmitting a Q1
protocol packet to a network element and receiving the first character of the
response packet. The same time-out is also applied when waiting between
characters of the response packet. If the bus speed is slow, the time-out should
reflect this, but the time can also be increased if the bus contains elements that are
slow in responding.
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If there are TMS Adaptors or Branching Units (TU 21743.00/.01) on the bus, they
cause a delay to the node response and therefore the packet time-out should be
increased. Increasing the time-out slows down detection of disconnected network
elements in the same way as increasing retry counts.

The packet time-out can be 2...600 in 100 ms units (200 ms ... 1 min). The default
is 2 (200 ms).

Q1 Application delay

The minimum delay between two data transfer commands to the same network
element. It is the time that must pass between ending/starting a Q1 protocol data
transfer command and starting the next data transfer command. In the
configuration type NMS/10 MF C2.0 this delay is counted from the end of one
command to the start of the next command. In the other configuration types it is
counted from start to start.

The purpose of this delay is to give the network element time to recover from
processing the previous command.

It can be 0...600, or 2...600 in 100 ms units (0 ms ... 1 min, or 200 ms ... 1 min).
If the configuration type is NMS/10 MF C2.0, the minimum and default value is
0 (ms). Otherwise, the minimum and default value is 2 (200 ms).

Q1 Empty packet delay

The delay after receiving an empty packet during data transfer when
communicating with the same element. It is the time that must pass between
receiving a Q1 Data Transfer Command reply packet without payload data and
transmitting the next query packet to the element.

The purpose of this delay is to prevent the Polling card from overloading the
network element by repeatedly asking for the reply data.

The empty packet delay can be 0...600 in 100 ms units (0 ms ... 1 min). If the
configuration type is NMS/10 MF C2.0, the default value is 1 (100 ms). Otherwise
the default value is 0.

Q1 Inter packet delay

The minimum delay between two packets sent in any/same direction. It is the time
that must pass between ending/starting the transmission of one command packet
and starting the transmission of the next command packet. This delay may be
needed in some bus configurations where there are some elements more or less
directly connected to the polling unit, and some elements are behind a delaying
structure. In such a situation, the directly connected elements can answer to the
polling unit before the command transmission has reached the entire bus. In the
configuration type NMS/10 MF C2.0 this delay is counted from the end of one
packet to the start of the next packet and it is obeyed in any direction. In other
configuration types it is counted from start to start and it is obeyed in any direction
when sending polling commands; otherwise, it is obeyed in the same direction.
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The purpose of this delay is to ensure that the transmission has time to travel to
the whole bus before the next protocol packet is transmitted. Using a non-zero
inter packet delay slows down the polling and causes delay to the detection and
reporting of fault state changes in network elements. The polling cycle time (the
average delay of reporting a fault state change in NE) of a bus increases roughly
with number_of_elements*delay.

The inter packet delay can be 0...1000 in 100 ms units (0 ms ... 1 min 40 s). The
default is 0.

Q1 Command time-out

The maximum time allowed for executing one complete Q1 command transaction
in one direction. The time-out is measured from the start of the transmission of
the the first command packet and the command iteration is aborted if command
is not complete when the timeout occurs.

Q1 command time-out can be 0...36 000 in 100 ms units (0 ms ... 1 h). The default
value is 0 (ms).

The value 0 is a so called ’do not care’ value, i.e. there is no time-out.

This item is disabled if the configuration type is PDH Polling C1.0, PDH Polling
C2.0, or NMS/10 MF C1.0.

Q1 Command time-out, Packet limit and Max. empty packets can be used as
mutually complementary criteria for limiting the maximum duration for a Q1
command iteration.

Switch delay

The minimum delay after switching direction. It is the time that must pass
between ending/starting the transmission of last command packet to one direction
and starting the transmission of the first command packet into the other direction.
In the configuration type NMS/10 MF C2.0 this delay is counted from the end of
one packet to the start of the next packet. In the other configuration types it is
counted from start to start.

The purpose of this delay is to ensure that the transmitted packet has travelled
through the whole bus before transmitting in other direction and thus prevent
simultaneous data transmission from two directions. Fault polling alternates
polling through primary and secondary directions and the direction is switched
between cycles so using a non-zero switch delay has negligible effect in normal
situation. However, it causes a delay to the detection of a disconnected element
as both directions are always checked if an element fails to answer.

The switch delay can be 0...600 in 100 ms units (0 ms ... 1 min). The default is 0.
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This item is disabled if the bus is not a protected bus.

Max. empty packets

The maximum number of empty packets received from the network element
during one command iteration in one direction. Empty packets need not to be
consecutive and the packet counting is reset if the direction changes.

The purpose of this parameter is to prevent an infinite iteration of a command in
case of a network element is unable to send replies.

The maximum number of consecutive empty packets can be 0...65535. If the
configuration type is NMS/10 MF C2.0, the default value is 200. Otherwise the
default value is 1000.

The value 0 is a so called ’do not care’ value, i.e. an infinite number of empty
packets is allowed.

Q1 Command time-out, Packet limit and Max. empty packets can be used as
mutually complementary criteria for limiting the maximum duration for a Q1
command iteration.

Packet limit

The maximum number of transmitted and received command packets during one
command iteration in one direction. Packet counting is reset if the direction
changes.

The maximum number of transmitted command packets can be 0...65535. The
default value is 1000.

The value 0 is a so called ’do not care’ value, i.e. an infinite number of packets is
allowed.

Q1 Command time-out, Packet limit and Max. empty packets can be used as
mutually complementary criteria for limiting the maximum duration for a Q1
command iteration.

This item is disabled if the configuration type is PDH Polling C1.0, PDH Polling
C2.0, or NMS/10 MF C1.0.

Clock refresh rate (E gen. elements) (d hh:mm)
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The refresh rate for clocks of E generation NEs.

E generation elements maintain a real-time clock and the time-stamping of the
events is carried out in the elements (for ND generation elements, events are time-
stamped at the NMS/10 MF system). To keep the E generation element clocks
synchronized with the NMS/10 MF system clock, it periodically refreshes the real
time clock of the E generation elements.

To ensure the system to work properly, appropriate node managers must be used
to set the nodes to follow the UTC time.

The refresh rate can be from 0 minute to 7 days. The default is 1 hour. The edit
boxes (and spin buttons) from left to right are: days (0...7), hours (0...23), and
minutes (0...59).

The content of the edit box is set to empty if an illegal value is selected.

The value 0 is a ’do not care’ value, i.e. clock of the E generation elements is not
refreshed.

If there are E generation equipment connected to the TMS Adaptor (HW
TC21710.01 version 01A and SW TS21709.03 version 02A), the clock refresh
rate must be set to 0d0h0m.

This item is disabled if the configuration type is PDH Polling C1.0, PDH Polling
C2.0, or NMS/10 MF C1.0.

Connection Monitoring tab

You can define connection monitoring parameters for primary and secondary
polling directions in this tab.
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Figure 45. Connection Monitoring tab

Poll retries on one cycle

The number of immediate fault polling retry attempts after an NE does not
respond.

The connection poll retry count can be 0...10. The default is 1.

Connection loss threshold

The number of allowed command failures before the connection to a network
element is considered to be lost. When the connection is considered lost, the NE
is removed from fault polling. Connections to lost elements are checked
according to the configured lost checking settings. Increasing connection loss
threshold prevents loss of connection alarms from occasionally failing
commands. However, detecting a genuine loss of connection is slower by nature.
This parameter used to be called “Cycle retries” in MF Manager C2.0. When only
fault polling commands are sent to the bus, this parameter can be treated as the
number of fault polling cycles to wait before a failing element is considered as
lost.
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The connection loss threshold can be 0...10. The default is 4.

Command retries

The maximum retry count for all commands except for fault polling. This
parameter can be increased for better tolerance of failures while, for example,
passing through node manager traffic (the fault polling retry count should
typically be kept quite low to enable a rapid recovery from communication
failures).

In NMS/10 MF C2.0, the retry counter is not reset upon reception of a valid
answer packet from the element. Hence, this parameter specifies the total
maximum number of packet level failures for a command iteration in one
direction.

In other systems, the counter is reset to zero each time a valid answer is received.
Hence, this parameter specifies the maximum number of consecutive failures.

The command retry count can be 0...10. The default is 1.

PM tab

You can define performance monitoring addresses of the selected bus in this tab.
This tab is disabled if the configuration type is PDH Polling.

There may be addresses on several rows, separated with commas. An address
range is given by separating two addresses with a hyphen. Addresses are sorted
in ascending order. Each address is displayed only once even if there are multiple
FEs on the same NE address even if there are multiple FEs in PM on the same NE
address.

On NMS/10 MF C1.0 and PDH Polling C2.0, the PM files are saved to the folder:
C:\NOKIAMGR\NMS10MF\PMP\LOGS\yymmdd.txt

On NMS/10 MF C2.0, the PM files are saved to the FTP folder:

\MF\PMDATA\yyyymmdd.txt

Fault polling is per address, not per FE. PM is per FE if the configuration type is
NMS/10 MF C2.0. Otherwise, the PM is per address.
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Figure 46. PM tab (for NMS/10 MF C2.0)

Performance monitoring addresses

These addresses are defined for performance monitoring. The addresses can be
between 0 and 4093. The default is empty.

The Performance monitoring addresses edit box is read-only. If you want to
modify its contents, open the Addresses dialog box by clicking the Edit... button.

Edit...

Opens the Addresses dialog box where you can edit the addresses of the selected
bus. The Bus combo box on the Addresses dialog box is fixed to the current bus.

Address information (NE) or Address information (FE/NE)

Displays the number of (FEs and) NEs in the bus by the NE generation, totally
and how many of them is in PM.

If the configuration type is NMS/10 MF C2.0, the group box title is Address
information (FE/NE) and the number of both FEs and NEs is displayed.
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Otherwise, the group box title is Address information (NE) and only the number
of NEs is displayed (number of FEs and the dividers between the number of FEs
and NEs are missing).

Address 65535 is always included here as it can have PM jobs. Because of this,
the total NE count on a bus on this page is one higher than the same count on the
Fault Polling and Auto-discovery page.

The E generation information is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

6.13 Bus x - Add Address(es)/FE(s) dialog box

This dialog box allows you to add address(es) and FE(s). The title bar shows the
bus to which you are adding the address/FE.
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Figure 47. Bus x - Add Address(es)/FE(s) dialog box

Add type

Option buttons in this group box are for selecting the type of address/FE
information added to the configuration.

Add type / 1 Address and 1 FE

Adds exactly one FE to one address. This is the default selection.

Add type / 1 Address and range of FEs

Adds a range of FEs to one address.

Add type / Range of addresses and 1 FE

Adds exactly one FE to a range of addresses.

Add type / Range of addresses and range of FEs

Adds a range of FEs to a range of addresses.

Address or Addresses
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The address of an NE can be 0...4093. All addresses are displayed and the
address(es) in use have an asterisk (*) after the address value. The default is the
first unused address.

The start address must be smaller than or equal to the end address.

Do not use addresses higher than 3999 with E generation NEs.

FE or FEs

The FE on an address can be 0...254. FEs that are available for all addresses
defined in Address or Addresses combo box, are displayed. The default value is
the first common and available FE.

The start FE must be smaller than or equal to the end FE.

The common and available FEs are updated once the address(es) are changed.

If the range of FEs is not continuous, there is a note about this after the last FE
combo box.

The combo box(es) are empty if:

• there is no common unused FE

• the start address of an address range is higher than the end address.

FE name

The name of a functional entity can be 1...32 characters long. The default value is
empty.

When PAM reads a configuration and creates network maps, it uses the first 11
characters of the FE name of FE 0 for naming the node symbol.

If necessary, change the FE 0 name with the Bus x - Modify Address(es)/FE(s)
dialog box.

This note does not apply to the configuration type NMS/10 MF C2.0.

NE generation
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The equipment generation for the added addresses. The default selection is
updated every time the Add type or Address (Addresses) selection changes.

MF Manager checks from the selected (and existing) addresses what is their
current generation (the default for a new address is ND). The following cases are
possible:

• All existing addresses are ND generation; a ND selection is displayed.

• All existing addresses are E generation and there are no new addresses; an
E selection is displayed.

• All existing addresses are E generation and there are new addresses; a
multiple selection is displayed.

• Existing addresses have different generations, a ’multiple’ selection is
displayed.

• All addresses are new; a ND selection is displayed.

• All existing addresses are of unknown generation; an empty selection is
displayed.

- If there are new addresses; a multiple selection is displayed.
- If only part of the existing addresses are of unknown generation, a

multiple selection is displayed (a’#’ mark next to the box and
information text at the bottom of the dialog box).

A multiple selection is available only when such a selection is needed.

If it is multiple, generation settings of all the existing addresses are retained and
the generation for the new addresses is set to ND.

The system-defined bus 254 has a fixed value, an empty selection.

If you change the value, all addresses (old and new) will get the same generation
setting.

NE generation is per address, not per FE.

This item is disabled if:
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• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Station

The station these address(es)/FE(s) are set to. The default selection is updated
every time the Add type, Address (Addresses), or FE (FEs) selection changes.

MF Manager checks if all existing FEs on the selected addresses have the same
station. The following cases are possible:

• All existing FEs have same station; that station is displayed. This selection
is displayed also when there are new FEs.

• Existing FEs have multiple stations; a ’multiple stations’ selection is
displayed. This selection is displayed also when there are new FEs.

• All FEs are new; an empty selection is displayed.

• All existing FEs have unknown station; an empty selection is displayed.
This selection is displayed also when there are new FEs. If only part of the
existing FEs have unknown station, the selection is defined using previous
cases (unknown stations are omitted; there is a ’#’ mark next to the box and
information text at the bottom of the dialog box).

The ’multiple stations’ selection is available only when that selection is needed,
but you must select some station.

The system-defined bus 254 has a fixed value 1 - PDHplat (the station name is
PDHplat if you have not changed its default value).

Same station is set for all new FEs.

Station / Browse...

Opens the PDH Polling General dialog box (only the Stations tab is active)
where you can modify the stations. The Station combo box is updated.

This button is disabled if the selected bus is 254.

Device type

The device type set to the address(es)/FE(s). The default selection is updated
every time the Add type, Address (Addresses), or FE (FEs) selection changes.
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MF Manager checks if all existing FEs on the selected addresses have the same
device type. The following cases are possible:

• All existing FEs have same device type; that device type is displayed. This
selection is displayed also when there are new FEs.

• Existing FEs have multiple device types; a ’multiple device types’
selection is displayed. This selection is displayed also when there are new
FEs.

• All FEs are new; an empty selection is displayed.

• All existing FEs have unknown device types; an empty selection is
displayed. This selection is displayed also when there are new FEs. If only
a part of the existing FEs have unknown device type, selection is defined
using previous cases (unknown device types are omitted; there is a ’#’ mark
next to the box and information text at the bottom of the dialog box).

A ’multiple device types’ selection is available only when that selection is
needed, but you must select some device type.

The system-defined bus 254 has a fixed value 0 − SYSTEM (the station name is
SYSTEM if you have not changed its default value).

Same device type is set for all the new FEs.

Device Type / Browse...

Opens the PDH Polling General dialog box (only the Device types tab is active)
where you can modify the device types. The Device type combo box is updated.

This button is disabled if the selected bus is 254.

In fault polling

If the In fault polling is selected, address(es) are set to fault polling. The default
selection is updated every time the Add type, Address (Addresses), or FE (FEs)
selection changes.

MF Manager checks from the selected (and existing) addresses what is their
current fault polling setting (the default for a new address is ’in fault polling’).
The following cases are possible:

• All existing addresses are in fault polling; the check box is selected.

• All existing addresses are not in fault polling and there are no new
addresses; the check box is cleared.
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• All existing addresses are not in fault polling and there are new addresses;
the check box is undefined.

• Existing addresses have different fault polling settings; the check box is
undefined.

• All addresses are new; the check box is selected.

The In fault polling check box is a tri-state control only when the ’undefined’
selection is needed. Otherwise, it has only two states: selected or cleared.

If the selection is undefined, all the existing fault polling settings are retained and
the new addresses are set in fault polling.

The system-defined bus 254 has a fixed value cleared.

If you change the state of the check box, all addresses (old and new) will get the
same fault polling setting.

Fault polling is set per address, not per FE.

OK

Closes the Add Address(es)/FE(s) dialog box. FE names are formatted
according to FE name format (see Section 6.42, ’PDH Polling General dialog box
/ FE Name Format tab’).

If the NE generation is E generation and the address is higher than 3999, MF
Manager displays a warning. However, you can accept the operation.

This button is disabled if:

• FE name or NE generation is empty

• Station or Device type has an empty or multiple selection

• start address is greater than end address

• start FE is greater than end FE

• there is a discontinuous FE range.

Cancel
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Closes the Add Address(es)/FE(s) dialog box and discards changes.

Help

Displays help about the Add Address(es)/FE(s) dialog box.

6.14 Bus x - Add PM Jobs dialog box

This dialog box allows you to define performance monitoring jobs on bus(es),
address(es), and FE(s). The title bar shows the bus number if all addresses belong
on it.

With all configuration types, this dialog box is used for:

• adding PM jobs on multiple addresses on one bus (Bus x - Add PM Jobs)

• adding PM jobs on multiple buses (Add PM Jobs).

When the configuration type is not NMS/10 MF C2.0, this dialog box can be used
for modifying PM jobs on one selected address (Bus x Address y - Edit PM
Jobs).

With the configuration type NMS/10 MF C2.0, this dialog box is used for:

• adding PM jobs on multiple FEs on one address (Bus x Address y - Add
PM Jobs)

• modifying PM jobs on one selected FE (Bus x Address y FE z - Edit PM
Jobs).

Fault polling is per address, not per FE. PM is per FE if the configuration type is
NMS/10 MF C2.0. Otherwise, the PM is per address.

You can set a predefined PM job on an address (or on an FE in NMS/10 MF C2.0).
There is a period telling how often the PM job is performed (e.g. every 15
minutes). There is also an interval telling the time when it is allowed to perform
the PM job (e.g. only on Sundays). There can be multiple PM jobs on one address
or FE. PM jobs with the same period must not have overlapping intervals.

If PM jobs are added to multiple addresses (or to FEs in NMS/10 MF C2.0),
previously added PM jobs are not shown, even though they are retained. If the PM
jobs are added to one address (or to one FE in NMS/10 MF C2.0), all previously
added PM jobs on that address or FE are shown.
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Figure 48. Bus x - Add PM Jobs dialog box

Available PM jobs

A list of available PM jobs that are sorted in ascending order by name.

The definition of the selected PM job is displayed in the PM job definition group
box.

Current PM jobs
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A list of current PM jobs on the selected bus(es), address(es), or FE(s) with
sortable columns. By default, current PM jobs are sorted in ascending order by
their name. If the same job has multiple periods, they are sorted in ascending
order by period. If there are multiple start/stop times for one period, the start/stop
time is used as the third sorting rule.

PM jobs with the same bus, address, FE, period, and PM job name settings must
not overlap. This includes also combinations of continuous, delayed continuous,
and scheduled PM data collection.

If you add PM jobs to several addresses (or FEs in NMS/10 MF C2.0) at the same
time, you cannot see previously added PM jobs, even though they are retained.
However, when you modify one address (or one FE in NMS/10 MF C2.0) at a
time, you see all currently defined PM jobs on that address or FE.

One address or FE can have the maximum of 128 PM jobs.

The definition of the selected PM job is displayed in the PM job definition group
box.

Period

You can define multiple periods for the selected PM job(s).

The check boxes have no default values. At the beginning, they are all cleared.
However, they are not reset after each PM job adding.

For most PM jobs it does not make sense to define multiple periods, because the
reading of counters may reset them, or there can be reset commands in the PM
job.

Period / 15 minutes

Runs the selected PM job(s) every 15 minutes.

Period / 24 hours

Runs the selected PM job(s) every 24 hours.

Period / Other (d hh:mm:ss)

Runs the selected PM job(s) on user-defined intervals. The user-defined interval
can vary from 3 seconds to 7 days.
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If this option is not selected, the time controls below the check box are disabled.

PM data collection times

Defines PM data collection to be continuous or done at defined times.

The start/stop time is the NMS/10 MF local time.

This group box and all the controls inside it are disabled if the configuration type
is PDH Polling C1.0, PDH Polling C2.0, or NMS/10 MF C1.0.

PM data collection times / Continuous

Defines PM data collection to be continuous and starting as soon as possible. This
is the default selection.

If this option button is selected, the Times... components are disabled.

PM data collection times / Scheduled

Defines PM data collection to be continuous, but the start is delayed or PM data
is collected only at defined times.

PM data collection times / Times...

Defines the PM data collection interval.

The schedule is modified in the PM Data Collection Times dialog box, which is
opened by clicking Times.... The static text below the button describes the
currently selected scheduling.

Add →

Adds the selected PM job(s) to the list of current PM jobs. The selected period(s)
and PM data collection times are used.
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If the Scheduled option is selected, but the PM data collection times are not
defined, MF Manager asks if the continuous PM data collection should be
selected instead.

On NMS/10 MF C1.0, PM data is always collected from FE0, and on NMS/10
MF C2.0, PM data is collected from the defined FE. If the configuration type is
NMS/10 MF C2.0 and the NE generation is ’ND’, all PM jobs should be on FE0.

For most PM jobs, it does not make sense to define multiple periods, because
reading of the counters may reset them, or there can be reset commands in the PM
job.

This button is disabled if no PM jobs are selected in the Available PM jobs list
box or no period is selected in the Period group box.

← Remove

Removes the selected PM job(s) from the list of current PM jobs.

This button is disabled if no PM jobs are selected in the Current PM jobs list
box.

PM job definition

The fields in this group box are updated when you select one line in the Available
PM jobs or Current PM jobs list box.

PM job definition / Commands

Performance monitoring commands for the selected PM job. These commands
are sent to the selected addressed or FEs. This field is read-only.

This field is empty if either no or multiple PM jobs are selected.

PM job definition / Parse

Parse commands for the selected PM job. The answers to the PM commands are
parsed by using these commands. This field is read-only.

This field is empty if either no or multiple PM jobs are selected. It is also empty
if there is nothing to parse in the selected PM job.

PM job definition / Comment
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A comment about the selected PM job. This field is read-only.

This field is empty if either no or multiple PM jobs are selected. It is also empty
if the selected PM job contains no comments.

Import...

Enables you to import PM jobs.

Opens a common dialog box by the title of Import PM Job Definitions. In this
dialog box you can select a file containing PM job definitions. MF Manager reads
the file and adds the found PM jobs to the Available PM jobs list box. If an
already reserved name is found, both definitions are displayed and you have to
select the one to use.

We recommend that only experienced users carry out the import operation,
because it is a potentially dangerous operation.

OK

Closes the Add/Edit PM Jobs dialog box.

Cancel

Closes the Add/Edit PM Jobs dialog box and discards changes.

Help

Displays help about the Add/Edit PM Jobs dialog box.

6.15 Bus x - Addresses to Scan dialog box

This dialog box allows you to define addresses for a network scan on the selected
bus. The title bar displays the bus number.

There may be addresses on several lines and they are separated with commas. An
address range is given by separating two addresses with a hyphen. Addresses are
sorted in ascending order.
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Figure 49. Bus x - Addresses to Scan dialog box

Addresses

The addresses can be 0...4094. These addresses are defined for the network scan
on the selected bus. The default is empty.

Address 4094 is a possible address for an NE. However, the address 4094 is
reserved for other use, so it is not an acceptable address for an NE. By adding the
address 4094 to the network scan address list you may check that no NE uses this
address.

OK

Closes the Bus x - Addresses to Scan dialog box.

This button is disabled if no addresses have been defined.

Cancel

Closes the Bus x - Addresses to Scan dialog box and discards changes.

Help

Displays help about the Bus x - Addresses to Scan dialog box.

6.16 Bus x - Modify Address(es)/FE(s) dialog box

This dialog box allows you to change address and FE information. The title bar
shows the bus number if all addresses belong on it.
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• modifying selected addresses and FEs on one bus (Bus x  Modify
Address(es)/FE(s))

• modifying selected addresses and FEs on multiple buses (Modify
Address(es)/FE(s)).

Figure 50. Bus x - Modify Address(es)/FE(s) dialog box

Address

If you have selected FEs from a single address, the address is displayed but you
cannot change it.

This field is always disabled. It is also empty if multiple addresses have been
selected.

FE

If you have selected a single address and FE, the FE is displayed but you cannot
change it.

This field is always disabled. It is also empty if multiple FEs have been selected.

FE name

The functional entity name can be 1...32 characters long.

If you have selected one address and FE, the name of the FE name is displayed.
If you change the FE name, it is formatted as described in Section 6.13, ’Bus x -
Add Address(es)/FE(s) dialog box’.
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Note

This field is disabled if multiple FEs have been selected.

When PAM reads a configuration and creates network maps, it uses the first 11
characters of the FE name of FE 0 for naming the node symbol.

This note does not apply to the configuration type NMS/10 MF C2.0.

NE generation

The equipment generation for the selected addresses.

The default selection can be one of the following:

• All selected addresses have the same generation setting; that setting is
displayed.

• Selected addresses have different generation settings; a ’multiple’ selection
is displayed.

• All selected addresses are of unknown generation; an empty selection is
show. If only a part of the existing addresses are of unknown generation, a
’multiple’ selection is shown (there is a ’#’ mark next to the box and
information text at the bottom of the dialog box).

A multiple selection is available only when that selection is needed.

If the selection is multiple, generation settings of all the existing addresses are
retained.

The system-defined bus 254, and the system-defined address 65535 have both a
fixed value, an empty selection.

If you change the value, all addresses get the same generation setting.

NE generation is per address, not per FE.

This item is disabled if:
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• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Station

The station for the selected FEs.

The default selection can be one of the following:

• All the selected FEs have same station; that station is displayed.

• The selected FEs have multiple stations; a ’multiple stations’ selection is
displayed.

• All the selected FEs have an unknown station; an empty selection is
displayed. If only part of the existing FEs have unknown station, the
selection is defined using previous cases (unknown stations are omitted;
there is a ’#’ mark next to the box and information text at the bottom of the
dialog box).

The ’multiple stations’ selection is available only when that selection is needed.

If the selection is ’multiple stations’, station settings of all the existing FEs are
retained.

If you change the station, all selected addresses and FEs are set to that station.

The system-defined bus 254 has a fixed value 1 – PDHplat (the station name is
PDHplat if you have not changed its default value).

The system-defined address 65535 has a fixed value 2 – TMN (the station name
is TMN if you have not changed its default value).

Station / Browse...

Opens the PDH Polling General dialog box (only the Stations tab is active)
where you can modify the stations. The Station box is updated.

This button is disabled if the selected bus is 254, or the selected address is 65535.

Device type

The device type for the selected FEs.

The default selection can be one of the following:
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• All the selected FEs have same device type, which is displayed.

• The selected FEs have multiple device types; a ’multiple device types’
selection is displayed.

• All the selected FEs have unknown device types; an empty selection is
displayed. If only a part of the existing FEs have unknown device type,
selection is defined using previous cases (unknown device types are
omitted; there is a ’#’ mark next to the box and information text at the
bottom of the dialog box).

A ’multiple device types’ selection is available only when that selection is
needed.

If the selection is ’multiple device types’, device type settings of all the existing
FEs are retained.

The system-defined bus 254 has a fixed value 0 - SYSTEM (the station name is
SYSTEM if you have not changed its default value).

The system-defined address 65535 has a fixed value 0 - SYSTEM (the station
name is SYSTEM if you have not changed its default value).

If you change the device type, all selected addresses and FEs are set to that device
type.

Device Type / Browse...

Opens the PDH Polling General dialog box (only the Device types tab is active)
where you can modify the device types. The Device type combo box is updated.

This button is disabled if the selected bus is 254, or the selected address is 65535.

In fault polling

The fault polling setting for the selected addresses.

The default selection can be one of the following:
DN00276927 © Nokia Networks Oy 139 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
Note

Note

• All the selected addresses have same fault polling setting; that setting is
displayed.

• The selected addresses have different fault polling settings; the check box
is undefined.

This check box is a tri-state control only when the undefined selection is needed.
Otherwise, it has only two selections: selected or cleared.

If the selection is undefined, all the existing fault polling settings are retained.

Fault polling is set per address, not per FE.

If you change the state, all addresses get the same fault polling setting.

This check box is disabled if the selected bus is 254, or the address is 65535.

OK

Closes the Bus x - Modify Address(es)/FE(s) dialog box.

This button is disabled if at least one of the fields is empty.

Cancel

Closes the Bus x - Modify Address(es)/FE(s) dialog box and discards changes.

Help

Displays help about the Bus x - Modify Address(es)/FE(s) dialog box.

6.17 Bus x - Move Address(es)/FE(s) dialog box

This dialog box allows you to modify the selected addresses and FEs. The title bar
displays the bus on which the addresses belong to.

The Bus x - Move Address(es)/FE(s) dialog box is used to define the FE name,
NE generation, station, device type, and fault polling when FEs are moved from
the auto-discovery or network scan log to the current configuration.
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Figure 51. Bus x - Move Address(es)/FE(s) dialog box

Address

If FEs on the same address are moved, the address is displayed. Otherwise it is
empty and disabled.

The Address box is read-only.

FE

If one FE is moved, that FE is shown. Otherwise, it is empty and disabled.

The FE box is read-only.

FE name

The functional entity name can be 1...32 characters. The default selection can be
one of the following:

• One FE is moved:

- It is a new one; the FE name from the Addresses on log list view is
displayed

- It is an existing one; the FE name from the Addresses on log or
Addresses on current configuration list view is shown depending
on the Use FE name from log when adding FE to current
configuration selection.

• Multiple FEs are moved; edit box is empty and disabled.
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If multiple FEs are moved, the new FEs will get their FE name from the
Addresses on log list view and existing FEs their names from the Addresses on
log or Addresses on current configuration list view depending on the Use FE
name from log when adding FE to current configuration selection.

If you changed the FE name, or the FE is a new one, it is formatted according to
the FE Name Format when the dialog box is closed with the OK button (see
Section 6.42, ’PDH Polling General dialog box’).

When PAM reads a configuration and creates network maps, it uses the first 11
characters from the FE0's FE name for naming the node symbol.

This note does not apply to the configuration type NMS/10 MF C2.0.

NE generation

The equipment generation for the moved addresses. The default selection can be
one of the following:

• All addresses (new and/or existing) have the same generation setting; that
setting is displayed.

• New and/or existing addresses have different generations; a ’multiple’
selection is displayed.

• All existing addresses (no new addresses) are of unknown generation; an
empty selection is displayed. If there are new addresses, a multiple
selection is displayed. If only a part of the existing addresses are of
unknown generation, a ’multiple’ selection is displayed (there is a ’#’ mark
next to the box and information text at the bottom of the dialog box).

A multiple selection is available only when that selection is needed.

If the selection is ’multiple’, the generation settings of all the existing addresses
are retained and the generation for the new addresses is set according the Gen. ID
field in the Addresses on log list view.

If you change the value, all addresses get the same generation setting.

The NE generation is per address, not per FE.
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This item is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Station

The station for the moved FEs. The default selection can be one of the following:

• All existing FEs have the same station; that station is displayed. This
selection is displayed also when there are new FEs.

• Existing FEs have multiple stations; a ’multiple stations’ selection is
displayed. This selection is displayed also when there are new FEs.

• All FEs are new; an empty selection is displayed.

• All existing FEs have an unknown station; an empty selection is displayed.
This selection is displayed also when there are new FEs. If only a part of
the existing FEs have an unknown station, the selection is defined using
previous cases (unknown stations are omitted; there is a ’#’ mark next to
the box and information text at the bottom of the dialog box).

A ’multiple stations’ selection is available only when that selection is needed, but
you must select some station.

If you changed the station, all the FEs are set to that station.

Station / Browse...

Opens the PDH Polling General dialog box (only the Stations tab is active)
where you can select or create the station.

Device type

The device type for the moved FEs. The default selection can be one of the
following:

• If the Use device type from log when adding FE to current
configuration check box is selected in the Auto-discovery Log dialog box
or in the Network Scan Log dialog box, the ’use device types from the log
file’ selection is displayed

• All existing FEs have the same device type; that device type is displayed.
This selection is displayed also when there are new FEs.
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• Existing FEs have multiple device types; a ’multiple device types’
selection is displayed. This selection is displayed also when there are new
FEs.

• All FEs are new; an empty selection is displayed.

• All existing FEs have unknown device types; an empty selection is
displayed. This selection is displayed also when there are new FEs. If only
a part of the existing FEs have an unknown device type, the selection is
defined using previous cases (unknown device types are omitted; there is a
’#’ mark next to the box and information text at the bottom of the dialog
box).

A ’multiple device types’ selection is available only when that selection is
needed, but you must select some device type.

If the selection is ’use device types from the log file’, device types from the log
file are used for the FEs (even if they exist). If the device type in the log is N/A
and the FE is an existing one, its device type is retained. If the FE is a new one,
its device type is set as unknown. You must define it later separately.

If you changed the device type, all the FEs get the same device type.

Device type / Browse...

Opens the PDH Polling General dialog box (only the Device Types tab is active)
where you can select or create the device type.

In fault polling

The fault polling setting for the moved addresses. The default selection can be one
of the following:

• All existing addresses are in fault polling; the check box is selected.

• All existing addresses are not in fault polling and there are no new
addresses; the check box is cleared.

• All existing addresses are not in fault polling and there are new addresses;
the check box is undefined.
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Note

• Existing addresses have different fault polling settings; the check box is
undefined.

• All addresses are new; the check box is selected.

This check box is a tri-state control only when the undefined selection is needed.
Otherwise, it has only two selections: selected or cleared.

If the selection is undefined, all the existing fault polling settings are retained and
the new addresses are set in fault polling.

If you change the value, all addresses get the same fault polling setting.

Fault polling is per address, not per FE.

OK

Closes the dialog box. The FE name value is validated and if there is an error, MF
Manager displays a message. The dialog box is not closed.

If you changed the FE name, it is formatted according to the FE Name Format
(see Section 6.42, ’PDH Polling General dialog box’).

This button is disabled if:

• The FE name box is empty (one FE is selected)

• The NE generation box has an empty selection (the configuration type is
NMS/10 MF C2.0)

• The Station box has ’multiple stations’ or empty selection

• The Device type combo box has ’multiple device types’ or empty
selection.

Cancel

Closes the dialog box and discards changes.

Help

Displays help for the dialog box.
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6.18 Bus x Address y - Add PM Jobs

This dialog box is described in Section 6.14, ’Bus x - Add PM Jobs dialog box’.

Figure 52. Bus x Address y - Add PM Jobs dialog box

6.19 Bus x Address y - Edit PM Jobs dialog box

This dialog box is described in Section 6.14, ’Bus x - Add PM Jobs dialog box’.
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Figure 53. Bus x Address y - Edit PM Jobs dialog box

6.20 Bus x Address y FE z - Edit PM Jobs dialog box

This dialog box is described in Section 6.14, ’Bus x - Add PM Jobs dialog box’.
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Figure 54. Bus x Address y FE z - Edit PM Jobs dialog box

6.21 Change Configuration Type dialog box

This dialog box allows you to change the current configuration type.
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Figure 55. Change Configuration Type dialog box

Old configuration type

Displays the type of the current configuration.

The static text displays information about the current configuration type.

New configuration type

Selects a new configuration type. The current configuration type is excluded from
the box. The default value is an empty selection.

The static text below the combo box changes when you change the selection. It
displays information about the selected configuration type.

OK

Closes the dialog box.

This button is disabled if no new configuration type is selected.

Cancel

Closes the dialog box and discards the selection.

Help

Displays help for this dialog box.
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6.22 Configuration window

The Configuration window allows you to manage the configuration of buses,
PDH Manager interfaces, OS interfaces and printer spoolers.

This window contains the following tabs:

• Buses

• PDH Manager Interfaces

• OS Interfaces and Printer Spoolers.

The OS Interfaces and Printer Spoolers tab is disabled if the configuration type
is PDH Polling C1.0 or PDH Polling C2.0.

6.22.1 Common information

Group boxes in the top of the Configuration window contain information about
the current configuration, the current user, and the number of FEs/NEs (ND
generation, E generation, and total).

Common information is always visible regardless which tab you have selected.
The name of configuration is <Untitled> if the current configuration is a new one
and it has not been saved.

The Address information (FE/NE) group box displays the number of FEs and
NEs in the current configuration by NE generation, total number, and how many
of them are set to fault polling.

E generation information is disabled if the configuration type is PDH Polling
C1.0, PDH Polling C2.0, or NMS/10 MF C1.0.

The format of username is: domain\username. For details on security levels and
their effect, refer to Section 5.1, ’Security’.

Configuration types

NMS/10 MF C2.0

This configuration contains buses, PDH Manager Interfaces, OS Interfaces,
Printer Spoolers, SNMP Interface, and Network Test Interface. You can also
define the performance monitoring.
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Note

Note

Note

There are one polling unit and two Q1 Interface units installed in an industrial PC.
Configuration can contain up to 16 buses.

PDH Manager Interface does not contain FM information.

NMS/10 MF C1.0

This configuration contains buses, PDH Manager Interfaces, OS Interfaces, and
Printer Spoolers. You can also define the performance monitoring.

There are one polling unit and two Q1 Interface units installed in an industrial PC.
Configuration can contain up to 16 buses.

This configuration type was PDH Polling and OS Interface in MF Manager C2.0.

PDH Polling C2.0

This configuration contains buses and PDH Manager Interfaces. User can also
define the performance monitoring.

There are one polling unit and one Q1 Interface unit installed in a desktop PC.
Configuration can contain up to 8 buses.

This configuration type was PDH Polling and PM Poller in MF Manager C2.0.

PDH Polling C1.0

This configuration contains buses and PDH Manager Interfaces.

There is one polling unit and one Q1 Interface unit installed in a desktop PC.
Configuration can contain up to 8 buses.

This configuration type was PDH Polling in MF Manager C2.0.
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6.22.2 Buses tab

All buses in the current configuration are listed in this tab. The system-defined
bus 254, which is used to report about NMS/10 MF internal faults, is not
displayed.

Figure 56. Buses tab

Each list box line contains the following information about one bus:

• Bus number (0...240)

• Polling unit number (always 1)

• Primary polling direction port (1A...16B or 1A...8B)

• Primary polling direction line speed (300...19200)

• Secondary polling direction port (1A...16B or 1A...8B); displayed only if
the bus is protected

• Secondary polling direction line speed (300...19200); displayed only if the
bus is protected

• Number of FEs defined on the bus
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• Number of NEs defined on the bus

• Information about the bus being partly or totally suspended.

The port value format is Serial_channelPort, where: Serial_channel = 1...16 or
1...8 (depending on the configuration type), Port = A or B.

By default, buses are sorted in ascending order by bus number. Click the header
to sort the lines in different ways. For example, clicking FEs in the header sorts
the lines in ascending order by the number of FEs in the bus. Secondary sorting
rule is always the bus number.

It is possible that several buses have the same port on the display, although
different bus directions cannot have the same port. When saving the
configuration, MF Manager checks this.

6.22.3 PDH Manager Interfaces tab

All PDH Manager interfaces in the current configuration are listed in this tab.
These interfaces are used by PDH Alarm Manager and node managers.
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Figure 57. PDH Manager Interfaces tab

Each line contains the following information about one TCP/IP PDH Manager
interface:

• PDH Manager interface number (19...99)

• TCP/IP port (0...65535).

The following information is only available with the configuration types PDH
Polling C1.0, PDH Polling C2.0, and NMS/10 MF C1.0:

• Filter name; followed by (A) if the filter is active

• Alarm classification name.
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Note

By default, interfaces are sorted in ascending order by interface number. Click the
header to sort the lines in different ways. E.g., clicking Port sorts the lines in
ascending order by TCP/IP port number. The secondary sorting rule is always the
PDH Manager interface number.

It is possible that several PDH Manager interfaces have the same port on the
display, although different interfaces cannot have the same port. When saving the
configuration, MF Manager checks this.

6.22.4 OS Interfaces and Printer Spoolers tab

All OS interfaces and printer spoolers in the current configuration are listed in this
tab. They are displayed in separate list boxes. OS Interfaces are used by NMS/
100(0).

The OS Interfaces and Printer Spoolers is disabled if the configuration type is
PDH Polling C1.0 or PDH Polling C2.0.

Each OS interfaces list box line contains the following information about one OS
interface:

• OS interface number (1...99)

• Command interface TCP/IP port (0...65535)

• Alarm interface TCP/IP port (0...65535)

• Filter name; followed by (A) if the filter is active

• Alarm classification name.

By default, OS interfaces are sorted in ascending order by OS interface number.
Click the header to sort the lines in different ways. E.g., clicking Alarm port sorts
the lines in ascending order by alarm interface TCP/IP port number. The
secondary sorting rule is always the OS interface number.

It is possible that several OS interfaces have the same port on display. When
saving the configuration, MF Manager cancels the operation if the same port is
used in multiple OS interfaces.
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Note

Figure 58. OS Interfaces and Printer Spoolers tab

Each Printer spoolers list box line contains the following information about one
printer spooler:

• Printer spooler number (1...99)

• Printer name defined in Windows NT

• Filter name; followed by (A) if the filter is active

• Alarm classification name.

By default, printer spoolers are sorted in ascending order by printer spooler
number. You can click the header to sort the lines in different ways. E.g., clicking
Printer name sorts the lines in ascending order by printer name. The secondary
sorting rule is always the printer spooler number.

It is possible that several printer spoolers have the same printer name on display.
When saving the configuration, MF Manager cancels the operation if the same
printer name is used in multiple printer spoolers.
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6.23 Configuration Type dialog box

This dialog box allows you to select the type of a new configuration.

Figure 59. Configuration Type dialog box

New configuration type

Selects the configuration type for the new configuration. The default is NMS/10
MF C2.0.

The static text changes when you change the selection. It displays information
about the selected configuration type.

OK

Closes the Configuration Type dialog box. Continues the operation that called
this dialog box and uses the selection.

Cancel

Closes the Configuration Type dialog box and discards the selection.

Help

Displays help about the Configuration Type dialog box.

6.24 Connect dialog box

This dialog box allows you to select an on-line or off-line configuration name.

This dialog box is used for:
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• selecting an on-line configuration (Connect)

• opening an off-line configuration (Open)

• saving the current configuration with a new name (Save As).

Figure 60. Connect dialog box

Figure 61. Open dialog box
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Figure 62. Save As dialog box

Name

You can select a name in the list box or type a new name. In the Connect or Open
dialog boxes the default value is the last successfully used configuration name.
Otherwise, the default is an empty selection.

In the Open dialog box it is not possible to edit the name of the configuration.

The name is the NMS/10 MF computer name. The maximum length of the name
is 15 characters, and it must not be terminated with a period (.). The allowable
characters are:

• letters

• numbers

• the following symbols: ! @ # $ % ^ & ’ ) ( . − _ { } ∼

The static text displays information about the selected configuration type if it is a
known one, i.e. can be found on the local computer.

OK

Closes the Connect / Open / Save As dialog box. Continues the operation that
called this dialog box using the selection.

This button is disabled if:

• in the Open dialog box, Name has an empty selection

• in the Connect or Save As dialog box, Name is empty.

Cancel
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Note

Closes the Connect / Open / Save As dialog box and discards the selection.
Cancels the operation that called this dialog box.

Help

Displays help about the Connect / Open / Save As dialog box.

6.25 Fault Status Consistency Check dialog box

This dialog bus allows you to select buses for the fault status consistency check.

If all activity on all the buses is suspended, the fault status consistency check
cannot be done.

Fault status consistency check obtains the full fault status from the monitored
network elements and compares it with the locally stored fault data. If differences
are discovered, alarms and cancels are generated as appropriate and the local data
is updated. During normal operation, manual fault status consistency checks are
not needed, but in some situations (hardware replaced, local management
operations at NE site, etc.) it can be used for synchronising MF fault status with
network elements more rapidly than with periodic fault status consistency checks.

This operation only updates the fault statuses stored in the MF and generates
notifications of the changes. It does not necessarily bring the management system
up to date with the fault status of the network elements if the management system
is not synchronised with the MF.
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Figure 63. Fault Status Consistency Check dialog box

Check buses

A list of buses defined to NMS/10 MF. If all activity is suspended on a bus, it is
excluded from the list. Also, the system-defined bus 254 is excluded.

You can select multiple buses in this list.

List of buses is always checked from the NMS/10 MF, not from the current
configuration (even if it is an on-line configuration; you may have made changes
to the current configuration, but they are not sent to the system).

Start

Closes the Fault Status Consistency Check dialog box and informs the NMS/10
MF about the buses on which the fault status consistency check is carried out.

This button is disabled if no bus is selected.

Cancel

Closes the Fault Status Consistency Check dialog box and discards the
selection. Cancels the operation that called this dialog box.

Help

Displays help about the Fault Status Consistency Check dialog box.
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6.26 Filters and Alarm Classifications dialog box

This dialog box allows you to change filters and alarm classifications.

You can set a filter to the PDH Manager interface, OS interface, SNMP interface
and printer spooler. A global filter that has the highest priority over other filters
can also exist. The same filter can be used in multiple places.

Alarm classification can be set to the same place as a filter. The global alarm
classification is available only with the NMS/10 MF C2.0 configuration type.

This dialog box contains two tabs:

• Filters

• Alarm Classifications.

For details on adding filters and alarm classifications, refer to section 6.2, ’Add
Alarm Classification dialog box’, and section 6.5, ’Add Filter dialog box’.

Buttons common to all tabs

OK

Closes the Filters and Alarm Classifications dialog box.

Filters and alarm classifications are not yet written to files. They are saved when
the configuration is saved.

Cancel

Closes the Filters and Alarm Classifications dialog box and discards all
changes.

Help

Displays help about the Filters and Alarm Classifications dialog box.

Filters tab

You can define filters to the system in this tab.
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Figure 64. Filters tab

filter list

A list of filters that are sorted in ascending order by filter name with sortable
columns. After the filter name there is text include or exclude, depending on the
filter type. S is a read-only system-defined filter.

Only the user-defined filters can be used in the interfaces. System-defined filters
can be used as a base when creating user-defined filters.
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Include means that alarms that match to the definition pass through. Exclude
means that alarms that match to the definition do not pass through.

A system-defined filter and user-defined filter can have a same name. However,
there cannot be an ’include’ and ’exclude’ type system-defined or user-defined
filter with a same name.

Definition

A definition of the selected filter. This is a read-only field.

This field is empty if no filter or multiple filters are selected in the Name list box.

Comment

A comment for the selected filter. This is a read-only field.

It is empty if no filter or multiple filters are selected in the Name list box. It is also
empty if the selected filter contains no comment.

Used in

A list of PDH Manager Interfaces, OS Interfaces, Printer Spoolers and SNMP
Interface that use the selected filter. If the selected filter is also the global filter, it
is displayed first in the list. There is a letter A at the end of line if the filter is
active.

Interfaces and printer spoolers are sorted in ascending order by their number.

This list box is empty if no filter or multiple filters are selected in the Name list
box.

If the selected filter is not used in any interface or printer spooler, only the text
“filter not used” is displayed.

Add...

Opens the Add Filter dialog box where you can add a new filter.

Modify...

You can modify the selected filter in the Modify Filter dialog box. You cannot
modify the system-defined filters.

If you change the name of a filter already in use (items in Used in list box) and
exit by clicking OK, the changed name is chosen for those interfaces and printer
spoolers.
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This button is disabled if no filter or multiple filters are selected, or the system-
defined filter is selected in the Name list box.

Delete

Deletes the selected filter(s). You are asked for confirmation before the selected
filter(s) are deleted. You cannot delete system-defined filters.

This button is disabled if no filters, or only system-defined filters are selected in
the Name list box.

Copy

Makes a copy of the selected filter.

A new filter is added to the Name list box. A unique number is added to the end
of the filter name. The Definition is the same as in the original filter. The
Comment is set empty and the new filter is set to unused.

This button is disabled if no filter or multiple filters are selected in the Name list
box.

Alarm Classifications tab

You can define alarm classifications to the system in this tab.

Alarm severity definitions made in the MF Manager do not have any effect on the
PDH Alarm Manager alarm severity. It defines its own alarm severities.
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Figure 65. Alarm Classifications tab

alarm classification list

A list of alarm classifications with sortable columns. By default the list is sorted
in ascending order by alarm classification name. S denotes a read-only system-
defined alarm classification.

Only user-defined alarm classifications can be used with the interfaces. System-
defined alarm classifications can be used as a base when creating user-defined
alarm classifications.

A system-defined alarm classification and user-defined alarm classification can
have a same name.
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Severity definition type / Critical

Selects the critical definitions to be displayed in the Definition edit box. This
severity definition type is sometimes named fatal.

This is the default selection.

Severity definition type / Major

Selects the major definitions to be displayed in the Definition box.

Severity definition type / Minor

Selects the minor definitions to be displayed in the Definition box.

Severity definition type / Warning

Selects the warning definitions to be displayed in the Definition box.

This item is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Definition

A definition of the selected alarm classification and definition type.

This is a read-only field. It is empty if no alarm classification or multiple alarm
classifications are selected in the Name list box, or there is no definition for the
selected definition type.

Comment

A comment for the selected alarm classification.

This is a read-only field. It is empty if no alarm classification or multiple alarm
classifications are selected in the Name list box. It is also empty if the selected
alarm classification contains no comment.

Used in

A list of PDH Manager Interfaces, OS interfaces, Printer Spoolers and SNMP
Interface that use the selected alarm classification. There is no default value.

Interfaces and printer spoolers are sorted in ascending order by their number. If
there is a global alarm classification, it is shown first.
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The list box is empty if no alarm classification or multiple alarm classifications
are selected in the Name list box.

If the selected alarm classification is not used in any interface or printer spooler,
only text “alarm classification not used” is displayed.

Add...

Opens the Add Alarm Classification dialog box where you can add a new alarm
classification.

Modify...

Opens the Modify Alarm Classification dialog box where you can modify the
selected alarm classification. You cannot modify the system-defined alarm
classifications.

If you change the name of the alarm classification and the alarm classification is
already in use (items in Used in list box) and exit by clicking OK, the changed
name is brought into use in those interfaces and printer spoolers.

This button is disabled if no alarm classification or multiple alarm classifications
are selected in the Name list box, or you have selected a system-defined alarm
classification.

Delete

Deletes selected alarm classification(s). You are asked for confirmation before
the selected alarm classification(s) are deleted.

You cannot delete system-defined alarm classifications.

This button is disabled if no alarm classifications are selected, or only system-
defined alarm classifications are selected in the Name list box.

Copy

Makes a copy of the selected alarm classification including all the definition types
(critical, major, minor, warning).

A new alarm classification is added to the Name list box. A unique number is
added after the alarm classification name. The Definition is the same as in the
original alarm classification. Comment is set empty and the new alarm
classification is set to unused.

This button is disabled if no alarm classification or multiple alarm classifications
are selected in the Name list box.
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6.27 Font dialog box

This is a Windows NT system dialog box. For details, refer to the Windows NT
user documentation.

Figure 66. Font dialog box

6.28 Hardware dialog box

The Hardware dialog box allows you to view the current hardware settings of the
polling unit. This dialog box contains a tab named Polling Unit 1.

The Hardware dialog box is read-only.

Buses are connected to Q1 Interface units. One Q1 Interface unit can have up to
8 protected buses. One polling unit can have one or two Q1 Interface units, i.e. 8
or 16 protected buses.

You can change the values in this dialog box, but the changes are ignored. MF
Manager reads the real values from the NMS/10 MF or PDH Polling every time
it sends the configuration. I/O base address and interrupt level are fixed when the
NMS/10 MF or PDH Polling is installed.
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Polling Unit 1 tab

You can view the current settings of the polling unit in this tab.

Figure 67. Polling Unit 1 tab

IO Address (hex)

The I/O address of this unit can be 200, 220, 240, 260, 300, 320, 340 or 360. The
default is an empty selection.

Interrupt

The interrupt level of this unit can be 10, 11, 12 or 15. The default is an empty
selection.

Interface unit 1

The Interface Unit 1 can be none or internal. The default is internal.

Interface unit 2

The Interface Unit 2 can be none or internal. If the configuration type is NMS/10
MF C2.0 or NMS/10 MF C1.0, the default is internal. Otherwise the default is
none.

OK

Closes the Hardware dialog box.

Cancel

Closes the Hardware dialog box.
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Help

Displays help about the Hardware dialog box.

6.29 MF Manager Window

This window is described in Section 6.10, ’Application window’.

6.30 Modify Address(es)/FE(s) dialog box

This dialog box is described in Section 6.16, ’Bus x - Modify Address(es)/FE(s)
dialog box’.

6.31 Modify Alarm Classification dialog box

This dialog box is described in Section 6.2, ’Add Alarm Classification dialog
box’.

6.32 Modify Device Type dialog box

This dialog box is described in Section 6.4, ’Add Device Type dialog box’.

6.33 Modify Filter dialog box

This dialog box is described in Section 6.5, ’Add Filter dialog box’.

6.34 Modify Station dialog box

This dialog box is described in Section 6.7, ’Add Station dialog box’.
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6.35 Network Scan dialog box

This dialog box allows you to select buses and addresses for the network scan.
Network Scan is the easiest way to find out which NEs are on the management
network. You can define the buses and addresses where to query for the NE and
the NMS/10 MF creates a log file about the found NEs. You can select the FEs
you want include in the current configuration in the Network Scan Log dialog
box.

If all activity on all buses is suspended, the Network Scan cannot be done.

Figure 68. Network Scan dialog box

“bus list box”

A list of buses defined for the network scan with sortable columns. By default,
buses are sorted in ascending order by bus number.

Add...
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Opens the Add Bus dialog box where you can select a bus. Only the free buses
and those defined to the system are displayed. If all activity is suspended on a bus,
it is excluded from the list. Also, the system defined bus 254 is excluded.

List of buses is always checked from the NMS/10 MF, not from the current
configuration (even if it is an on-line configuration; you may have made changes
to the current configuration, but they are not sent to the system).

Opens the Bus x - Addresses to Scan dialog box where you can define the
addresses.

Modify...

Opens the Bus x - Addresses to Scan dialog box where you can modify the
addresses.

This button is disabled if no bus or multiple buses are selected.

Delete

Deletes selected bus(es) from the network scan. You are asked for confirmation
before the selected bus(es) are deleted.

This button is disabled if no bus is selected.

Start

Closes the Network Scan dialog box and informs NMS/10 MF about the buses
and addresses on which the network scan is carried out.

As long as the network scan is going on and there is a connection to NMS/10 MF,
a moving magnifying glass is displayed in the status bar.

This button is disabled if no bus is defined.

Cancel

Closes the Network Scan dialog box and discards the selection. Cancels the
operation that called this dialog box.

Help

Displays help about the Network Scan dialog box.
DN00276927 © Nokia Networks Oy 173 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
Note

6.36 Network Scan Log dialog box

This dialog box is described in Section 6.11, ’Auto-discovery dialog box’.

6.37 Network Test Interface dialog box

This dialog box allows you to manage the configuration of the Network Test
Interface.

Figure 69. Network Test Interface dialog box

TCP/IP port

The TCP/IP port can be 0...65535. The default port number is 49900.

The Network Test Interface must have a unique TCP/IP port.

Max. number of connections

The maximum number of connections allowed through the TCP/IP port can be
1...99. The default number is 1.

Logon
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The logon parameters for the Network Test Interface.

Logon / Use local computer

If selected, the computer on which the NMS/10 MF is running is used to validate
the logon. The default value is cleared.

If this check box is selected, Logon domain is disabled.

Logon / Logon domain

The Windows NT network domain or computer name that is used for validating
the logon. The length can be 1...15 characters. The default value is empty.

Allowed characters are letters, numbers and the following symbols:

! @ # $ % ^ & ' ) ( . - _ { } ∼

This field is disabled if Use local computer is selected.

Logon / User group

The Windows NT user group to which the Network Test Interface user must
belong in the NMS/10 MF computer. The user group must be local and not any
of the standard Windows NT user groups.

The name of user group can be 1...256 characters. The backslash (\) is not an
allowed character.

The default user group is Nokia NMS/10 MF Command Interface.

This field is disabled if the configuration type is PDH Polling C1.0, PDH Polling
C2.0, or NMS/10 MF C1.0.

Logon / Logon time-out

The time-out to use in the logon. The time-out can be 0...86 400 in seconds (0...24
h). The value 0 is a so-called ’do not care’ value, i.e. there is no time-out. The
default value is 60 seconds.

OK

Closes the dialog box. All values are validated and if there are errors, MF
Manager displays an error message. The dialog box is not closed.

This button is disabled if any of TCP/IP port, Max. number of connections,
User group, or Logon time-out is empty, or Use local computer is cleared and
Logon domain is empty.

Cancel
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Closes the dialog box and discards changes.

Help

Displays help about the dialog box.

6.38 Open dialog box

This dialog box is described in Section 6.24, ’Connect dialog box’.

6.39 OS Interface x dialog box

This dialog box allows you to change the configuration of the selected OS
interface.

The OS Interface is a combination of two types of NMS/100 interfaces: the
command interface and the alarm interface. Both interfaces use their own TCP/IP
port. The OS Interface is for emulating the NMS/100 interface of TMS4.

This dialog box contains the following tabs:

• General

• Ports

• Heartbeat and Equipment Type Text

The Heartbeat and Equipment Type Text tab is disabled if:

• configuration type is NMS/10 MF C1.0 and it is not version C

• configuration type is PDH Polling C2.0

• configuration type is PDH Polling C1.0.

MF Manager C2.0 had a FE Name tab. It is not used any more. Creation of unique
FE names is deselected by default.

When changing from one tab to another, all values are validated. If there are
errors, an error message is displayed. The tab is not changed.
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Buttons common to all tabs

OK

Closes the OS Interface x dialog box.

All values are validated and if there are errors, an error message is displayed and
operation is cancelled.

Cancel

Closes the OS Interface x dialog box and discards all changes.

Help

Displays help about the OS Interface x dialog box.

General tab

You can modify general parameters of the selected OS interface in this tab.

Figure 70. General tab

Filter / Name
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The name of the filter. All filters found in the current configuration are in the list.
There is no default selection. System-defined filters are not displayed in the list.

The same filter is used for all connections to the command interface and alarm
interface TCP/IP ports.

If the filter name is not defined, no filter is used in the OS interface.

If the interface has no filter and there is an active global filter, it defines which
alarms are reported through the OS Interface. However, the global filter is not
effective with the system-defined bus 254 alarms; thus they all are reported.

Filter / Active

If the Active check box is checked, the filter is also taken into use. The default is
not checked.

This check box has no effect if the filter name is not defined.

Filter / Browse

Opens the Filters and Alarm Classifications dialog box where you can select or
create the filter. Only the Filters tab is active.

Alarm classification / Name

The name of the alarm classification. All alarm classifications found in the
current configuration are in the list. There is no default selection. System-defined
alarm classifications are not displayed in the list.

The same alarm classification is used for all connections to the command
interface and alarm interface TCP/IP ports.

If the alarm classification name is not defined, no alarm classification is used in
the OS interface.

If the interface has no alarm classification, there can be a global alarm
classification, which defines the alarm severities used in the OS Interface.
However, the global alarm classification is not effective with the system-defined
bus 254 alarms; thus they all have their default values.

Alarm classification / Browse
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Note

Note

Opens the Filters and Alarm Classifications dialog box where you can select or
create the alarm classification. Only the Alarm Classifications tab is active.

Alarm buffer / Size

The alarm buffer size can be 100...10 000 events. The default is 1000 events.

This value is only valid for the alarm interface.

Alarm buffer / Free space alarm limit

When the free space in alarms in the alarm buffer decreases under this limit, an
alarm is sent. The default is 30.

This value is only valid for the alarm interface.

The alarm limit must be smaller that the alarm buffer size.

Alarm buffer / Free space cancel limit

When the free space in alarms in the alarm buffer increases over this limit (after
an alarm is sent), a cancellation is sent. The default is 60.

This value is only valid for the alarm interface.

The cancel limit must be smaller than the alarm buffer size and greater than the
alarm limit.

Alarm and alarm cancellation are sent to every interface (PDH Manager Interface,
OS Interface, Printer Spooler and SNMP Interface).

Alarm buffer / Full action
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The action to be carried out when the alarm buffer is full can be discard old or
discard new. The default is discard old.

This value is only valid for the alarm interface.

Discard old means that the new alarm is added to the alarm buffer and the oldest
alarm is removed from there.

Before the alarm buffer is full, an “Alarm limit exceeded” alarm is added to the
alarm buffer. As the alarm buffer eventually becomes full, a “Buffer overflow”
alarm is added to the alarm buffer. However, if the alarm buffer remains full
(alarms are not read), these alarms are overwritten and thus lost.

Discard new means that the new alarm is not added to the alarm buffer.

Ports tab

You can modify command and alarm interface parameters in this tab.
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Figure 71. Ports tab

Command port

The TCP/IP port value can be 0...65535. The default value is 500.

Connection is closed by NMS/10 MF if there is no activity within 12 hours.

Each command interface must have a unique TCP/IP port.

Max. number of connections (Command port)

The maximum number of connections allowed through this command interface
TCP/IP port can be 1...99 The default value is 10.

Alarm port
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The TCP/IP port value can be 0...65535. The default value is 501.

Each alarm interface must have a unique TCP/IP port.

Max. number of connections (Alarm port)

The maximum number of connections allowed through this alarm interface TCP/
IP port can be 1...99. The default value is 1.

Logon / Use local computer

If Use local computer is checked, the computer on which the NMS/10 MF is
running is used to validate the logon. The default is not selected.

This value is only valid for the command interface.

If the Use local computer check box is selected, Logon domain is disabled.

Logon / Logon domain

The Windows NT network domain or computer name to use when validating
logon. The length can be 1...15 characters. The default value is empty.

Allowed characters are letters, numbers and the following symbols:

! @ # $ % ^ & ' ) ( . - _ { } ∼

If the configuration type is not NMS/10 MF C2.0, the OS Interface user must
belong to the local user group Nokia NMS/10 MF Command Interface in the
NMS/10 MF computer. Otherwise, the user must belong to the user group
displayed in the User group edit box.

This value is only valid for the command interface.

This box is disabled if the Use local computer check box is selected.

Logon / User group
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The Windows NT user group to which the OS Interface user must belong in the
NMS/10 MF computer. The user group must be local and not any of the standard
Windows NT user groups.

The user group name can be 1...256 characters. The backslash (\) is not an
allowed character.

The default user group is Nokia NMS/10 MF Command Interface.

This value is valid only for the command interface.

This field is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Logon / Logon time-out

The time-out to use in logon can be 0...86400 seconds. There is no time-out if the
value is 0. The default is 600 seconds.

This value is only valid for the command interface.

Heartbeat and Equipment Type Text tab

You can modify parameters for the heartbeat and equipment type text on the
selected OS Interface.

This tab is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0 and its version is not C.

NMS/10 MF C1.0 version C supports heartbeat and equipment type text
functionality. However, MF Manager C2.0 did not support them. MF Manager
C2.5 notices if NMS/10 MF C1.0 is version C and supports changing these
parameters.
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Figure 72. Heartbeat and Equipment Type Text tab

Heartbeat

The heartbeat configuration for the selected OS Interface.

Heartbeat is valid only for the alarm interfaces.

Heartbeat / Send heartbeat

Select if the selected OS Interface sends a heartbeat text. The default is cleared.

If this check box is cleared, all the rest of the controls in the Heartbeat group box
are disabled.

Heartbeat / Interval (d hh:mm)

The interval of sending the heartbeat text. The heartbeat interval can be from 1
minute to 7 days. The default interval is 1 minute.
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When the alarm interface is created, OS Interface immediately sends the first
heartbeat.

The new interval is activated and the heartbeat is sent immediately after the
interval is changed.

This is the interval of sending the heartbeat text, not the time of silence. Sending
may be delayed in case of network trouble or excessive alarms.

The meaning of the Interval (d hh:mm) boxes from left to right:

• days (0...7)

• hours (0...23)

• minutes (0...59).

The content of the box is set empty if there is an illegal value.

These boxes are disabled if Send heartbeat is cleared.

Heartbeat / Text

The heartbeat text can be 1...64 characters long. Text can contain placeholders
that are expanded in printing. The expanded heartbeat text must not exceed 2048
characters.

If you change the heartbeat text but not the interval, the new text is sent only when
the heartbeat is sent for the next time.

The default text is: MF /q/ alive /x//l/.

The following placeholders can be used in the text:

• /l/ is carriage return (CR) followed by line feed (LF)

• /q/ is the two-digit decimal unit (equipment ID) number (right adjusted in
the expanded text)

• /s/ is the space character

• /t/ is the tabulator character

• /x/ is the current date and time in format yy−mm−dd hh:mm:ss

• // is a single slash (/).
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/l/, /s/, and /t/ can be preceded with a repeat count (max. 255). For example,
/20s/ is expanded into 20 spaces. Spaces preceding /l/ are omitted in printing.
Each line must end with the /l/ operator.

This box is disabled if Send heartbeat is cleared.

Heartbeat / Heartbeat text expanded

Displays the heartbeat text in expanded form.

At the beginning of each line there is the line number, colon, and one space. They
are not part of the expanded heartbeat text and will not be printed. They show the
number of lines there will be.

The Heartbeat text expanded box is read-only, and it is disabled if Send
heartbeat is deselected.

Heartbeat / Length

Displays the length of the heartbeat text in expanded form. If the length exceeds
the maximum value (2048 characters), an overflow is notified.

This box is disabled if Send heartbeat is cleared.

Equipment type text

The equipment type text can be 0... 3 characters long. The equipment type text is
sent in the columns 30...32 in the first line of the alarm text. The text is right-
justified and padded with spaces in front of it (if necessary).

The default value is ’MF’.

6.40 Page Setup dialog box

This dialog box allows you to manage the page setup parameters for a printed
configuration report.

Page setup settings can be used with all configuration types, but the settings are
saved to configuration only if the configuration type is NMS/10 MF C2.0.
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Figure 73. Page Setup dialog box

Margins

The margins for printing the configuration report. The usable margins depend on
the selected printer driver. Below this group box is a static text that displays the
minimum margins reported by the printer.

Margins / Top

The top margin for printing the configuration report can be 5...50 mm. The default
value is 10 (mm).

MF Manager C2.0 used a top margin of 2 lines.

Margins / Left

The left margin for printing the configuration report can be 5...50 mm. The default
value is 15 (mm).

MF Manager C2.0 used a left margin of 4 characters.

Margins / Right
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The right margin for printing the configuration report can be 5...50 mm. The
default value is 10 (mm).

MF Manager C2.0 used a right margin of 4 characters.

Margins / Bottom

The bottom margin to use in printing the configuration report can be 5...50 mm.
The default value is 10 (mm).

MF Manager C2.0 used a bottom margin of 3 lines.

Orientation

The orientation of the paper for printing the configuration report.

Orientation / Portrait

The orientation of the paper is portrait.

This is the default selection.

Orientation / Landscape

The orientation of the paper is landscape.

Font

The currently selected font for printing the configuration report.

There are two lines of static text:

• The first line displays the currently selected font name, size, and style. You
can change the selection in the Font dialog box, opened by clicking Select
Font....

• The second line displays the number of lines and characters per line fits on
the paper using the current margin and font settings. Values are updated
every time there is a change in the margin, orientation, or font setting.

Font / Select Font...
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Selects the font, font style, and size for printing the configuration report. The
default setting is: Courier New, Regular, and 9. (This setting was used in MF
Manager C2.0.)

Opens the Font dialog box where you can select the font, font style, and font size.
Fonts are restricted to fixed pitch and scalable fonts. Both screen fonts and printer
fonts can be used.

OK

Closes the dialog box. All values are validated and if there are errors, MF
Manager displays an error message. The dialog box is not closed.

This button is disabled if any of the boxes in Margins is empty, or a font is not
selected.

Cancel

Closes the dialog box and discards changes.

Help

Displays help for the dialog box.

6.41 PDH Manager Interface x dialog box

The PDH Manager Interface dialog box allows you to change the configuration
of the selected PDH Manager interface.

This interface is used by PDH Alarm Manager (used with the NMS/10 System
Releases C4.0 and C4.1) and node managers.

If the configuration type is NMS/10 MF C2.0, you can connect to one PDH
Manager Interface from multiple computers. Other configuration types require a
separate PDH Manager Interface for each computer.

This dialog box contains the following tabs:

• General

• Port.

The General tab is disabled if the configuration type is NMS/10 MF C2.0.

When changing from one tab to another, all values are validated. If there are
errors, an error message is displayed. The tab is not changed.
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Buttons common to all tabs

OK

Closes the PDH Manager Interface dialog box. All values are validated and if
there are errors, an error message is displayed and the operation is cancelled.

Cancel

Closes the PDH Manager Interface dialog box and discards all changes.

Help

Displays help about the PDH Manager Interface dialog box.

General tab

You can modify general parameters for the selected PDH Manager interface in
this tab. This tab is disabled if the configuration type is NMS/10 MF C2.0.

Figure 74. General tab

Filter / Name
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The name of the filter. All filters found in the current configuration are in the list.
There is no default selection. System-defined filters are not displayed in the list.

If the interface has no filter and there is an active global filter, it defines which
alarms are reported through the OS Interface. However, the global filter is not
effective with the system-defined bus 254 alarms; thus they all are reported.

If the filter name is not defined, no filter is used in this PDH Manager interface.

The same filter is used for all connections to the TCP/IP port.

Filter / Active

If you check the Active check box, the filter is also brought into use. The default
value is not checked.

This check box has no effect if the filter name is not defined.

Filter / Browse

Opens the Filters and Alarm Classifications dialog box where you can select or
create the filter. Only the Filters tab is active.

Alarm classification / Name

The name of the alarm classification. All alarm classifications found in the
current configuration are in the list. There is no default selection. System-defined
alarm classifications are not displayed in the list.
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If the alarm classification name is not defined, no alarm classification is used in
this PDH Manager interface.

If the interface has no alarm classification, there can be a global alarm
classification, which defines the alarm severities used in the OS Interface.
However, the global alarm classification is not effective with the system-defined
bus 254 alarms; thus they all have their default values.

The same alarm classification is used for all connections to the TCP/IP port.

Alarm classification / Browse

Opens the Filters and Alarm Classifications dialog box where you can select or
create the alarm classification. Only the Alarm Classifications tab is active.

Alarm buffer / Size

The size of alarm buffer in alarms can be 100...10 000 events. The default is 1000
events.

Alarm buffer / Free space alarm limit

When the free space in alarms in the alarm buffer decreases below this limit, an
internal fault is set onto bus 254. The default is 30.

The alarm limit must be smaller than the alarm buffer size.

Alarm buffer / Free space cancel limit

When the free space in alarms in the alarm buffer increases over this limit (after
an alarm is sent), an alarm cancellation is sent. The default is 60.

The cancel limit must be smaller than the alarm buffer size and greater than the
alarm limit + 30.

Alarm and alarm cancellation are sent to every interface (PDH Manager interface,
OS interface, SNMP interface and printer spooler).

Alarm buffer / Full action
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The action to be carried out when the alarm buffer is full can be discard old or
discard new. The default is discard old.

Discard old means that the new alarm is added to the alarm buffer and the oldest
alarm is removed from there.

Before the alarm buffer is full, an “Alarm limit exceeded” alarm is added to the
alarm buffer. As the alarm buffer eventually becomes full, a “Buffer overflow”
alarm is added to the alarm buffer. However, if the alarm buffer remains full
(alarms are not read), these alarms are overwritten and thus lost.

Discard new means that the new alarm is not added to the alarm buffer.

Port tab

You can define parameters for TCP/IP port in this tab.

If the configuration type is NMS/10 MF C2.0, you can connect to one PDH
Manager Interface from multiple computers. Other configuration types need a
separate PDH Manager Interface for each computer.
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Figure 75. Port tab

TCP/IP port

The TCP/IP port value can be 0...65535. The default value is 27500.

Each PDH Manager Interface must have a unique TCP/IP port.

Logon / Use local computer

If Use local computer is checked, the computer on which the NMS/10 MF is
running is used to validate the logon. The default is not selected.

If the Use local computer check box is selected, Logon domain is disabled.

Logon / Logon domain

The Windows NT network domain or computer name to use when validating
logon. The length can be 1...15 characters. The default value is empty.
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Allowed characters are letters, numbers and the following symbols:

! @ # $ % ^ & ' ) ( . - _ { } ∼

If the configuration type is not NMS/10 MF C2.0, the PDH Manager Interface
user must belong to the local user group Nokia NMS/10 MF Command Interface
on the NMS/10 MF computer. Otherwise, the user must belong to the user group
displayed in the User group edit box.

Logon / User group

The Windows NT user group to which the PDH Manager Interface user must
belong in the NMS/10 MF computer. The user group must be local and not any
of the standard Windows NT user groups.

The user group name can be 1...256 characters. The backslash (\) is not an
allowed character.

The default user group is Nokia NMS/10 MF Command Interface.

This field is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Logon / Logon time-out

The time-out to use in logon can be 0...86 400 seconds (24 hours). There is no
time-out if the value is 0.

For the configuration type NMS/10 MF C2.0 the default is 86 400 seconds and it
is also used as an ’inactivity time-out’, which breaks the connection if nothing
happens during the time-out.

Otherwise the default is 60 seconds.

6.42 PDH Polling General dialog box

This dialog box allows you to change the general values of NMS/10 MF.

This dialog box contains the following tabs:

• FE Name Format

• Global Filter and Alarm Classification
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• Limits

• Hard Disk

• Stations

• Device Types

• Equipment ID

• Comment.

When changing from one tab to another, all values are validated. If there are
errors, an error message is displayed. The tab is not changed.

Buttons common to all tabs

OK

Closes the PDH Polling General dialog box. All values are validated and if there
are errors, an error message is displayed and the operation is cancelled.

Cancel

Closes the PDH Polling General dialog box and discards all changes.

Help

Displays help about the PDH Polling General dialog box.

FE Name Format tab

This is the FE name format that is used when MF Manager adds a new network
element to the configuration, or when you change the FE name of an existing FE.
This format is not used with the system-defined bus 254.

Old FE names are not changed if you change the format in an existing
configuration. You can use the Change All Now button to change all FE names
at once.
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Figure 76. FE Name Format tab

“ bb.aaaa.ff device name” [b, a and f in hexadecimal]

The FE name format is “bb.aaaa.ff device name”, where bb is the bus number in
hexadecimal (00...F0), aaaa is the NE address in hexadecimal (0000...0FFD) and
ff is the functional entity number in hexadecimal (00...FE). The device name is a
name supplied by user (the maximum length is 21 characters).

When the configuration is PDH Polling C1.0 or PDH Polling C2.0, this option is
disabled.

An example:

3F.0093.00 DM 2 AD1

The format of the address 65535 (FFFF) is “BUxx device name”, where BUxx is
the bus number in hexadecimal (BU00...BUF0) and device name is the name
supplied by user (the maximum length is 27 characters). The default device name
is ’SUPERVISION BUS’.

An example:

BU3F SUPERVISION BUS

 “device name (BUxx ADxxxx FExx)” [x in hexadecimal]
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The FE name format is “device name (BUxx ADxxxx FExx)”, where device name
is the name supplied by user (the maximum length is 13 characters), BUxx is the
bus number in hexadecimal (BU00...BUF0), ADxxxx is the NE address in
hexadecimal (AD0000...AD0FFD), and FExx is the functional entity number in
hexadecimal (FE00...FEFE).

An example:

DM 2 AD1 (BU3F AD0093 FE00)

The format of the address 65535 (FFFF) is “device name BUxx”, where BUxx is
the bus number in hexadecimal (BU00...BUF0) and device name is the name
supplied by user (the maximum length is 27 characters). The default device name
is ’SUPERVISION BUS’.

An example:

SUPERVISION BUS BU3F

 “device name bb.aaaa.ff” [b, a and f in decimal]

The FE name format is “device name bb.aaaa.ff”, where device name is the name
supplied by user (the maximum length is 19...21 characters depending on bus and
FE numbers; see note below), bb is the bus number in decimal (00...240), aaaa is
the NE address in decimal (0000...4093), and ff is the FE number in decimal
(00...254).

The default width for the bus number and functional entity fields is 2. If the bus
or FE number is greater than 99, the width is set to 3. Use this style with NMS/
100(0).

An example:

DM 2 AD1 63.0147.00

The format of the address 65535 (FFFF) is “device name BUxx”, where BUxx is
the bus number in decimal (BU00...BU240), and device name is the name
supplied by user (the maximum length is 26 or 27 characters depending on the
length of the bus number). The default device name is ’SUPERVISION BUS’.

The default width for the bus number field is 2. If the bus number is greater than
99, the width is set to 3. Use this style with NMS/100(0).
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An example:

SUPERVISION BUS BU63

“device name”

The FE name format is “device name” , where device name is the name supplied
by user (the maximum length is 32 characters). The bus number, NE address and
functional entity number are not included.

An example:

DM 2 AD1

The format of the address 65535 (FFFF) is “device name”, where device name is
the name supplied by user (the maximum length is 32 characters). The bus
number is not included. The default device name is ’SUPERVISION BUS’.

An example:

SUPERVISION BUS

This is the recommended option and it is selected by default.

Change All Now

Changes all existing FE names using the selected style. The changes are
permanent and they cannot be cancelled with the Cancel button.

Global Filter and Alarm Classification tab

This tab defines the global filter and alarm classification to use with NMS/10 MF
before any other filter or alarm classification.

Global alarm classification can be used for overriding the default severity
assignment of all events (except for internal faults on bus 254). The initial
severities of events generated by ND generation fault polling is set based on fault
codes according to the NMS/10 MF Fault Codes (an appendix to the NMS/10 MF
C2.0 Operating Manual). E generation fault polling obtains the initial severity
from the network element.
DN00276927 © Nokia Networks Oy 199 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
Figure 77. Global Filter and Alarm Classification tab

Filter

The parameters for the global filter to use in the NMS/10 MF before all other
filters.

Filter / Name

The name of the global filter to use in the NMS/10 MF. The list contains filter
names found in the current configuration. The system-defined filters are not in the
list. The default selection is empty.

If the global filter name is not defined, no global filter is used in the NMS/10 MF.

Filter / Active

If this is selected, the global filter is also in use. The default is cleared.

This check box has no effect if the global filter name is not defined.

Filter / Browse...

Opens the Filters and Alarm Classifications dialog box (only the Filters tab is
active) where you can select or create the global filter. The Filter box is updated.

Alarm classification

The parameters for the global alarm classification to use in the NMS/10 MF
before all other alarm classifications.
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This group box and all the controls inside it are disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Alarm classification / Name

The name of the global alarm classification to use in the NMS/10 MF. The list
contains alarm classification names found in the current configuration. The
system-defined alarm classification are not in the list. The default selection is
empty.

If the global alarm classification name is not defined, no global alarm
classification is used in the NMS/10 MF.

This list is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Alarm classification / Browse...

Opens the Filters and Alarm Classifications dialog box (only the Alarm
Classifications tab is active) where you can select or create the global alarm
classification. The Alarm classification box is updated.

This button is disabled if:

• the configuration type is PDH Polling C1.0

• the configuration type is PDH Polling C2.0

• the configuration type is NMS/10 MF C1.0.

Limits tab

You can set limits to the number of addresses on one bus, the number of FEs in
the polling unit, and the number of PDH Manager Interfaces that can be created.

The PDH Manager Interface limit is absolute. Other limits are not absolute, but
they are used as warning levels for you informing that exceeding these limits may
cause problems.
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Figure 78. Limits tab

Max. number of addresses / bus

The maximum number of addresses in one bus can be 1...4094. The default is 200.

Max. number of FEs / polling unit

The maximum number of FEs in one polling unit. The default values are:

• PDH Polling C1.0 and C2.0 (8 buses), the default value is 1500

• NMS/10 MF C1.0 and C2.0 (16 buses), the default value is 3000.

Max. number of PDH manager interface

The maximum number of PDH Manager interfaces allowed for the NMS/10 MF
C2.0 configuration type is 60 and the default is 8. For other configuration types,
both the maximum and default values are 8.

If the configuration type is NMS/10 MF C2.0, you can connect to one PDH
Manager Interface from multiple computers. Other configuration types need a
separate PDH Manager Interface for each computer.
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Hard Disk tab

Determines the alarm and cancel limits for the free disk space. When the free disk
space on the hard disk decreases under the alarm limit, an alarm is sent. When the
free disk space on the hard disk increases over the cancel limit (after an alarm is
sent), a cancel for the alarm is sent.

Alarms and alarm cancellations are sent to every interface (PDH Manager
interface, OS interface, SNMP interface and printer spooler).

Figure 79. Hard Disk tab

Free space alarm limit (MB)

The alarm limit in megabytes. The alarm limit can be 1...2048 MB. The default is
50 MB.

Free space cancel limit (MB)

The cancel limit in megabytes. The cancel limit can be 1...2048 MB. The default
is 55 MB.
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Note

The cancel limit must be higher that the alarm limit.

In NMS/10 MF and PDH Polling 1 MB is 1 million bytes.

Stations tab

You can change station information in this tab. Station can be considered as an
entity, e.g. a location, which multiple NEs belong to.

Figure 80. Stations tab

“station list box”

A sortable list of stations. By default, it is sorted in ascending order by station
number. 1 PDHplat and 2 TMN are system-defined stations.

These stations are reserved and cannot be used for naming equipment. However,
you can modify the names.

Add...

Opens the Add Station dialog box where you can add a new station.
204 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Reference
Modify...

Opens the Modify Station dialog box where you can modify the selected station.

This button is disabled if no station or multiple stations are selected.

Delete

Deletes selected station(s). A confirmation is asked before the deletion. System-
defined stations and stations in use cannot be deleted.

This button is disabled if no station is selected, or only system-defined stations
are selected.

Device Types tab

You can change device type information common with NMS/10 MF in this tab.
Device type can be considered as a product family, e.g. ACM2.

Figure 81. Device Types tab

“device type list view”

A sortable list of device types. By default, it is sorted in ascending order by device
type number.

There are three system-defined device types: 0 SYSTEM (reserved, you cannot
take it into use), 1 TRANSM and 2 EXTERN. You can change the names of the
system-defined device types.
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TRANSM is for transmission equipment in general and EXTERN for other
equipment used in management network, for example, Branching Unit, TMS
Adaptor and Supervisory Substation.

Add...

You can add a new device type in the Add Device Type dialog box.

Modify...

You can modify device types in the Modify Device Type dialog box.

This button is disabled if no device type or multiple device types are selected.

Delete

Deletes selected device type(s). You are asked for confirmation before the
selected device type(s) are deleted. The system-defined device types and device
types that are in use cannot be deleted.

This button is disabled if no device types are selected or only system-defined
device types are selected.

Equipment ID tab

You can change the equipment ID of NMS/10 MF in this tab.

Figure 82. Equipment ID tab

Equipment ID
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The equipment identification number of NMS/10 MF can be 0...255. There is no
default value.

If there are OS interfaces or printer spoolers in a configuration, recommended
values are 0...99. Larger values may cause problems as OS interface and printer
spooler alarm format assume that the equipment ID contains a maximum of 2
digits.

The equipment ID provides a means for a supervising network management
system (for example NMS/100) to identify and distinguish between different
NMS/10 MF subsystems.

Comment tab

This tab contains a comment about configuration. You can see the comment in a
print-out in addition to this dialog box.

Figure 83. Comment tab

“comment edit box”

A free format comment about the configuration. The maximum length of the
comment is 500 characters. There is no default value.
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6.43 Performance Settings dialog box

This dialog box allows you to define PM data size limits and the action to be taken
when the maximum data size is reached.

Alarms and alarm cancellations are sent to every interface (PDH Manager
interface, OS interface, SNMP interface and printer spooler).

Figure 84. Performance Settings dialog box

Performance Monitoring data / Max. size (MB)

The maximum space reserved for performance monitoring data can be 1...1 000
000 MB. The default is 500 MB.

Performance Monitoring data / Free space alarm limit (MB)

When the free space falls below this limit, an alarm is sent. The default is 50 MB.

The alarm limit must be below the maximum size.

Performance Monitoring data / Free space cancel limit (MB)

When the free space exceeds this limit (after an alarm has been sent), an alarm
cancellation is sent. The default is 200 MB.
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The cancel limit must be between the max. size and the alarm limit.

In NMS/10 MF and PDH Polling 1 MB is 1 million bytes.

Performance Monitoring data / Full action

The action to take when the maximum size is reached can be discard old, discard
new or halt. The default is discard old.

Discard old means that new PM data is added to and the oldest PM data is
removed from the storage.

Discard new means that new PM data is not added to the storage.

Halt means that collection of PM data is halted until there is more space in the
storage.

OK

Closes the Performance Settings dialog box.

This button is disabled if any of the fields is empty.

Cancel

Closes the Performance Settings dialog box and discards changes.

Help

Displays help about the Performance Settings dialog box.

6.44 PM Data Collection Times dialog box

This dialog box allows you to manage PM data collection scheduling. Usually,
PM data is collected continuously and the collection is started as soon as possible.
However, the PM data collection uses the same resources on the management
network as e.g. FM, and it would be sensible to be able collect the PM data only
at certain times. The scheduled PM data collection enables this.
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Figure 85. PM Data Collection Times dialog box

Scheduling type

Selects the type of PM data collection scheduling.

Scheduling type / Delay start of the first PM data collection; then collect
continuously

The start of the first PM data collection is delayed. After that, PM data is collected
continuously as defined by the period. Start time is defined in the Start group
box.

If this option is selected, the Stop group box and all the controls inside it are
disabled.

Scheduling type / PM data collection only on defined times

PM data is collected only at defined times. Start and stop times are defined in the
Start and Stop group boxes.

This is the default selection.

Start

The starting day and time for the scheduling.

If the start day/time and stop day/time are on the same day, the start day/time must
occur before the the stop day/time.
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The PM data collection time ’start day/time - stop day/time’ (calculation takes
care the transition from Sunday to Monday, if necessary) must be higher than the
period.

Start / “day”

The starting day for the scheduling can be Any Day, Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday, or Sunday.

If the Delay start of the first PM data collection; then collect continuously is
selected, ’Any day’ means that the continuous PM data collection is started when
the start time next time occurres. Otherwise, it means that the PM collection is
started every day at the defined time. If the start day is ’Any day’, also the stop
day must be ’Any day’.

The default is Any Day.

Start / “time”

Start time for the scheduling can be 00:00:00...23:59:59.

The default value is 00:00:00.

The meaning of the and time is boxes from left to right: hours (0...23), minutes
(0...59), seconds (0...59).

The content of the box is set to empty if there is an illegal value.

Start time is in the NMS/10 MF computer's local time.

Stop

The stopping day and time for the scheduling.

If the stop day/time and start day/time are in the same day, the stop day/time must
be higher than the start day/time.

The PM data collection time ’start day/time - stop day/time’ (calculation takes
care the transition from Sunday to Monday, if necessary) must be higher than the
period.

This group box and all the controls inside it are disabled if Delay start of the first
PM data collection; then collect continuously is selected.

Stop / “day”
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The stopping day for the scheduling can be Any Day, Monday, Tuesday,
Wednesday, Thursday, Friday, Saturday, and Sunday.

’Any Day’ means that the PM data collection is stopped every day at a defined
time. If the stopping day is ’Any Day’, also the starting day must be ’Any Day’.

The default is Any Day.

Stop / “time”

Stop time for the scheduling can be 00:00:00...23:59:59.

The default value is 00:00:00.

The meaning of the and time is boxes from left to right: hours (0...23), minutes
(0...59), seconds (0...59).

The content of the box is set to empty if there is an illegal value.

Stop time is in the NMS/10 MF computer's local time.

OK

Closes the dialog box.

All values are validated and if there are errors, MF Manager displays an error
message. The dialog box is not closed.

Cancel

Closes the dialog box and discards changes.

Help

Displays help for the dialog box.

6.45 Print Selection dialog box

This dialog box allows you to select what information is included in the
configuration report. The configuration report format is described in Appendix C,
’Configuration report format’.

By default, all check boxes in this dialog box are cleared.
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Figure 86. Print Selection dialog box

PDH Polling general

PDH Polling general information is to be printed: FE name format, global filter
and alarm classification, limits, stations, device types, equipment ID and a
comment about the PDH Polling.

PM data storage settings

Performance monitoring data settings are to be printed: limits and full action.

This check box is disabled if the configuration type is PDH Polling C1.0.

Hardware information

PDH Polling hardware information is to be printed: number of Polling Units, I/O
addresses, interrupts and type of Q1 Interface units.

PDH Manager Interfaces
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Information about all PDH Manager interfaces is to be printed.

OS Interfaces

Information about all OS interfaces is to be printed.

This check box is disabled if the configuration type is PDH Polling C1.0 or PDH
Polling C2.0.

Printer Spoolers

Information about all printer spoolers is to be printed.

This check box is disabled if the configuration type is PDH Polling C1.0 or PDH
Polling C2.0.

SNMP Interface

Information about the SNMP Interface is to be printed.

This check box is disabled if the configuration type is PDH Polling C1.0, PDH
Polling C2.0, or NMS/10 MF C1.0.

Network Test Interface

Information about the Network Test Interface is to be printed.

This check box is disabled if the configuration type is PDH Polling C1.0, PDH
Polling C2.0, or NMS/10 MF C1.0.

Buses

Information about selected buses is to be printed. You can select the buses in the
list box beside this check box.

If Buses is not checked, all the check boxes under it are disabled.

General information

General information about selected buses is to be printed: port parameters, polling
parameters, list of fault polling (ND and E generation), auto-discovery, PM,
suspended addresses, and suspension information.

This check box is disabled if the Buses check box is not selected or only bus 254
is selected.

Addresses not in fault polling

Addresses that are in the configuration but not in fault polling on the selected
buses are to be printed.
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This check box is disabled if the Buses check box is not selected or only bus 254
is selected.

Free addresses

Free addresses on the selected buses are to be printed.

This check box is disabled if the Buses check box is not selected.

Detailed address information

Also detailed address information about selected buses is to be printed.

This check box is disabled if the Buses check box is not selected.

Detailed PM address information

Detailed performance monitoring address information is to be printed.

This check box is disabled if the Buses check box is not selected or only bus 254
is selected.

“bus list box”

A list of available bus numbers (0...240 and 254) that are sorted in ascending
order by the bus number. You can select multiple buses.

This list box is disabled if the Buses check box is not checked.

Filter and alarm classification definitions

Select if the filter and alarm classification definitions are printed.

This group box and all the controls inside it are disabled if PDH Polling general,
PDH Manager Interfaces, OS Interfaces, Printer Spoolers, and SNMP
Interface check boxes are all cleared.

Filter and alarm classification definitions / Yes

Print filter and alarm classification definitions. The default value is cleared.

If PDH Polling general is selected, prints the global filter and alarm
classification definitions. The filter definition is printed even if it is not active.

If PDH Manager Interfaces, OS Interfaces, Printer Spoolers, or SNMP
Interface is selected, prints the corresponding filter and alarm classification
definitions. The filter definition is printed even if it is not active.

Print

Closes the Print Selection dialog box and starts printing.
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This button is disabled if nothing is checked.

Cancel

Closes the Print Selection dialog box and discards all selections. Cancels the
operation that called this dialog box.

Help

Displays help about the Print Selection dialog box.

6.46 Printer Spooler x dialog box

This dialog box allows you to change the configuration of the selected printer
spooler.

This dialog box contains the following tabs:

• General

• Printer

MF Manager C2.0 had a FE Name tab. It is not used any more. Creation of unique
FE names is deselected by default.

When changing from one tab to another, all values are validated. If there are
errors, an error message is displayed. The tab is not changed.

Buttons common to all tabs

OK

Closes the Printer Spooler x dialog box. All values are validated and if there are
errors, an error message is displayed and the operation is cancelled.

Cancel

Closes the Printer Spooler x dialog box and discards all changes.

Help

Displays help about the Printer Spooler x dialog box.
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General tab

You can modify general parameters for the selected printer spooler.

Figure 87. General tab

Filter / Name

Name of the filter. All filters in the current configuration are in the list. There is
no default selection. System-defined filters are not displayed.

If the filter name is not defined, no filter is used in this printer spooler.

If the interface has no filter and there is an active global filter, it defines which
alarms are reported through the OS Interface. However, the global filter is not
effective with the system-defined bus 254 alarms; thus they all are reported.

Filter / Active
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If the Active check box is selected, the filter will also be in use. The default is
selected.

This check box has no effect if the filter name is not defined.

Filter / Browse

Opens the Filters and Alarm Classifications dialog box where you can select or
create the filter. Only the Filters tab is active.

Alarm classification / Name

The name of the alarm classification. All alarm classifications found in the
current configuration are in the list. There is no default selection. System-defined
alarm classifications are not displayed in the list.

If the alarm classification name is not defined, no alarm classification is used in
this printer spooler.

If the interface has no alarm classification, there can be a global alarm
classification, which defines the alarm severities used in the OS Interface.
However, the global alarm classification is not effective with the system-defined
bus 254 alarms; thus they all have their default values.

Alarm classification / Browse

Opens the Filters and Alarm Classifications dialog box where you can select or
create the alarm classification. Only the Alarm Classifications tab is active.

Alarm buffer / Size

The alarm buffer size can be 100...10 000. The default is 1000.

Alarm buffer / Free space alarm limit

When the free space in alarms on the alarm buffer decreases under this limit, an
alarm is sent. The default is 30.

The alarm limit must be smaller than the alarm buffer size.

Alarm buffer / Free space cancel limit

When the free space in alarms on the alarm buffer increases over this limit (after
an alarm is sent), a cancellation is sent. The default is 60.

The cancel limit must be smaller than the alarm buffer size and greater than the
alarm limit.
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Alarm buffer / Full action

The action to be carried out when the alarm buffer is full can be discard old or
discard new. The default is discard old.

Discard old means that the new alarm is added to the alarm buffer and the oldest
alarm is removed from there.

Before the alarm buffer is full, an “Alarm limit exceeded” alarm is added to it. As
the alarm buffer eventually becomes full, a “Buffer overflow” alarm is added to
it. However, if the alarm buffer remains full (alarms are not read), these alarms
are overwritten and thus lost.

Discard new means that the new alarm is not added to the alarm buffer.

Alarms and alarm cancellations are sent to every interface (PDH Manager
Interface, OS Interface, Printer Spooler and SNMP Interface).

Printer tab

You can modify printing parameters in this tab.
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Figure 88. Printer tab

Name

The name of the printer in the Windows NT network (the length can be 1...128
characters). The default is an empty selection.

The format of the printer name is ’name’ or ’\\computer\name’,

where ’computer’ is the name of the computer or the printer server where the
printer is connected and can be missing if the printer is connected locally; ’name’
is the name the printer has in the computer or printer server.

Every Printer Spooler must have a unique name.

Browse...

Selects the printer from shared printers found on the Windows NT network.
Opens the Select Printer dialog box.
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When you select a printer, its name is updated to the Name edit box.

A printer that is connected directly to the computer where the NMS/10 MF is
running and that is not shared to the network does not appear in the Select Printer
dialog box.

Job max. size

The maximum alarm count for one print job can be 1...10 000. A sensible value
depends on the printer and the value should be the same as the number of alarms
that fit on one page (e.g. for A4 paper 12...13).

The print job is executed when the alarm count reaches the maximum size. The
default is 100.

Job time-out

The maximum time elapsed since the first alarm was received for printing can be
0...86400 seconds. After time-out, alarm(s) are printed (even if there is only one
alarm). The default is 600 seconds.

6.47 Save As dialog box

This dialog box is described in Section 6.24, ’Connect dialog box’.

6.48 Select Printer dialog box

This dialog box allows you to select a printer for the printer spooler.
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Figure 89. Select Printer dialog box

Printer

The selected printer from the printers found in the network. You can also type the
printer name in this edit box.

The default is an empty selection if there was not already a printer selected before
opening this dialog box.

Comment

If there is a comment for the selected printer, you can see it here. The Comment
edit box is read-only.

Printers in network

Displays all the printers found in the network in tree format. When you select a
printer, it's name and comment are displayed in the Printer and Comment fields.

Printers connected directly to a workstation and not shared to the network, are not
shown in this list.
222 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Reference
Note

OK

Closes the Select Printer dialog box.

This button is disabled if the Printer edit box is empty.

Cancel

Closes the Select Printer dialog box and discards the selection.

Help

Displays help about the Select Printer dialog box.

6.49 Set NT Time dialog box

This dialog box allows you to set the Windows NT time of NMS/10 MF.

If you still have the 30-day trial licence and change the time, the trial licence may
be lost.
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Figure 90. Set NT Time dialog box

Current local time

The local Windows NT date, time and time zone are displayed continuously in
this group box. Also, use of daylight saving time is displayed.

Local time is the time of the computer on which MF Manager is running. That
computer can be the same on which NMS/10 MF or PDH Polling is running; in
this case Current local time and Current target time are identical.

Current local time / Set Local Time...

Opens the Windows NT system Date/Time dialog box where you can set the
local Windows NT time.

The Date/Time dialog box is displayed in Figure 91.
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Figure 91. Windows NT 4.0 system Date/Time Properties dialog box

Current target time

The target NMS/10 MF date, time and time zone are displayed continuously in
this group box. Also, use of daylight saving time is displayed.

Target time is the time of the computer on which NMS/10 MF or PDH Polling is
running. That computer can be the same on which MF Manager is running; in this
case Current target time and Current local time are identical.

Current target time / Get Target Time

Gets the current date, time and time zone from the target NMS/10 MF and shows
it continuously.

New target time

You can select a time zone for the NMS/10 MF. The default is the same as in the
Current target time group box.
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Note

You can select a new time zone from the drop-down list box and daylight saving
time by checking the check box.

You can use the Adjust time in send by (hh:mm) check box and the time
controls beside it to adjust the time to be sent to the remote NMS/10 MF. This is
only necessary when you wish to set a time that is not correct in the selected time
zone. When you change the time by using these time controls, the time to be sent
is displayed below New target time.

After changing the time zone, restart the NMS/10 MF by System command →
Reboot NT.

Send

Sends the date, time and time zone in the New target time group box to the
remote NMS/10 MF and closes the Set NT Time dialog box.

This button is disabled if the user security level is lower than NMS/10 Network
Administrator.

Cancel

Closes the Set NT Time dialog box and discards changes.

Help

Displays help about the Set NT Time dialog box.

6.50 SNMP Interface dialog box

This dialog box allows you to manage the common settings of the SNMP
Interface.

The SNMP Interface dialog box is used for configuring filters and alarm
classifications. The agent configuration tool is to be used for configuring SNMP
settings.
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Figure 92. SNMP Interface dialog box

Filter

Filter parameters for the SNMP interface.

Filter / Name

The name of the filter. All filters found in the current configuration are in the list.
There is no default selection. System-defined filters are not displayed in the list.

If the filter name is not defined, no filter is used in the SNMP interface.

If the interface has no filter and there is an active global filter, it defines which
alarms are reported through the OS Interface. However, the global filter is not
effective with the system-defined bus 254 alarms; thus they all are reported.

This filter is used in all trap destinations.

Filter / Active

If this option is selected, the filter will also be in use. The default is cleared. This
check box has no effect if the filter name is not defined.

Filter / Browse...

Opens the Filters and Alarm Classifications dialog box where you can select or
create the filter. Only the Filters tab is active. The Filter box is updated.
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Alarm classification

Alarm classification parameters for the SNMP Interface.

Alarm classification / Name

The name of the alarm classification. All alarm classifications found in the
current configuration are in the list. There is no default selection. System-defined
alarm classifications are not displayed in the list.

If the alarm classification name is not defined, no alarm classification is used in
the SNMP interface.

If the interface has no alarm classification, there can be a global alarm
classification, which defines the alarm severities used in the OS Interface.
However, the global alarm classification is not effective with the system-defined
bus 254 alarms; thus they all have their default values.

This alarm classification is used in all trap destinations.

Alarm classification / Browse...

Opens the Filters and Alarm Classifications dialog box where you can select or
create the alarm classification. Only the Alarm Classifications tab is active. The
Alarm classification box is updated.

OK

Closes the dialog box. All values are validated and if there are errors, MF
Manager displays an error message. The dialog box is not closed.

Cancel

Closes the dialog box and discards changes.

Help

Displays help for the dialog box.
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6.51 Subset Definition dialog box

This dialog box allows you to define a subset of the FEs that are shown in the
Addresses (SUBSET) dialog box.

If the FE fulfils any of the selections, it is shown.

Figure 93. Subset Definition dialog box

Station(s)

Show FEs that are in the selected station(s). The default is cleared.

If this option is cleared, the list beside it is disabled.

“station list view”

A list of stations defined to the current configuration.
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By default, the lines are sorted in ascending order by station number. You can use
the header to sort the lines in different ways. Clicking Name in the header sorts
the lines in ascending order by station name. Secondary sorting rule is always
station number.

This list is disabled if Station(s) is cleared.

Device type(s)

Shows FEs that are of the selected device type. The default is cleared.

If this option is cleared, the list beside it is disabled.

“device type list view”

A list of device types defined to the current configuration.

By default, the lines are sorted in ascending order by device type number. You
can use the header to sort the lines in different ways. Clicking Name in the header
sorts the lines in ascending order by device type name. Secondary sorting rule is
always device type number.

This list is disabled if Device type(s) is cleared.

Substring

Shows FEs that have the defined substring in the FE name, station name, or
device type name.

If this option is cleared, the edit box beside it as well as the in FE name, in station
name, and in device type name check boxes are disabled.

“substring edit box”

A substring can be 1...32 characters long. It is interpreted as is; there are no
wildcard characters. The default is empty.

A useful length for the substring depends on where it is searched. The maximum
length for FE name is 32 characters, for station name 12 characters, and for device
type name 16 characters.

Substring / in FE name

Shows FEs that have the substring in the FE name. The default is cleared.

Substring / in station name

Shows FEs that have the substring in the station name. The default is cleared.

Substring / in device type name
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Shows FEs that have the substring in the device type name. The default value is
cleared.

Generation(s)

Shows FEs (addresses) that are of the selected generation. The default is cleared.
If this option is cleared, the box beside it is disabled.

This option is disabled if the configuration type is PDH Polling C1.0, PDH
Polling C2.0, or NMS/10 MF C1.0.

“generation combo box”

Any combination can be selected. However, the selections that do nothing are
omitted. The default is an empty selection.

This box is disabled if:

• the configuration type is PDH Polling C1.0, PDH Polling C2.0, or NMS/
10 MF C1.0

• The Generation(s) check box is cleared.

Status

Shows FEs (addresses) that have the selected status(es). Status is the same that
you see in the Status column in the Addresses and Addresses (SUBSET) dialog
boxes. The default is cleared.

If this option is deselected, the box beside it is disabled.

“status combo box”

Any combination can be selected. However, selections that do nothing are
omitted. The default is an empty selection.

This box is disabled if Status is cleared.

OK

Closes the dialog box. The content of the list in the Addresses (SUBSET) dialog
box is updated according to the definition. If all check boxes are cleared, all FEs
are shown in the Addresses dialog box. All values are validated and if there are
errors, MF Manager displays an error message. The dialog box is not closed.

This button is disabled if:

• Stations(s) check box is selected, but no stations are selected

• Device type(s) check box is selected, but none of the device types in the
list is selected
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• Substring check box is selected, but the edit box is empty, or none of the
check boxes in FE name, in station name, and in device type name is
selected

• Generation(s) check box is selected, but the selection is empty

• Status check box is selected, but the selection is empty.

Cancel

Closes the dialog box and discards changes.

Reset

Resets all selections.

Help

Displays help for the dialog box.

6.52 System Command dialog box

This dialog box allows you to send a command to NMS/10 MF. The system
command is a command sent to service process(es) running on NMS/10 MF or
PDH Polling, e.g. to stop a service process or restart Windows NT.

Figure 94. System Command dialog box

Status
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Sends a command to get the status of PDH Polling, OS Interface, PM Poller,
SNMP Interface, or Network Test Server depending on the selection(s) in the
Target group box.

Start

Sends a command to start PDH Polling, OS Interface, PM Poller, SNMP
Interface, or Network Test Server depending on the selection(s) in the Target
group box.

This option is disabled if the user security level is lower than NMS/10 Network
Administrator, or there already is a connection.

Stop

Sends a command to stop PDH Polling, OS Interface, PM Poller, SNMP
Interface, or Network Test Server depending on the selection(s) in the Target
group box.

This option is disabled if the user security level is lower than NMS/10 Network
Administrator, or there already is a connection.

Restart

Sends a command to restart PDH Polling, OS Interface, PM Poller, SNMP
Interface, or Network Test Server depending on the selection(s) in the Target
group box.

This option is disabled if the user security level is lower than NMS/10 Network
Administrator, or there already is a connection.

Target

This group box and all controls inside it are disabled if the Restart remote NT
option is selected, or the Current users at selected system option is selected.

Target / PDH Polling

Sends Status, Start, Stop and Restart commands to PDH Polling. If selected
with Stop or Restart, all other targets are also selected. If selected with Status,
the statuses of the Watchdog update service, Nokia Polling Card Device Driver
and Watchdog devices are also displayed.

This option covers all the necessary processes that handle the buses and PDH
Manager interfaces.

This option is disabled if:

• the Restart remote NT option button is selected

• the Current users at selected system option is selected.
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Target / OS Interface

Sends Status, Start, Stop and Restart commands to OS Interface. If selected
with Start, also Target / PDH Polling is selected.

This option covers the process that handles the OS Interfaces and Printer
Spoolers.

This option is disabled if:

• the configuration type is PDH Polling C1.0 or PDH Polling C2.0

• the Restart remote NT option button is selected

• the Current users at selected system option is selected.

Target / PM Poller

Sends Status, Start, Stop and Restart commands to PM Poller. If selected with
Start, also Target / PDH Polling is selected.

This option covers the process that handles the PM data collection.

This option is disabled if:

• the configuration type is PDH Polling C1.0

• the Restart remote NT option button is selected

• the Current users at selected system option is selected.

Target / SNMP Interface

Sends Status, Start, Stop and Restart commands to SNMP Interface. If selected
with Start, also Target / PDH Polling is selected.

This option covers the process that handles the SNMP.

This option is disabled if:

• the configuration type is PDH Polling C1.0, PDH Polling C2.0, or NMS/
10 MF C1.0

• the Restart remote NT option button is selected

• the Current users at selected system option is selected.

Target / Network Test Server

Sends Status, Start, Stop and Restart commands to Network Test server. If
selected with Start, also Target / PDH Polling is selected.
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This option covers the process that handles the network tests.

This option is disabled if:

• the configuration type is PDH Polling C1.0, PDH Polling C2.0, or NMS/
10 MF C1.0

• the Restart remote NT option button is selected

• the Current users at selected system option is selected.

Restart remote NT

Sends a command to restart the remote Windows NT. A message “System is
going down in 30 seconds” is displayed on the remote NT. NMS/10 MF is
stopped on the remote computer before the NT will be restarted.

This option is disabled if the user security level is lower than NMS/10 Network
Administrator, or the remote NT is the same NT where MF Manager runs, or
connection to the NMS/10 MF is open.

Current users at selected system

Displays users who are connected to the target system. Your own connection
information is displayed when the current configuration is an on-line
configuration.

This option is disabled if the configuration type is PDH Polling C1.0, PDH
Polling C2.0, or NMS/10 MF C1.0.

Send

Sends the selected command to the selected target(s) and closes the System
Command dialog box.

This button is disabled if the Restart remote NT and Current users at selected
system options are not selected, and nothing is selected in the Target group box.

Cancel

Closes the System Command dialog box and discards the selections. Cancels the
operation that called this dialog box.

Help

Displays help about the System Command dialog box.
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Appendix A. Connecting Nokia Managers to NMS/10 MF or PDH Polling
workstation

This appendix gives you some important guidelines for setting up the system and
your Windows NT network and its user databases. Also, connections with Nokia
Managers from outside the workstation or domain are discussed.

For more information about Windows NT and NMS/10 security, refer to NMS/10
System Release User Manual.

A.1 General

Before starting to install the network management system with Windows NT
Workstations, NMS/10, NMS/10 MF and separate node managers, alarm
managers or agents, we recommend you to prepare a detailed installation plan
considering also network security.

A.2 MF Manager and NMS/10 MF installation

MF Manager installation program creates the NMS/10 security groups (see
section 5.1, ’Security’ and the NMS/10 System Release User Manual). They are
created onto the local computer. The NMS/10 MF C2.0 installation program also
creates the NMS/10 security groups onto the computer it is installed in. Other
configuration types (NMS/10 MF C1.0, PDH Polling C2.0, and PDH Polling
C1.0) do not use the NMS/10 security groups.

NMS/10 MF and PDH Polling system installation programs create a
NOKIAMGR share. It points to the root directory under which the NMS/10 MF
or PDH Polling system is installed. MF Manager needs adequate rights to access
the NOKIAMGR share (see sectionA.3, ’MF Manager connections’).

The number of concurrent users in the NOKIAMGR share can be limited and by
default it is limited to two users. The share interprets one computer as one user,
i.e. there can be multiple connections from one computer (although this is highly
discouraged).

NMS/10 MF and PDH Polling system installation programs also create a
Windows NT user group called Nokia NMS/10 MF Command Interface onto the
computer where it is installed. If the configuration type is not NMS/10 MF C2.0,
the user of an interface (PDH Manager Interface, etc.) must belong to that user
group. Otherwise, the user of an interface must belong to the user group that is
defined in the configuration for that interface. In any case, the user group must be
a local one and it cannot be any of the Windows NT's standard user groups.
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A.3 MF Manager connections

When connecting to an NMS/10 MF workstation with the MF Manager, you must
have adequate user rights on that workstation.

MF Manager uses the computer name of the system when it connects to it. It
mounts a share called NOKIAMGR (created by the NMS/10 MF and PDH
Polling system installation programs). The username and password for the MF
Manager user must be the same both on the MF Manager computer and on the
computer which the system is running. The MF Manager user must be one of the
allowed users of the NOKIAMGR share, or belong to a user group that is allowed
to access the share. The type of access in the share permissions for the user or user
group must be at least ’Change’. The number of computers that can be
simultaneously connected to the share is two by default. That can be changed if
more connections are required.

MF Manager uses the NMS/10 security groups to limit the functionality. They
define your security level (see section 5.1, ’Security’). When MF Manager
interacts with an NMS/10 MF C2.0 system, it checks your security level on that
computer. If it is lower than on the local computer, it is effective as long as there
is a connection. It is possible that you are not allowed to work with the NMS/10
MF C2.0 system, e.g. because of too low a security level, or because you do not
belong to any of the (security) user groups.

When working on other systems (NMS/10 MF C1.0, PDH Polling C2.0, or PDH
Polling C1.0), the remote security level is not checked, because these systems do
not use the (security) user groups.

If you want to start, stop or restart the NMS/10 MF or part of it or restart the
computer where the system is running through MF Manager's System Command
dialog box, you must have the security level NMS/10 Network Admin on that
computer.

Multiple MF Managers can be connected to one system (although it is not
recommended), but they do not know about each other's actions. If the system is
NMS/10 MF C2.0, you are displayed information about the other connected users
and you can at any time ask who are currently connected. Otherwise, the MF
Managers after the first connected one are informed that there is already someone
connected (first one will never know that there is also others). If multiple MF
Managers send configuration changes, the end result might be unpredictable.
Usually, the latest changes are simply brought into use, but sometimes it might
lead to data corruption.
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A.4 NMS/10 MF and PDH Polling system connections

PDH Alarm Manager and node manager users use the PDH Manager Interface for
communication with the NMS/10 MF or PDH Polling system. If the configuration
type is ’NMS/10 MF C2.0’, multiple computers (users) can connect to one PDH
Manager Interface. Otherwise, each computer (user) needs a separate PDH
Manager Interface.

NMS/100, NMS/1000, etc. use the OS Interface for communication with the
NMS/10 MF. OS Interface has limits for how many concurrent users are allowed
per OS Interface, see Ports tab in the OS Interface x dialog box.

Network Test application's users use the Network Test Interface for
communication with the ’NMS/10 MF C2.0’ system. Network Test Interface has
a limit for how many concurrent users is allowed, see Network Test Interface
dialog box.

The Network Test application is a separate application used to test the Q1
network. It is installed at the same time as the MF Manager.

All connections are authenticated. Before a connection can be established, a valid
Windows NT username and password must be provided. The user is validated
from the domain that is defined in the interface's settings (that domain can be the
computer where the system is running). If the configuration type is NMS/10 MF
C2.0, the user must belong to the user group defined in the interface's settings. In
other configuration types, the user must belong to the Nokia NMS/10 MF
Command Interface user group. In any case the user group must be a local one on
the computer where the NMS/10 MF or PDH Polling system is running and it
cannot be any of the Windows NT's standard user groups.

A.5 PM data collection result files

The NMS/10 MF C2.0 installation program creates a virtual FTP directory
MF\PMDATA that points to the place where the PM data collection result files
are. You should connect to the NMS/10 MF C2.0 computer using an FTP
program and change to the directory MF\PMDATA. All the PM data collection
result files are there and it depends on your NMS/10 security group if you can
only read the files or also remove them. If the configuration type is not NMS/10
MF C2.0, the PM data collection result files can be read from the directory
C:\NOKIAMGR\NMS10MF\PMP\LOGS. Current day's PM data collection
result file is always locked and it cannot be removed (however, it can be read).
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Appendix B.  Directory hierarchy

B.1 MF Manager directory hierarchy

MF Manager uses its own directory hierarchy when it handles configurations. It
copies all relevant files to a directory named using the system's computer name.
Files are copied even when the system and MF Manager are running on a same
computer.

Licencing system uses one visible file MFM.LIC and creates four hidden files
(MFM.41S, MFM.ENT, MFM.KEY, and MFM.RST). They are in the MF
Manager root directory MFM. Do not remove, rename, or move them.

The software licence is based on the machine and disk configuration and will be
lost if a disk is replaced or reformatted. If you have a disk failure, you will need
to contact Nokia Customer Services to get a new Site Key for your restored
software.

Depending on the configuration type, not all files are present. All files are not
described here.

The directory hierarchy used by MF Manager is the following:

The NOKIAMGR environment variable indicates the location of the root
directory for all Nokia managers. Usually it is C:\NOKIAMGR. All MF Manager
related directories are located under this directory.

MFM the root directory for MF Manager files.

MFM\NDT254.INI ’internal network elements’ on bus 254 for a new configuration

MFM\POLLCMD.TXT definitions of available PM jobs for a new configuration

MFM\DEVTYPES.TXT default device types for a new configuration

MFM\*.FLT system-defined filter files
240 (274) © Nokia Networks Oy DN00276927
Nokia Proprietary and Confidential Issue 1-0en



Directory hierarchy
The NMS/10 MF name used in the hierarchy above is the NMS/10 MF computer
name. The length of the name can be 15 characters.

An off-line configuration can have any name as long as the name is a valid
computer name (existing or non-existing). However, an on-line configuration
name is always the same as the computer name of NMS/10 MF.

Filter and alarm classification files in the MF Manager root directory (MFM) are
shown in Filters and Alarm Classifications dialog box as system-defined filters
and alarm classifications; they have an S in the Sys column in the list view. Other
filters and alarm classifications shown in the list view are from the corresponding
configuration (they are located in the directory that has the same name as the
configuration under MF Manager root directory). There can be a user-defined and
system-defined filter or alarm classification with a same name (as they are located
in different directories). The user-defined filter or alarm classification is the one
that is used in the configuration.

MFM\*.CLF system-defined alarm classification files.

LONDON directory for a configuration named LONDON

LONDON\*.INI configuration files

LONDON\*.OUT bus suspension parameters; present if defined but not yet sent

LONDON\*.FLT filter files

LONDON\*.CLF alarm classification files

LONDON\AUTO.LOG auto-discovery result log file; present if new network elements
found

LONDON\SCAN.LOG network scan result log file; present ifnetwork elements found

LONDON\POLLCMD.TXT definitions for the available PM jobs

LONDON\POLLSCR.TXT schedule for running the selected PM jobs

PARIS directory for a configuration named PARIS

PARIS\*.INI configuration files

PARIS\*.OUT bus suspension parameters; present if defined but not yet sent

PARIS\*.FLT filter files

PARIS\*.CLF alarm classification files

PARIS\AUTO.LOG auto-discovery result log file; present if new network elements
found

PARIS\SCAN.LOG network scan result log file; present if network elements found

PARIS\POLLCMD.TXT definitions for the available PM jobs

PARIS\POLLSCR.TXT schedule for running the selected PM jobs
DN00276927 © Nokia Networks Oy 241 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
The file NDT254.INI in the MF Manager root directory is copied into the new
configuration. It contains information needed when reporting about internal
faults. This file is directly suitable only for the NMS/10 MF C2.0 configuration
as it contains the NE generation info and an unique ID for the SNMP. MF
Manager takes care of removing the extra information when it is not needed.

The file DEVTYPES.TXT in the MF Manager root directory contains the default
device types added to a new configuration. Each line contains one device type
name. The numbering starts from 3. Empty lines and comment lines starting with
a semicolon (;) are ignored. If this file is missing, MF Manager uses its own set
of default device types.

The file POLLCMD.TXT in the MF Manager root directory is copied into the
new configuration (except if the configuration type is PDH Polling C1.0). It
contains definitions for PM jobs that can be performed on network elements
periodically.

The file POLLSCR.TXT contains information about the network elements and
periods. It is located in tha directory that has the same name as the configuration
under the MF Manager root directory.

The file AUTO.LOG contains the results of auto-discovery and the file
SCAN.LOG contains the results of network scan.

Files *.OUT are located in the MF Manager directory hierarchy only temporarily.
They are only created if there is something suspended on a bus. After the file has
been copied to the target system, it is removed from this directory hierarchy.

Files *.INI are the actual configuration files. When MF Manager saves the
configuration, it first renames all files with extension .BAK.

The file NMS100.CFG contains the configuration for the NMS/100 heartbeat and
equipment type text. If the configuration type is NMS/10 MF C1.0 and this file
exists, MF Manager handles it. This file has an effect only with the NMS/10 MF
C1.0 version C. Older versions of NMS/10 MF C1.0 do not have this file. If you
change the configuration type from NMS/10 MF C1.0 to NMS/10 MF C2.0 and
this file exists, MF Manager merges its contents to the NMS10MF.INI file and
removes NMS100.CFG. MF Manager never creates this file if it does not already
exist. See the NMS/10 MF C1.0 version C README.TXT file for more
information on this file.
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B.2 NMS/10 MF and PDH Polling directory hierarchy

Files are the same as in the MF Manager directory hierarchy, but they are
scattered in multiple directories.

Licencing system uses one visible file NMS10MF.LIC and creates four hidden
files (NMS10.41S, NMS10.ENT, NMS10.KEY, and NMS10.RST). They are
located in the NMS/10 MF root directory C:\NOKIAMGR\NMS10MF. Do not
remove, rename, or move them.

The software licence is based on the machine and disk configuration and will be
lost if a disk is replaced or reformatted. If you have a disk failure, you will need
to contact Nokia Customer Services to get a new Site Key for your restored
software.

Depending on the configuration type, not all files are present.

The directory hierarchy used by the NMS/10 MF and PDH Polling is the
following (only the directories that the MF Manager uses are listed):

The NOKIAMGR environment variable indicates the location of the root
directory for all Nokia managers. Usually it is C:\NOKIAMGR. All NMS/10 MF
and PDH Polling related directories are located under this directory.

NMS10MF the root directory for NMS/10 MF and PDH Polling files.

CLASSIFY\*.CLF alarm classification files.

FILTER\*.FLT filter files.

NODECONF\NDTX.INI network elements on bus X

NODECONF\NDT254.INI ’internal network element’ on bus 254

NODECONF\TMC.INI TMC type information, e.g. stations

NWTEST\CONFIG\NWTEST.INI Network Test Interface configuration.

OSIF\CONFIG\NMS10MF.INI OS Interface and Printer Spooler configuration
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The file SCAN.NET is located in the NMS/10 MF directory only temporarily. It
contains information on the buses and addresses to scan. After the Network Scan
is done, it is removed from this directory.

Files YYYYMMDD.TXT and YYMMDD.TXT are the PM result files created
one per day (YYYY or YY is the year in decimal, MM is the month in decimal,
and DD is the day in decimal; leading zeros are added if necessary.). The
configuration type NMS/10 MF C2.0 uses 4 digits for a year, other configuration
types use 2 digits.

If the configuration type is NMS/10 MF C2.0, these files can be retrieved by FTP
from a virtual directory called \MF\PMDATA. Otherwise they are located in the
C:\NOKIAMGR\NMS10MF\PMP\LOGS directory.

The current day's PM result file is always locked and it cannot be removed
(however, it can be read).

OSIF\CONFIG\NMS100.CFG Heartbeat configuration for NMS/10 MF C1.0 version C.

PDHP\CONFIG\BUSX.INI protection, polling, and port parameters for bus X

PDHP\CONFIG\BUSX.OUT suspension parameters for bus X

PDHP\CONFIG\GENERAL.INI general information about system, e.g. global filter

PDHP\CONFIG\HARDWARE.INI hardware configuration

PDHP\CONFIG\NMSE.INI PDH Manager Interface configuration.

PDHP\LOGS\AUTO.LOG auto-discovery result log file; present if new network
elements found

PDHP\LOGS\SCAN.LOG network scan result log file; present if network elements
found

PDHP\LOGS\SCAN.NET network scan definition file; present if network scan going
on.

PMP\CONFIG\PM.INI PM data storage settings

PMP\CONFIG\POLLCMD.TXT definitions for the PM jobs

PMP\CONFIG\POLLSCR.TXT schedule for running the selected PM jobs.

PMP\LOGS\YYYYMMDD.TXT PM results (NMS/10 MF C2.0)

PMP\LOGS\YYMMDD.TXT PM results (other configuration types)

SNMPIF\CONFIG\SNMPIF.INI SNMP Interface configuration.
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Appendix C. Configuration report format

C.1 General

On the top of every page is text MF Manager C2.5, configuration name, date, time
and a continuous page number. The date format is the current Windows NT time
and long date format.

An example:

MF Manager C2.5 - pc123 28 June, 2000 13:30:25 Page 1

You can select in the Print Selection dialog box what information will be
included in the configuration report. The following sections describe what each
selection of the Print Selection dialog box contains. The sections are listed in the
same order as they are printed.

The type of the configuration is printed on top of the selected information.

An example:

Configuration type     NMS/10 MF C2.0

C.2 PDH Polling general information

General information about NMS/10 MF is shown in this section. Global alarm
classification and its definition are only printed if the configuration type is NMS/
10 MF C2.0.

PDH Polling Information

====================

FE name format               “bb.aaaa.ff device name”

Global filter name                           disturbance
Global filter active                         yes
Global alarm classification name             default

Max. number of addresses/bus                 200
Max. number of FEs/polling unit              3000
Max. number of PDH Manager Interfaces        5

Hard disk free space alarm limit             50 [ MB ]
Hard disk free space cancel limit            55 [ MB ]

Equipment ID                           1

If Yes is selected, global filter and alarm classification definitions are printed. The
global filter definition is printed even if it is not active.
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Comment of the filter
---------------------
Do not show disturbance

Definition of the filter
------------------------
Filter type is EXCLUDE
TYPE=DISTURBANCE

Comment of the alarm classification
-----------------------------------
Default alarm classification

Definition of the alarm classification
--------------------------------------
Definition of CRITICAL severity
TYPE=ALARM

Definition of MAJOR severity
<not defined>

Definition of MINOR severity
TYPE=DISTURBANCE

Definition of WARNING severity
TYPE=DISTURBANCE

Stations are printed in ascending order by station number and device types are
printed in ascending order by device type number. If station or device type
information is spread onto multiple pages, the station or device type header is
printed at the beginning of all those pages.

Station Number                             Station Name
---------------                            ------------
1                                          PDHplat
2                                          TMN
3                                          London
4                                          Manchester

Device Type Number                         Device Type Name
-------------------                        ----------------
0                                          SYSTEM
1                                          TRANSM
2                                          EXTERN
3                                          DN2
4                                          DB2
5                                          DM2
6                                          DM8
7                                          DM34
8                                          ACM2
9                                          ACL2
10                                         DF2-8
11                                         DMR
12                                         DMF
13                                         DNT128
14                                         DNT1M
15                                         DNT2M

The comment can be on multiple lines.

Comment
-------
Power line between London and Manchester
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C.3 PM data settings

Performance Monitoring Data Settings
====================================
PM data max size                   1000 [ MB ]
PM data alarm limit                100 [ MB ]
PM data cancel limit               200 [ MB ]
PM data full action                discard old

C.4 Hardware information

Hardware information is printed in ascending order by polling unit number.

The following example shows the configuration of one polling unit.

Polling Unit 1 Configuration
============================

IO Address                        220 H
Interrupt                         11
Interface unit 1 type             internal
Interface unit 2 type             internal

C.5 PDH manager interfaces

PDH manager interfaces are printed in ascending order by PDH Manager
interface number. Only the port parameters are printed if the configuration type
is NMS/10 MF C2.0. User group is only printed when the configuration type is
NMS/10 MF C2.0.

The following example shows one PDH Manager interface.

PDH Manager Interface 19
========================

Filter name                     manager2
Filter active                   yes
Alarm classification name       classify

Alarm buffer size               1000
Alarm buffer alarm limit        30
Alarm buffer cancel limit       60
Alarm buffer full action        discard old

TCP/IP port                     27500
Logon domain                    ntc
User group      Nokia NMS/10 MF Command Interface
Logon time-out                  60 [ s ]

If Yes is selected, filter and alarm classification definitions are printed. The filter
definition is printed even if it is not active. The warning severity is only printed
if the configuration type is NMS/10 MF C2.0.

Comment of the filter
---------------------
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Do not show disturbance

Definition of the filter
------------------------
Filter type is EXCLUDE
TYPE=DISTURBANCE

Comment of the alarm classification
-----------------------------------
Default alarm classification

Definition of the alarm classification
--------------------------------------
Definition of CRITICAL severity
TYPE=ALARM

Definition of MAJOR severity
<not defined>

Definition of MINOR severity
TYPE=DISTURBANCE

Definition of WARNING severity
TYPE=DISTURBANCE

C.6 OS interfaces

OS interfaces are printed in ascending order by OS interface number. The user
group is only printed if the configuration type is NMS/10 MF C2.0. Heartbeat
information and equipment type text are only printed if the configuration type is
NMS/10 MF C2.0 or NMS/10 MF C1.0 version C.

The following example shows one OS interface.

OS Interface 1
==============

Filter name                           manager2
Filter active                         no
Alarm classification name             classify3

Alarm buffer size                     1000
Alarm buffer alarm limit              30
Alarm buffer cancel limit             60
Alarm buffer full action              discard old

Command interface TCP/IP port         500
Max. connections on command interface 10
Alarm interface TCP/IP port           501
Max. connections on alarm interface   1
Logon domain                          ntc
User group        Nokia NMS/10 MF Command Interface
Logon time-out                        600 [ s ]

Heartbeat active             yes
Heartbeat interval           0 00:11 [ d hh:mm ]
Heartbeat text               MF /q/ alive /x//l/
Equipment type text          discard old
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If Yes is selected, filter and alarm classification definitions are printed. The filter
definition is printed even if it is not active. The warning severity is only printed
if the configuration type is NMS/10 MF C2.0.

Comment of the filter
---------------------
Do not show disturbance

Definition of the filter
------------------------
Filter type is EXCLUDE
TYPE=DISTURBANCE

Comment of the alarm classification
-----------------------------------
Default alarm classification

Definition of the alarm classification
--------------------------------------
Definition of CRITICAL severity
TYPE=ALARM

Definition of MAJOR severity
<not defined>

Definition of MINOR severity
TYPE=DISTURBANCE

Definition of WARNING severity
TYPE=DISTURBANCE

C.7 Printer spoolers

Printer spoolers are printed in ascending order by printer spooler number. The
following example shows one printer spooler.

Printer Spooler 1
=================

Filter name                     manager2
Filter active                   no
Alarm classification name       classify3

Alarm buffer size               1000
Alarm buffer alarm limit        30
Alarm buffer cancel limit       60
Alarm buffer full action        discard old

Printer name                 \\pc123\PRINTER1
Printer job max. size           100
Printer job time-out            600 [ s ]

If Yes is selected, filter and alarm classification definitions are printed. The filter
definition is printed even if it is not active. The warning severity is only printed
if the configuration type is NMS/10 MF C2.0.

Comment of the filter
---------------------
Do not show disturbance

Definition of the filter
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------------------------
Filter type is EXCLUDE
TYPE=DISTURBANCE

Comment of the alarm classification
-----------------------------------
Default alarm classification

Definition of the alarm classification
--------------------------------------
Definition of CRITICAL severity
TYPE=ALARM

Definition of MAJOR severity
<not defined>

Definition of MINOR severity
TYPE=DISTURBANCE

Definition of WARNING severity
TYPE=DISTURBANCE

C.8 SNMP interface

The following example shows the common parameters for the SNMP interface.

SNMP Interface
==============

Filter name                    manager2
Filter active                  no
Alarm classification name      classify3

If Yes is selected, filter and alarm classification definitions are printed. The filter
definition is printed even if it is not active.

Comment of the filter
---------------------
Do not show disturbance

Definition of the filter
------------------------
Filter type is EXCLUDE
TYPE=DISTURBANCE

Comment of the alarm classification
-----------------------------------
Default alarm classification

Definition of the alarm classification
--------------------------------------
Definition of CRITICAL severity
TYPE=ALARM

Definition of MAJOR severity
<not defined>

Definition of MINOR severity
TYPE=DISTURBANCE

Definition of WARNING severity
TYPE=DISTURBANCE
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C.9 Network Test interface

The following example shows the parameters for Network Test interface.

Network Test Interface
======================

TCP/IP port                           49900
Max. connections on TCP/IP port       1
Logon domain                          ntc
User group       Nokia NMS/10 MF Command Interface
Logon time-out                        600 [ s ]

C.10 Buses

Common information

If the bus is the system-defined bus 254, only the detailed address information and
free addresses can be printed.

Each bus starts a new page. Buses are printed in ascending order by bus number
and information can spread into multiple pages.

Bus 1
=====

General information

General information contains bus, physical port and polling parameters. Address
lists are included, but they are not detailed.

Addresses in fault polling (ND) is Addresses in fault polling if the configuration
type is NMS/10 MF C1.0, PDH Polling C2.0, or PDH Polling C1.0.

Addresses in fault polling (E), Q1 Command time-out, Packet limit, Cycle target
time, Consistency check (if time left), Lost NEs per cycle (if time left), New NEs
per cycle (if time left), and Do nothing (if time left) are printed only if the
configuration type is NMS/10 MF C2.0.

Consistency check (if time left), Lost NEs per cycle (if time left), New NEs per
cycle (if time left), and Do nothing (if time left) are printed only if Cycle target
time is greater than 0 seconds.

The following example shows one bus that is protected:

Addresses in fault polling (ND)       9, 11, 13-15
Addresses in fault polling (E)        19-25
Addresses in auto-discovery           1-200
Addresses in performance monitoring   9, 19-25
Addresses suspended                   4-5

All fault polling and auto-discovery suspended
                                      no
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All activity suspended                no

Protected bus                         yes

Polling Parameters
------------------

Connection poll retries               1
Connection loss threshold             4
Connection command retries            1

Q1 Packet time-out                    2 [ 100 ms ]
Q1 Application delay                  2 [ 100 ms ]
Q1 Empty packet delay                 2 [ 100 ms ]
Q1 Inter-packet delay                 0 [ 100 ms ]
Q1 Command time-out                   0 [ 100 ms ]
Switch bus delay                      0 [ 100 ms ]
Max. empty packets                    500
Packet limit                          1000

Clock refresh rate (E gen. elements)  60 [minutes]

Cycle target time                     60 [ s ]
Consistency check (compulsory)        1 NE
Lost NEs per cycle (compulsory)       1
New NEs per cycle (compulsory)        1
Consistency check (if time left)      50 [ % ]
Lost NEs per cycle (if time left)     30 [ % ]
New NEs per cycle (if time left)      20 [ % ]
Do nothing (if time left)             0 [ % ]

Primary Direction Port Parameters
---------------------------------
Polling unit                          1
Port                                  1A
Line speed                            9600 [ bits/s ]

Secondary Direction Port Parameters
-----------------------------------
Polling unit                          1
Port                                  3B
Line speed                            9600 [ bits/s ]

Addresses not in fault polling

Addresses that are in the current configuration on the bus, but are not in the fault
polling.

If general information is printed, the addresses that are not in fault polling will be
printed after the Addresses in fault polling (E). Otherwise they will be printed
after the common information.

Addresses not in fault polling (ND) is Addresses not in fault polling if the
configuration type is NMS/10 MF C1.0, PDH Polling C2.0, or PDH Polling C1.0.
Addresses not in fault polling (E) is printed only if the configuration type is NMS/
10 MF C2.0.

Addresses not in fault polling (ND)       1-8, 10, 12
Addresses not in fault polling (E)        35-40

Free addresses

Addresses that are not in the current configuration on the bus.
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If general information is printed, free addresses will be printed before Addresses
in auto-discovery. Otherwise they will be printed after the common information
and Addresses not in fault polling (E) (if printed).

Addresses not used                       16-4093

Detailed address information

Detailed address information is printed immediately after previously printed bus
information.

Detailed address information is printed in ascending order by address and FE
number. If the bus is the system-defined bus 254, the Gen. and Status fields are
not printed. If the bus is the system-defined bus 65535, the Status field is left
empty.

If detailed address information is spread onto multiple pages, the header is printed
at the beginning of all those pages.

Detailed PM address information

NMS/10 MF C2.0

Printed immediately after previously printed bus information in ascending order
by the address/FE combination. If there are multiple jobs on one FE, the period is
used as a secondary sorting rule (ascending order by the period). If there are
multiple start/stop times on one period, the start/stop time is used as a tertiary
sorting rule (ascending order by the start/stop time).

If the detailed PM address information is spread onto multiple pages, the PM
address header is printed at the beginning of the page.

Other configuration types

-- --------------------- ------------ ------------ ---- -----------

1

2

4

4

65535

0

0

0

1

0

01.0001.00 DM 2 AD1

01.0000.01 DMF16x2

ACM2

ACM2

01.0004.00

01.0004.01

BU01 SUPERVISION BUS

3-LONDON

3-LONDON

4-CROYDON

4-CROYDON

2-TMN

1-TRANSM

1-TRANSM

1-TRANSM

1-TRANSM

0-SYSTEM

ND

ND

E

E

F

F  S

F  S  P

F  S  P

P

Addr. FE FE Name Station Device Type Gen. Status

----- -- ------- ------------- ------------ ---------------
Addr. FE Period Start time Stop time PM Command Name

4 0 15 min Mon 00:00:00 Tue  00:00:00 ACM2_g821

4 1 24 h 03:00:00 ACM2_reset

65535 0 2 d 01:00:00 Q1_protocol_pri
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Printed immediately after previously printed bus information in ascending order
by the address. If there are multiple jobs on one address, the period is used as a
secondary sorting rule (ascending order by the period).

If the detailed PM address information is spread onto multiple pages, the PM
address header is printed at the beginning of the page.

Addr.   Period        PM Command Name
-----   -------       ----------------------------
4        15 min        ACM2_g821
4        24 h          ACM2_reset
65535    2 d 01:00:00  Q1_protocol_pri
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Appendix D. Network Test Client

This appendix gives instructions to using the Network Test Client (NWT) which
is a remote user interface to the Network Test Server used with NMS/10 MF C2.0.

This appendix covers the following topics:

• Features (section D.1)

• Getting started (section D.2)

• User interface (section D.3)

D.1 Features

NWT is used for testing a Q1 network that is connected to NMS/10 MF C2.0. It
provides a quick testing tool when commissioning the system. It is also useful in
pin-pointing connection problems and in a quick testing of troublesome network
elements (NEs).

The main functions of NWT are:

• Connect to a Network Test Server and retrieve configured buses

• Add addresses to the test

• Remove addresses from the test

• Modify test parameters

• Start test and view results

• Save test results.

D.2 Getting started

This section describes how to get started with NWT. It covers the following
topics:

• Starting the Network Test Client

• Connecting to a server

• Creating a configuration for testing
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Note

• Tuning test parameters

• Viewing test results.

To achieve most accurate results, turn off fault polling, auto discovery, and PM
polling in MF Manager before starting the Network Test Client.

D.2.1 Starting the Network Test Client

 To start NWT:

1. You can start the Network Test Client from MF Manager or from Windows
NT:

• MF Manager: Manage →  Special → Network Test...

• Windows NT:Start → Programs→ MF Manager→ Network
Test...

2. Network Test starts and the empty Configuration window is displayed. It
consists of a tree view and a list view. The tree view is on the left and the
list view on the right side of the window.

D.2.2 Connecting to a server

NWT tests NEs connected to a NMS/10 MF C2.0. Before a connection can be
established, the Network Test Interface in the NMS/10 MF must be configured
using MF Manager. Before testing or creating a testing configuration can be
started, a connection must be established between NWT and the Server.
Configured buses are retrieved when the connection has been opened.

To connect to a server:

1. Choose Manage → Connect... in the Configuration window, or click the
corresponding button in the toolbar. The NWT Connect dialog box is
displayed (Figure 95).

2. Fill in the fields:
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MF Address

An internet address for the desired connection. The address can be given as
text or numbers.

MF user name

A valid Windows NT user name on the target computer. It must belong to
a user group specified on the NMS/10 MF you are about to connect.

MF password

A valid password for the user name. Asterisks (*) are displayed instead of
the actual characters while you type in your password.

Command Port

The TCP/IP port of the Network Test Server. The command port number
must be the same as on the connected NMS/10 MF (configured with MF
Manager). The default port number is 49900.

Figure 95. NWT Connect dialog box

3. Click one of the command buttons:

Connect

Closes the dialog box and connects to the specified MF.

After establishing the connection, the buses configured on the MF are
added to the NWT Client. Suspended buses are not added, because MF
does not send anything to them.

The configuration information of the connected NMS/10 MF is displayed
in the NWT window (Figure 96).
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Cancel

Closes the dialog box.

Help

Displays the help for this dialog box.

Figure 96. NWT Client window after connecting to NMS/10 MF

D.2.3 Uploading addresses for testing

You can upload all addresses configured on NMS/10 MF for testing and select the
addresses you wish to test.
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To upload MF addresses:

1. Choose Configure → Upload MF Addresses... in the Configuration
window. The NWT Uploaded MF Addresses dialog box is displayed
(Figure 97).

Figure 97. NWT Uploaded MF Addresses dialog box

2. Fill in the fields:

Do what / Add to the current configuration

New MF addresses are added to the old configuration.

Do what / Create a new configuration

New MF addresses replace the old configuration.
DN00276927 © Nokia Networks Oy 259 (274)
Issue 1-0 en Nokia Proprietary and Confidential



MF Manager C2.5
Add Addresses / Add all

All MF addresses are added to the configuration.

Add Addresses / Add selected

Only the MF addresses selected in the list view are added to the
configuration.

Add Addresses / Bus

Selects a bus from which the addresses are added. If the whole MF
configuration is not added (and therefore bus selection is not disabled),
addresses are added only from this bus.

Add Addresses / Direction

Selects the direction to which the addresses are added. If an address already
exists, it will be tested in its old direction and the new one selected here.

This box is disabled if the current bus has only the primary direction
available (the selected direction is Primary).

Add Addresses /“ list view”

Displays MF addresses of the selected bus. You can select the addresses to
include them in the test configuration.

The list is sortable. You can sort it by clicking any of the column headers.

Add Addresses / Select all

Selects all addresses of the selected bus.

Add Addresses / Unselect all

Clears all addresses of the selected bus.

3. Click one of the command buttons:

OK

Adds MF addresses to test configuration and closes the dialog box. If an
address already exists, a new direction is added and the element type
updated.

Cancel

Closes the dialog box.

Apply
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Adds the MF addresses to the test configuration. If an address already
exists, a new direction is added and the element type updated. The check
marks are not cleared.

Help

Displays the help for this dialog box.

D.2.4 Selecting arbitrary addresses for testing

You can select arbitrary addresses for testing even though they are not configured
on the NMS/10 MF.

To select addresses for testing:

1. Choose Configure →  Add Addresses... in the Configuration window.
The NWT Add Addresses dialog box is displayed (Figure 98).

Figure 98. NWT Add Addresses dialog box

2. Select a Bus and a Direction.

3. Enter the addresses or address ranges (e.g. 5−100) in the Addresses to add
field. You can use commas if you wish to enter more items in the field.

4. Click one of the command buttons:

OK

Adds selected addresses to test configuration and closes the dialog box. If
an address already exists, a new direction is added. If the type of the
network element is not known, it is named ’Unknown’.

Cancel
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Closes the dialog box.

Apply

Adds the selected addresses to the test configuration. If an address already
exists, a new direction is added. If the type of the network element is not
known, it is named ’Unknown’.

Help

Displays the help for this dialog box.

D.2.5 Tuning test parameters

Before a test is started, some testing parameters can be specified if needed (if they
differ from the default values).

The parameters apply only to the current NWT Client. If you wish to use some
parameter in polling, use MF Manager. Also, if any other bus parameters should
be changed, use MF Manager.

To set testing parameters:

1. Choose Configure →  Parameters... in the Configuration window. The
NWT Parameters dialog box is displayed (Figure 99).
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Figure 99. NWT Parameters dialog box

2. Fill in the fields:

Number of retries

The number of times the command will be tried after the first try and failure
before it is considered failed.

Q1 Packet Timeout in 100 ms units

The time to let MF wait for an answer packet after sending a command
packet. This time-out is used as both first character time-out and inter
character time-out while waiting for an answer packet. The first character
time-out is measured from the end of transmission of a command packet to
the reception of the first character of the slave answer packet, which must
occur before the time-out expires. Inter character time-out is measured
from the reception of a character and the reception of the next character and
must occur before the time-out expires.

Slow bus speeds require larger values for this time-out. The ’First char
timeouts’ and ’Inter char timeouts’ counters tell when this time-out has
expired. A too small value results in lots of expired time-outs, while an
excessive value may result in slower overall performance, when a NE is not
answering. You should consider modifying this time-out on the MF
according to your findings.

Command to send / Quick Poll
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The test is carried out by sending a Quick Poll command.

Command to send / Equipment ID

The test is carried out by sending an Equipment ID command.

Command to send / Program ID

The test is carried out by sending a Program ID command.

Command to send / Data transfer

The test is carried out by sending a user-defined Q1 command (e.g. m:4,1)
to a selected FE.

The FE Number and Menu command fields are enabled if the Data
transfer option is selected.

Command to send / FE ID

The test is carried out by sending an ’FE ID’ packet command. The FE
Number field is enabled is the FE ID option is selected.

Testing / Continuous

Testing is continuous until it is stopped.

Testing / Number of test rounds

The number of test rounds can be from 1 to 10000.

The Number of test rounds field is disabled if the Continuous check box
is selected.

3. Click one of the command buttons:

OK

Closes the dialog box and sets parameters.

Cancel

Closes the dialog box.

Default

Changes the dialog entries to the default: a continuous Quick Poll with
1 retry and 200 ms command time-out.

Help
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Displays the help for this dialog box.

D.2.6 Viewing test results

You can view and save the results of a test both during the testing and after the
test. The counters are reset when you choose Tests → Start. While viewing, note
that the colour coding in the NWT window (Figure 100) changes when a test
ends.

You can save the test report as ASCII text by choosing Tests → Report.... The
reports are best viewed using a fixed-width font, such as Courier.

See below for the explanations of the views, colour coding, and test parameters.

Figure 100. Viewing test results in the NWT window
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The views

The tree view displays a three-level tree. The name of the server you are
connected to is the root of the tree. Buses configured to the MF are the
intermediate nodes. Addresses configured to the test are the leafs. The view is
grey when there is no configuration.

The list view can be displayed as icons or as details. It shows information relevant
to the selection in the tree view.

Colour coding

During testing, the following colours are used on the tree view and the list view
items:

Grey: Bus or address has received no answers from the server
Green: Last test ok at the first try
Yellow: Last test ok but not at the first try
Red: Last test failed.

After testing is stopped, the meaning of the colours are:

Grey: No tests made on bus or address
Green: All tests were ok at the first try
Yellow: All tests were ok, but one or more not at the first try
Red: At least one test failed.

Address details

When an address is selected in the tree view, the details in the list view display
columns:

Pri

Value of the counter. If the Pri column is empty, the address is not in testing in
primary direction.

Sec

Value of the counter. If the Sec column is empty, the address is not in testing in
secondary direction.

When an address is selected in the tree view, the details in the list view display
counters:

Test/Tests

How many tests have been made out of total. C denotes a continuous test.

OK
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How many tests on this address were free of errors.

OK with errors

How many tests on this address passed with an error. This can happen when
retries has been configured to be non-zero (see sectionD.2.5, ’Tuning test
parameters’) and the test fails on the first try but succeeds on a retry.

Failed

How many tests on this address failed.

Invalid answer data from slave

The number of commands whose answer data was invalid. These errors should be
relatively rare as corrupted data should usually be detected as either character
level errors or packet level parity errors. However, it is possible that in some bus
configurations answer delays are so long that a wrong answer packet is matched
with a command packet which can lead to this kind of error.

Too many empty answer packets

The number of command iterations in which the empty packet limit was hit.
Empty answer packets are common when TMS Adaptors are used. TMS Adaptor
keeps answering with empty answer packets while it is querying the actual NE for
the answer. Also, when a command requires some processing in a network
element, the network element keeps answering with empty packets while forming
the answer. The number of empty packets in this kind of situation can be
decreased by increasing the empty packet delay parameter in MF configuration
with MF Manager.

Too many packet transactions

The number of command iterations which the packet limit was hit. The packet
limit can be used as an alternative or complementary criteria for aborting a
command whose iteration is taking too long. The empty packet limit aborts a
command when the specified number of empty answer packets is detected,
whereas for the packet limit the number of transmit/receive transactions is simply
counted.

First char timeouts

The number of first character time-outs detected. See Appendix D.2.5, ’Tuning
test parameters’ for the definitions of time-outs.

First char time in milliseconds min / max
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The values show the minimum and maximum of the maximum values for the time
measured from the end of transmission of command packet to the reception of the
first character of the slave answer packet. Note that when a packet times out, these
values are not affected, i.e. the maximum time is not necessarily even near to the
packet time-out when time-outs occur.

Inter char timeouts

The number of inter character time-outs detected. See sectionD.2.5, ’Tuning test
parameters’ for the definitions of time-outs. These errors should be relatively rare
as they indicate that for some reason only part of slave answer packet was
correctly received.

Command timeouts

The number of command iterations where the Q1 command time-out expired.

Command timeout is the time allowed for the complete Q1 command transaction.
The time is measured from the start of transmission of the first command packet
and the iteration must be compelete (i.e. the last answer packet must be
succesfully received) before the time-out expires. This time-out can be set with
MF Manager.

Command time in milliseconds min / max

The values show the minimum and maximum for the time measured from start of
command iteration to the end of command iteration. Note that for the values both
succesful and failed commands are observed, i.e. if command time-out is enabled
in the MF configuration and command time-outs occur, the maximum time is
bound to be at least as large as the command time-out.

Serial channel errors

How many tests on this address had either a character framing error, serial
overrun error, serial transmit error or serial receive error.

These errors indicate that there are serious problems with the Q1 bus. For
example, serial channel overrun errors should not normally occur as they indicate
that the bus is generating more data than can be received by the MF. These errors
could be caused by noise/interference generating a constant stream of start/stop
bits and/or break conditions.

Char parity errors

How many tests on this address had character parity errors. These errors indicate
that the quality of the asynchronous serial signal is bad (for example, too low a
sampling rate in EOC). Parity errors can also be caused by master command and
slave answer collision, which is possible if packet time-out is too short.

Packet parity errors
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How many tests on this address had packet parity errors. These errors can be seen
in same kind of conditions as character parity errors but they should occur less
frequently as the character level parity already detects one bit erros.

Datalink errors

How many tests on this address had either a packet format error, packet size
overflow error or wrong address in answer packet. These errors can occur at least
with quick poll command when time-out is too tight (master command and slave
answer collision).

Retry min / max

What were the minimum (non-zero) and maximum numbers of retries on this
address. See sectionD.2.5, ’Tuning test parameters’ for details on setting the
value.

Server details

When a server is selected in the tree view, the details in the list view display
columns:

Bus

The first element in the bus column is a bus icon showing a status colour. See
section D.2.1, ’Starting Network Test Client’ for the meaning of the colours.
Beside is the text “Bus” and after that the number of the bus.

OK Count

The number of tests made on this bus that were either ’Ok’ or ’Ok with errors’.

Error Count

The number of tests made on this bus that were ’Failed’.

Address Count

The number of addresses on this bus.

Bus details

When a bus is selected in the tree view, the details in the list view display
columns:

Address

The address of the NE and a generic NE icon showing a status colour. See
sectionD.2.1, ’Starting Network Test Client’ for the meaning of the colours.

Type
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The type of the NE at this address. It is ’unknown’ unless the NE is added with
the Refresh dialog box.

Pri OK

The number of tests made on this address in primary direction that were either
’Ok’ or ’Ok with errors’.

Pri Fail

The number of tests made on this address in primary direction that were ’Failed’.

If both Pri column entries are empty, that address is not in testing in primary
direction.

Sec OK

The number of tests made on this address in secondary direction that were either
’Ok’ or ’Ok with errors’. Possible only on protected buses.

Sec Fail

The number of tests made on this address in secondary direction that were
’Failed’. Possible only on protected buses.

If both Sec column entries are empty, that address is not in testing in secondary
direction.

D.3 User interface

D.3.1 Title bar

Title bar at the top of the application window shows the name of the application,
NWT, the name of the configuration, the status, and the name of the server. If the
configuration is not named, its name is Untitled. The name of the server is the
internet address given in the Connect dialog box. Before connection, only NWT
is displayed.

D.3.2 Menu bar

Below the title bar is the menu bar, which contains the menu items for NWT. The
mnemonic letter for each menu choice is underlined and shortcut keys are
displayed after the menu items.
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D.3.3 Toolbar

The toolbar contains shortcut buttons for the most frequently needed commands.
It provides you a quicker way to operate with the mouse.

Figure 101. The toolbar

The functions of the toolbar buttons refer to the following menu items:

1. Manage → Connect...

2. Manage → Disconnect

3. Manage → New

4. Manage → Open...

5. Manage → Save

6. Configure → Upload MF Addresses...

7. Configure → Add Addresses...

8. Configure → Delete

9. Tests → Start

10. Tests → Stop

11. View → Icons

12. View → Details

13. Help → Contents

D.3.4 Status bar

The status bar at the bottom of the application window displays a short
description about the chosen menu command or toolbar icon.
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D.3.5 User input

All NWT functions can be activated with a mouse or keyboard.

Menu choices and dialog box fields all have a mnemonic letter that is underlined.
A mnemonic is used by pressing at the same time the ALT key and the mnemonic
letter. For example, you can open the Manage menu by pressing the key
combination ALT + M.

Some menu choices have also a shortcut key. Shortcut keys are in line with the
standard Windows shortcut keys.

In the tree and list views you can use the following shortcut keys:

• INSERT opens the Add Addresses dialog box.

• DELETE deletes all addresses on selected items.

You can select items with either mouse or keyboard following the standard
windows conventions on the TAB, CTRL, SHIFT, SPACE and arrow keys.

You can select a bus or an address by a double-click or pressing ENTER in the list
view. The list view then shows either addresses or counters.

D.3.6 Data validation

When you connect to a test server, the configured non-suspended buses are added
to the test configuration without addresses. When a test configuration is read from
a file, it is compared with buses that are already in the configuration. No new
buses are accepted from the file, and the bus protection is not changed. When an
Upload MF Addresses is performed, buses that are missing from the server, or
have been suspended, are removed and possible new buses are added to the test
configuration. The bus protection is also updated. You are always notified with a
message box.

D.3.7 Clipboard

NWT supports data exchange via the Clipboard between edit boxes (the standard
Windows NT support).

D.3.8 Test reports

Test reports can be saved as ASCII text. You can print the report as a text file from
Windows NT. The counters used in test reports are described in section D.2.6.
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D.3.9 Online help

You can request help by clicking a Help button in a dialog box to get help about
that particular dialog box. The Help button in the main window opens the Help
contents page.
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